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РАЗДЕЛ I.  РАБОТА В COREL DRAW 
 

1. Создание и открытие документа 
 
После загрузки программа выводит на экран диалоговое 

окно Добро пожаловать в Corel DRAW (welcome to Corel 
DRAW), которое предполагает несколько вариантов начала 
работы программы: Новый документ (New Graphic), От-
крыть последний редактируемый документ (Open Last 
Edited), Открыть документ (Ореп Graphic), Открыть шаблон 
(Template), Обучающая система (CorelTUROR), Что нового? 
(What is New?) (рисунок 1). 

 

 
 

Рисунок 1 
 

Для создания нового документа можно также, выбрав 
меню Файл (File), выполнить команду Новый (New) или 

нажать соответствующую кнопку на стандартной инструмен-
тальной полосе. Для открытия существующего документа 
следует, выбрав меню Файл (File), выполнить команду От-
крыть (Open) или нажать соответствующую кнопку на стан-
дартной инструментальной полосе. 

Поскольку программа CorelDRAW позволяет открывать 
одновременно несколько документов, то предусмотрена воз-
можность, по желанию, ненужные в данный момент доку-
менты закрывать. При выборе меню Файл и выполнении 
команды Закрыть (Close) закрывается активный документ. 
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Интерфейс программы 
После загрузки программы на экране предстаёт окно 

программы, которое принято называть интерфейсом пользо-
вателя (user interface) или рабочим пространством (workspace). 

Интерфейс является посредником между человеком и ком-
пьютером, он предоставляет всё необходимое для работы: 
панели, инструменты, диалоговые окна и т.д. 

Следует иметь в виду, что интерфейс в процессе работы 
может быть перестроен и очень сильно отличаться от ис-
ходного, выводимого на экран при первой загрузке. 

Интерфейс пользователя включает заголовок, главное ко-
мандное меню, рабочие окна для отображения документов, а 
также совокупность различных панелей, при помощи которых 
осуществляется редактирование изображений (рисунок 2). 

 

 
 

Рисунок 2 
 

Большое белое пространство в центре окна программы 
является рабочей областью, которая организуется в форме 
рабочего окна, при этом каждый документ открывается в 
отдельном окне. 
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Главное командное меню 
В верхней части экрана расположена полоса главного ко-

мандного меню (menu bar), которая предполагает следую-
щие группы команд. 

• Файл (File) 
• Редактирование (Edit) 
• Просмотр (View) 
• Компоновка (Layout) 
• Управление (Arrange) 
• Эффекты (Effects) 
• Точечные изображения (Bitmaps) 
• Текст (Text) 
• Сервис (Tools) 
• Окно (Window) 
• Помощь (Help) 
 

 
 

Каждая группа - совокупность команд, выполняющих 
функционально близкие действия, например, меню Текст 
(Text) включает значительное число команд для работы с тек-
стом, а меню Эффект (Effects) - команд для создания и редак-
тирования различных эффектов для векторной и точечной 
графики. 

Также предусмотрены дополнительные так называемые 
контекстные меню (Context - sensitive menu). Содержание 
этих меню находится в зависимости от активного в данный 
момент инструмента, типа выделенного объекта или откры-
той панели. 

Инструментальные полосы 
Под строкой меню могут быть расположены Инструмен-

тальные полосы (Toolbars). Любая инструментальная полоса 
может существовать и в «свободном состоянии» в виде неза-
висимой панели, которая может занимать любое положение 
на экране и изменять свою форму. 
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Вывод на экран той или иной полосы обеспечивается 
при помощи меню Окно (Window), далее следует вызвать 
командой Инструментальные полосы (Toolbars) диалогового 
окна Параметры (Options), (рисунок 3) где в разделе 
Настройка выбрать нужную полосу. 

 

 
 

Рисунок 3 
 

Инструментальная полоса Свойства (Property Ваr) 
Набор полей и кнопок в инструментальной полосе Свой-

ства (Property Ваг) отображается в зависимости от использу-
емого инструмента или от типа выделенного объекта, 
например при выборе текстового блока в инструментальной 
полосе отображаются параметры текста (рисунок 4). 

 

 
 

Рисунок 4 
 

 
 

Рисунок 5 
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При отсутствии выделенных объектов на полосе свой-
ства (Property Bar) представлены общие параметры доку-
мента, например, формат страницы, ее ориентация и другие 
(рисунок 5). 

 
Полоса Состояния (Status Ваr) 

 
По умолчанию в нижней части рабочего экрана распола-

гается полоса Состояния (Status Ваг), которая предназначена 
для отображения разнообразной служебной информации: 
параметров, обводки и заливки, параметров шрифта, сведе-
ний о типах выделенных объектов и об активных инстру-
ментах. Вид, положение и содержание самой полосы также 
могут изменяться (рисунок 6). 

 

 
 

Рисунок 6 
 

Панель инструментов (Toolbox) 
По умолчанию Панель инструментов располагается в ле-

вой части рабочего окна. В ней собраны все инструменты, с 
помощью которых можно создавать, выделять, редактиро-
вать и перемещать графические объекты (рисунок 7). 

 

 
 

Рисунок 7 
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При работе с инструментами курсор принимает опреде-
лённую форму в зависимости от выбранного объекта. Более 
того, от панели инструментов можно отделять некоторые 
группы инструментов в виде отдельных «плавающих» пане-
лей или панелей типа Flyout (рисунок 8). 

 

 
 

Рисунок 8 
 
Панели типа Docker 
Панели типа Docker представляют собой разновидность 

диалогового окна. Эти панели могут всё время находиться 
на экране и стыковаться с рабочими окнами документов. 
Для вызова на экран какой-либо панели нужно в меню Окно 
(Window) выполнить команду Панель типа Docker (Dockers...) 
и в открывшемся списке выбрать одну из довольно большо-
го числа панелей. 

 Панель Object Manager (Диспетчер объектов) - для отоб-
ражения параметров и иерархии объектов и слоев (рисунок 8). 

• Панель View Manager (Диспетчер видов) - для созда-
ния и управления «видами отображения». 

• Панель Graphic and Text Styles (Стили текста и гра-
фики) - для создания и присваивания стилей для графиче-
ских и текстовых объектов (рисунок 9). 

• Панель Color Styles (Цветовые стили) - для создания 

и дальнейшего использования предустановленных наборов 
цветов. 

• Панель Symbols and Special Characters (Символы и 
специальные знаки) - для работы с наборами декоративных 
символов. 
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Рисунок 9 
 

• Панель Internet Bookmark Manager (Диспетчер закла-
док Internet) - для создания и управления закладками ги-
пертекстовых ссылок. 

• Панель HTML Object Conflict (Анализатор конфлик-
тов объектов HTML) - для проверки и коррекции докумен-
тов, предназначенных для публикации в сети Internet. 

• Панель Script and Preset Manager (Диспетчер макросов 
и готовых образцов) - для записи и отладки макропрограмм. 

• Панель Object Data (База данных) - для присвоения 
каждому объекту документа таблицы данных, например 
стоимости, размеров и прочей информации. 

• Панель Object Properties (Свойства объектов) - для ото-

бражения и изменения многообразных параметров всех объ-
ектов документа (рисунок 10). 

• Панель Link Manager (Диспетчер связанных изображений) 
– для управления изображениями, которые не включают-

ся в документ, но сохраняют с ним связь. 
• Панель Bitmap Color Mask (Цветовая маска точечного 

изображения) - для создания цветовых масок точечного 
изображения. 

• Панель Lens (Линза) - для выбора типа линзы и уста-
новки ее параметров. 
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• Панель Artistic Media (Имитация) — для работы со 
сложными видами векторных кистей. 

 

 
 

Рисунок 10 
 

• Панель Transformation (Трансформирование) — для 
управления различными видами трансформаций. 

• Панель Shaping (Изменение формы) — для выполнения 
трех видов комбинирования нескольких объектов в один. 

• Панели Color (Цвет) и Color Palette Browser (Цветовые 
палитры) — для работы с цветом. 

• Панель Browse (Обзор) — для управления и просмотра 
документов программы. 

• Панели Cliparts (Векторные изображения), Photos (Фо-
тографии), 3Dmodels (Трехмерные модели) — для просмот-
ра компакт-дисков (CD-ROM), поставляемых с программой. 

• Панель FTP Sites (Сайты FTP) — для хранения ссылок 
на сайтах FTP и быстрого соединения с целью «перекачки» 

больших массивов информации. 
Если какой-либо из указанных команд нет в меню, то их 

необходимо подключить, используя диалоговое окно Пара-
метры (Options) из раздела Меню (Menus). 
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Сохранение и конфигурация интерфейса 
Программа CorelDRAW позволяет сохранить настройки 

интерфейса, что обеспечивает возможность разным пользо-
вателям создавать собственные настройки или одному поль-
зователю для различных задач подстраивать соответствую-
щий интерфейс. 

Для сохранения текущей настройки интерфейса необхо-
димо выполнить следующие действия: в меню Tools (Сер-
вис) выбрать команду Options (Опции...), и в открывшемся 
диалоговом окне выбрать раздел Интерфейс (Workspace) 

Кнопка New (Новый...) выводит на экран диалоговое ок-
но New Workspace (Новый интерфейс), в котором необходи-
мо определить параметры интерфейса, например, название - 
в поле Name of new workspace (Имя нового интерфейса). 
Флажок Установить в качестве текущего интерфейса (Set as 
current) обеспечивает использование нового интерфейса в 
качестве активного (рисунок 11). 

 

 
 

Рисунок 11 
 

Сохранение документа 
 

Сохранить документ в программе CorelDRAW можно не-
сколькими способами. 

В меню Файл (File) команда Сохранить (Save) сохраняет 
текущий документ под тем же именем, в той же папке и в 
том же формате. На стандартной инструментальной полосе 
имеется кнопка, дублирующая эту команду. 

Команда Сохранить как... (Save As) даёт возможность со-
хранить текущий документ под другим именем, в другой пап-
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ке и даже в другом формате. При выполнении этой команды, а 
также при сохранении нового документа на экран выдаётся 
окно Сохранить рисунок (Save Drawing) (рисунок 12). 

В списке Version (Версия) можно выбрать один из вари-
антов текущей или предыдущей версии CorelDRAW и со-
хранить документ в соответствующем формате. 

 

 
 

Рисунок 12 
 

Следует иметь в виду, что при сохранении документа в 

предыдущей версии возможна потеря некоторых параметров 
(и чем более ранняя версия программы используется, тем 
больше потерь). 

В списке Thumbnail (Миниатюра) предлагаются вариан-
ты сохранения вместе с документом небольшого точечного 
изображения: вариант None (Без изображения) хотя и поз-
воляет уменьшить размер файла, но может в дальнейшем 
усложнить поиск документа; варианты 1К (mono), 2К 
(mono), 4К (color), 8К (color) служат для создания черно-
белых или цветных изображений различного качества. По 
умолчанию принято максимальное качество. 

• Флажок Selected only (Только выделенные объекты) 

позволяет сохранить в новом файле только выделенные 
объекты, тем самым в других файлах можно сохранять от-
дельные фрагменты документа. 
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• Флажок Embed ICC profile (Разместить ICC профиль) 
предназначен для сохранения в документе данных цветовых 
профилей системы управления цветом. Программы пакета 
поддерживают эту функцию с форматами СРТ CDR, TIFF, 
JPEG, PICT и EPS. 

• Флажок No white spaces, special characters (Без пробе-
лов и специальных символов) позволяет при сохранении до-
кумента в его названии заменить пробелы символами под-
черкивания, а специальные символы – знаками, принятыми 
в стандартах Web. 

• Флажок Embed Fonts using TrueDoc (Разместить 
шрифты с использованием TrueDoc) позволяет включить в 

документ информацию об используемых шрифтах с подклю-
чением технологии TrueDoc. После включения этого флажка 
на экран непременно выводится предупреждение о том, что 
включаемые шрифты предназначены только для просмотра 
и компания Corel не несет ответственности за иное исполь-
зование включаемых шрифтов. В любом случае следует 
нажать кнопку Принимаю (Accept). 

• В полях Keywords (Ключевые слова) и Notes (Коммен-
тарии) можно сохранить документ с ключевыми словами и 
комментариями, которые призваны облегчить дальнейший 
поиск файлов или дальнейшую работу с документом. 

• Кнопка Advanced (Дополнительно) выводит на экран 
раздел Save (Сохранение) диалогового окна Options (Пара-
метры), в котором устанавливаются параметры по умолча-
нию (рисунок 13). 

• Флажок Save presentation exchange (Сохранить в фор-
мате обмена) обеспечивает возможность открытия докумен-
та другими приложениями, поддерживающими формат СМХ. 

Этот флажок без осознанной необходимости включать не 
стоит, поскольку формат СМХ ведет к некоторому увеличе-
нию размера файла в сравнении с форматом CDR. 

• Флажок Use current thumbnail (Использовать сущес-
твующую миниатюру) обеспечивает сохранение документа с 
миниатюрой, которая была растрирована при первом сохра-
нении. Это в какой-то мере уменьшает время, необходимое 
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для сохранения файла, но может вводить в заблуждение, ес-
ли документ был основательно переделан. 

• В поле File optimization (Оптимизация файла) пред-
ставлены два флажка, позволяющих сократить размер фай-
ла, поскольку обеспечивается сжатие точечных изображений 
(флажок Use bitmap compression) и/или векторных изобра-
жений (флажок Use graphic object compression). 

 

 
 

Рисунок 13 
 

 Поля Textures (Текстурные заливки) и Blends and 
extrudes (Эффекты «Пошаговый переход» и «Экструдирова-
ние») идентичны по своей структуре: 

 переключатель Save ... with the file (Сохранить ... вме-
сте с файлом) обеспечивает сохранение результатов работы 
указанных функций в документе, что увеличивает размер 
файла, но зато уменьшает время открытия документа; 

 переключатель Rebuild ... when opening the file (Постро-
ить ... при открытии файла) – наоборот, экономит место, но 
«транжирит» время. Выбор остается за пользователем. 

 

Отображение на экране 
 

В редакторах векторной графики предусмотрено представ-
ление изображения на экране в своём реальном отображении - 
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а именно так, как оно будет печататься. Для того чтобы 
управлять выводом изображений, в рабочем окне программы 
необходимо обратиться к меню Просмотра (View). В программе 
предусмотрено пять режимов отображения: Просто контурный 
(Simple Wireframe), Контурный (Wireframe), Черновой (Draft), 
Нормальный (Normal), Улучшенный (Enhanced). По умолча-
нию принят режим Нормальный (Normal), который отобража-
ет все параметры обводок и заливок. 

 

Экранный масштаб 
 

Для того чтобы уверенно работать с мелкими элементами 
рисунка, в программе предусмотрена функция увеличения и 
уменьшения изображений на экране. Для того чтобы восполь-
зоваться этой функцией, необходимо на Панели инструментов 
(Toolbox) выбрать инструмент Масштаб (Zoom) и щелкнуть 
кнопкой мыши на увеличиваемую или уменьшаемую область. 

В стандартной инструментальной полосе представлен 
список масштабов изображения, а также команд, дублирую-
щих кнопки панели Масштаба (Zoom): Все выделенные объ-
екты (То Selected), Все объекты (То Fit), Вся страница (То Pa-
ge), Ширина страницы (То Width), Высота страницы (То 
Height), 10%, 25%, 50%, 75%, 100%, 200%, 400% (рисунок 14). 

Когда изображение увеличено, то возникает необходи-
мость его перемещения с целью получения доступа к скры-
тым в данный момент частям документа. Для этого преду-
смотрены две возможности: 

1. Традиционные полосы прокрутки для перемещения 
изобра-жения по вертикали и по горизонтали. 

2. Специальный инструмент Панорама (Pan). Для пере-
мещения увеличенного объекта необходимо выбрать ин-
струмент, курсор примет форму руки, нажать кнопку мыши 
и перемещать объект в любом направлении (рисунок 15). 

3. По умолчанию Измерительные линейки на экран не 
выводятся, но для того, чтобы получить к ним доступ, в 
меню Просмотр (View) выполняется следующая команда - 
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Линейки (Rulers). Повторное выполнение команд служит для 
удаления линеек с экрана. 

 

       
 
           Рисунок 14                                Рисунок 15 

 
Измерительные линейки  

 

Измерительные линейки можно свободно перемещать в 
пределах рабочего окна, для этого следует «захватить» ли-
нейку при нажатой клавише <Shifit> и переместить её в 
требуемое место. Двойной щелчок на линейке с нажатой 
клавишей <Shift> вернёт её на «законное место». 

Двойной щелчок на линейке без нажатия каких-либо 
клавиш выводит на экран раздел Линейки (Rulers) диалого-
вого окна Параметры (Options) (рисунок 16). 

В программе CorelDRAW линейки могут отображать де-
ления различных измерений, в списках поля Единицы изме-
рения (Units) представлены следующие единицы измерения: 

- inches (дюймы), 1 (английский) дюйм равен 24,5 мм; 
- millimeters (миллиметры); 
- picas; points (пики), 1 пика равна 12 пунктам; 
- points (пункты), 1 пункт равен 1/72 английского дюйма; 
- pixels (пикселы), относительная единица (не имеет аб-

солютного значения); 
- ciceros; didots (цицеро), 1 цицеро равен 12 пунктам Дидо; 
- didots (пункты Дидо), 1 пункт Дидо равен 1/72 фран-

цузского дюйма (27,06 мм); 
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- feet (футы), 1 фут равен 304,8 мм; 
- yards (ярды), 1 ярд равен 914,4 мм; 
- miles (мили), 1 миля равна 1609 м; 
- centimeters (сантиметры); 
- meters (метры); 
- kilometers (километры). 
Следует иметь в виду, что общая рабочая площадь доку-

мента составляет около 45х45 метров. Это позволяет широко 
использовать данную программу в оформлении выставок, 
крупных объектов и т.д. 

 

 
 

Рисунок 16 
 

Отображение на экране параметров страницы 
 

На экране формат страницы (под форматом страницы 
понимается максимальный размер листа, используемый на 
внешнем устройстве) отображается условным прямоугольни-
ком с тенью, его размеры можно выбрать из списка в ин-
струментальной полосе Свойства (Property Ваг), который до-
ступен при отсутствии выделенных объектов. 

Кнопка Книжная (Portrait) обеспечивает ориентацию 
страницы с длинной стороной по высоте, а кнопка Альбом-
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ная (Landscape) обеспечивает ориентацию страницы с длин-
ной стороной по ширине. 

Эти размеры не следует путать с размерами печатной 
области. 

Отобразить на экране печатную область можно выбрав в 
меню Просмотр (View) команду Печатная область (Printable 
Area). Штриховыми линиями выводятся границы печатной 
области. А с помощью команды Под обрез (Bleed) обеспечи-
вается вывод на экран границы обреза (рисунок 17). Необ-
ходимость в этой информации возникает из-за того, что 

большинство принтеров не располагает возможностью нано-
сить изображение по краям бумаги. 

 

 
 

Рисунок 17 
 

2. Графика точечная и векторная 
 
Точечная графика оперирует элементами (пикселами), 

имеющими определенное цветовое значение и однозначное 
расположение в сетке битовой карты. 

С такими изображениями работают точечные графиче-
ские редакторы. Такие изображения получаются в результа-
те команды Конвертировать в точечное изображение 
(Convert to Bitmap). 

Граница пе-
чатьной области 

Граница обреза 



19 

При редактировании в точечной графике изменяется 
цвет определенной совокупности пикселов. Изменение цвета 
имеет своим результатом изменение формы изображаемых 
предметов. 

Векторная графика оперирует математическими объекта-
ми, которые не зависимы от параметров внешнего устрой-
ства (монитора, принтера). 

При редактировании в векторной графике изменяется в 
первую очередь форма объекта, а цвет играет второстепен-
ную роль. В векторной графике цвет и форма не зависимы 
друг от друга, при этом форма первична, а цвет - просто за-
полнитель формы. 

 

3. Работа с объектами и их формой 
 
Программа CorelDRAW предполагает разнообразные 

средства для создания векторных изображений - от тончай-
ших линий и перьевых штрихов до имитации мазков кисти 
разной формы. Вместе с тем специфика векторной графики 
весьма далека от рисования «вручную». Поэтому необходимо 

представлять себе, как создать векторный контур и как его 
отредактировать. 

Для этих целей программа CorelDRAW располагает не-
которыми инструментами по созданию и редактированию 
геометрических фигур (прямоугольника, многоугольника, 
эллипса, спирали), также имеются несколько инструментов 
«свободного рисования» (перо каллиграфическое, перо с 
нажимом и т.д.), есть инструмент Градиентная сетка (Mesh 
Fill) и основной инструмент векторной графики, создающий 
кривые Безье - инструмент Безье (Bezier). 

Полное редактирование векторных контуров, независимо 
от того, какими инструментами они созданы, выполняется 
единым образом: с помощью инструмента Форма (Shape) и 
специальной панели Редактора узлов (Node Edit) или дубли-
рующей её инструментальной полосы Свойства (Property Ваг). 
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Контуры и опорные точки 
 

Контур (path) - это линия, создаваемая с помощью ри-
сующих инструментов программы и представляющая собой 
проволочную структуру объекта. 

Контуру впоследствии могут быть присвоены параметры 
обводки (outline) и заливки (fill), в результате этого он стано-
вится видимым и может быть выведен на печать (рисунок 18). 
Если у контура отсутствуют какие-либо параметры, то он не 
отобра-жается в обычном режиме (а только в специальном - 
контурном) и не выводится на печать, хотя сохраняется в до-
кументе и является «полноценным» объектом. Контур (или со-
ставной контур - совокупность скомбинированных контуров), 
который можно выделить инструментом Форма (Shape), счи-
тается отдельным объектом (object). 

 

 
 

Рисунок 18 
 

Обычно контур состоит из множества сегментов, пред-
ставляющих собой элементарные кривые Безье и соединен-
ных в опорных точках, или узлах (nodes), которые в про-
грамме CorelDRAW бывают трех типов. 

При перемещении одной опорной точки сегменты, связан-
ные с нею, меняют свою форму. Изменение формы сегмента 
обеспечивается также перемещением управляющих точек. 

 

контур 
(patch) 

обводка 
(outline) 

заливка 
(fill) 
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Инструменты стандартных объектов 
 

Инструменты, предназначенные для создания стандарт-
ных геометрических фигур (прямоугольника, квадрата, эл-
липса, дуги, окружности и прочих), позволяют одним дви-
жением мыши создать сложный геометрический объект. 

 
Инструмент Прямоугольник (Rectangle) 

 
Инструмент Прямоугольник (Rectangle) служит для со-

здания любых прямоугольников и квадратов, в том числе с 
закругленными углами (рисунок 19). 

Для того чтобы «нарисовать» прямоугольник, необходи-
мо включить инструмент, нажать кнопку мыши и, не отпус-
кая её, протянуть диагональ требуемого размера. 

Если требуется создание прямоугольника из центральной 
точки, то следует удерживать клавишу <Shift>. Для рисова-
ния квадрата необходимо использовать клавишу <Ctrl>. 

 

 
 

Рисунок 19 
 

При выделенном объекте правой кнопкой можно вызвать 
контекстное меню, в котором команда Свойства (Properties) 
позволит вывести на экран панель Свойства объекта (Object 
Properties). В ней на вкладке Прямоугольник (Rectangle) в 
поле Закругление углов (Corner roundness) можно устано-
вить закругление каждого отдельного угла в процентах. 
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Также закругление углов можно выполнить с помощью ин-
струмента Форма (Shape) или Стрелка (Pick). Для этого сле-
дует подвести курсор мыши к одному из углов прямоуголь-
ника и «потянуть» в сторону, определяя радиус «на глаз». 

Можно использовать инструментальную полосу Свойства 
(Property Ваг), которая имеет соответствующее поле для ин-
терактивного изменения радиуса закругления углов для 
каждого угла индивидуально. 

 
Инструмент Эллипс (Ellipse) 

 
Инструмент Эллипс (Ellipse) предназначен для рисования 

эллипсов и окружностей (рисунок 20). 
Эллипс рисуется из угла прямоугольника, в который он 

вписывается. Для рисования эллипса из центра должна быть 
нажата клавиша <Shift>, а для получения окружности - кла-
виша <Ctrl>. 

Панель Свойства объекта позволяет изменить характер эл-
липса. Переключатели в верхней части вкладки Эллипс 
(Ellipse) дают возможность выбрать тип эллипса: Эллипс 
(Ellipse), Сектор (Pie) или Дуга (Arc). Эти переключатели дуб-
лируются на инструментальной полосе Свойства (Property Ваг). 

 

 
 

Рисунок 20 
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Инструменты группы Объект (Object) 
 

Три инструмента, а именно Многоугольник (Polygon), 
Спираль (Spiral), Координатная бумага (Graph Paper), объ-
единены в группу Объект (Object) и могут быть отделены от 
панели инструментов в виде отдельной панели: 

 

 
 

Инструмент Многоугольник (Polygon) 
 
Многоугольник следует понимать как геометрический 

объект с заданным числом сторон. Вариантом многоуголь-
ника является звезда, у которой точки соединяются, пересе-
кая площадь выпуклого многоугольника, в который она 
вписана. 

Процесс создания многоугольника или звезды с помощью 
инструмента Многоугольник (Polygon) ничем не отличается 

от работы описанного выше инструмента Прямоугольник 
(Rectangle). При нажатой клавише <Ctrl> создается пра-
вильный многоугольник, у которого все стороны равны. 

Изменение параметров осуществляется с помощью пане-
ли Свойства объекта (Object Properties). 

Выбрав вкладку Многоугольник (Polygon) на этой панели в 
поле Число вершин/сторон можно определить число вершин 
для многоугольника или звезды. Поле просмотра, расположен-
ное правее, отображает вид объекта (рисунки 21, 22). 

Поле Острота вершин (Sharpness) позволяет определить 
в условных единицах степень заостренности вершин звезд: 
чем больше у звезды вершин, тем больший диапазон 
«остроты» предоставляется. 

Переключатели Многоугольник (Polygon) и Звезда (Star) 
служат для выбора типа многоугольника. 

Все эти поля и переключатели дублируются и на инстру-
ментальной полосе Свойства (Property Ваг). 
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Рисунок 21 
 

Следует иметь в виду, что в программе существует неко-
торая не согласованность, поскольку в разделе инструмент 
Многоугольник (Polygon Tool) диалогового окна Параметры 
(Options) представлен ещё один тип многоугольника - Мно-
гоугольник в виде звезды (Polygon as Star). 
 

 
 

Рисунок 22 
 

Инструмент Спираль (Spiral) 
 
Инструмент Спираль (Spiral) предназначен для создания 

спирали – геометрического объекта в виде непрерывной 
кривой с определенным радиусом и числом завитков. 

Процесс создания спирали ничем не отличается от про-
цесса создания прямоугольника. 



25 

Переключатели Симметричная (Symmetrical) и Логариф-
мическая (Logarithmic) в разделе инструмент Спираль (Spiral 
Tool) обеспечивают выбор типа спирали (рисунок 23). 

 

 
 

Рисунок 23 
Для создания спирали, у которой ширина и высота габа-

ритного прямоугольника равны, следует удерживать нажа-
той клавишу <Ctrl>. Изменять параметры спирали можно с 
помощью инструментальной полосы Свойства (Property Ваг). 

 
    Инструмент Координатная бумага (Graph Paper) 

 
Инструмент Координатная бумага (Graph Paper) позво-

ляет быстро создать решетку с заранее заданными парамет-
рами. Такую решетку можно представить в качестве коорди-
натной основы для диаграммы или графика, отсюда и 
название (рисунок 24).   

Процесс создания решетки ничем не отличается от рабо-
ты, например, инструмента Многоугольник (Polygon). Един-
ственный параметр этого инструмента - размерность решет-
ки, которая определяется в разделе Инструмент Координат-
ная бумага (Graph Paper Tool) диалогового окна Параметры 
(Options). 

Поле Число ячеек по ширине (Number of cells wide) поз-
воляет установить ширину решетки по числу ячеек, а поле 
Число ячеек по высоте (Number of cells high) – высоту ре-
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шетки по числу ячеек. Для создания решетки с квадратными 
ячейками следует удерживать нажатой клавишу <Ctrl>.  

 

          
 

Рисунок 24     
                     

 
Инструменты группы Кривая (Curve) 

 
Группа Кривая (Curve) панели инструментов содержит 

следующие инструменты: Рисование (Freehand), Безье (Bezier), 
Перо (Natural Реп), Размерные линии (Dimension), Со-

единительная линия (Connector Line) и Соединитель 
(Connector), (рисунок 25). 

 

 
 

Рисунок 25  
   

Инструмент Рисование (Freehand) 
 

Инструмент Рисование (Freehand) предназначен для ри-
сования произвольных линий (рисунок 26). В результате ра-
боты этого инструмента, тем не менее, получается вектор-
ный контур, в котором опорные точки расставляются про-
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граммой автоматически. Он доступен для редактирования, 
как и любой другой контур, сразу же после прекращения ри-
сования этим инструментом. 

 

 
 

Рисунок 26    

 
При рисовании этим инструментом используются теку-

щие значения толщины и цвета обводки. 

В любой момент уже нарисованную линию можно про-
должить. Для этого следует подвести курсор к конечной 
точке (извилистая линия у курсора превратится в стрелку, 
что является свидетельством «точного попадания») и, нажав 

кнопку мыши, можно проводить линию дальше. 
С помощью инструмента Рисование (Freehand) рисуются 

и прямые линии. Для этого достаточно щелкнуть в началь-
ной и конечной точках. 

 
Инструмент Имитация (Artistic Media) 

 
Инструмент Имитация (Artistic Media) более характерен 

для программ точечной графики. Тем не менее, и векторная 
программа CorelDRAW предлагает этот инструмент, имити-
рующий в какой-то степени особенности рисования пером, а 
также как инструмент, напоминающий Декоративный штамп. 

Особенность этого инструмента заключается в том, что 
результатом его работы является основной контур (control 
path), вдоль которого располагается объект или совокуп-
ность объектов, имитирующих тот или иной живописный 
или графический эффект (рисунок 27). 
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Рисунок 27    
 

- Режим Образец (Preset) обеспечивает создание объек-
тов, которые изменяют свою толщину в соответствии с 
формой готовых образцов, предлагаемых в списке инстру-
ментальной полосы Свойства (Property Ваг). Этот режим 
позволяет выполнять рисование фигурными штрихами (в 
виде клиньев, капелек и т.д.). 

- Режим Кисть (Brush) обеспечивает создание декора-
тивных мазков в виде произвольных и достаточно сложных 
форм или даже текста. Художественной задачей является ри-
сование сложными декоративными мазками. 

- Режим Распылитель объектов (Object Sprayer) обеспе-
чивает размещение различных графических элементов вдоль 
траектории несколькими методами. Этот режим направлен 
на создание сложных рамок, гирлянд, декоративных полос и 
прочего. 

- Режим Каллиграфия (Calligraphic) обеспечивает созда-
ние объектов, имитирующих рисование широким пером или 
широкой кистью, расположенных под определенным углом к 
линии рисования. 

- Режим Нажим (Pressure) обеспечивает создание штри-
хов, которые изменяют свою толщину под влиянием особых 
комбинаций клавиш на клавиатуре (в худшем случае) или 
электронного пера (стилуса). Последняя возможность до-
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ступна при наличии соответствующих оборудования и про-
граммного обеспечения. 

 
Режим Образец (Preset) 

 
При выборе режима Образец (Preset) на инструменталь-

ной полосе Свойства (Property Ваг) становятся доступными 
следующие параметры: 

Поле Сглаживание (Freehand Smoothing) (на рисунке 28 
обозначено цифрой 1) предназначено для определения степени 
сглаживания основного штриха в диапазоне от 0 до 100. 

Поле Толщина (Width) (цифра 2) позволяет определить мак-
симальную толщину декоративного штриха (толщину штриха в 
самом широком месте) в диапазоне от 0,764 до 254 мм. 

В списке Preset Stroke (Форма штриха) (цифра 3) пред-
ставлен широкий выбор декоративных штрихов разнообраз-
ной формы. 

 

 
                                   1          2                3 

 
Рисунок 28   

 

Приемы работы с инструментом в этом режиме не отли-
чаются от работы инструмента Рисование (Freehand). 

 
Режим Кисть (Brush) 

 
При выборе режима Кисть (Brush) на инструментальной 

полосе Свойства (Property Ваг) становятся доступными сле-
дующие параметры: 

Поле Сглаживание (Freehand Smoothing) (на рисунке 29 
обозначено цифрой 1) предназначено для определения степени 
сглаживания основного штриха в диапазоне от 0 до 100. 

 



30 

 
                     1                   2             3        4   5 

 
Рисунок 29 

 
Поле Толщина (Width) (цифра 2) позволяет определить 

максимальную толщину декоративного штриха в диапазоне 
от 0,764 до 254 мм. 

В списке Форма кисти (Brush Stroke) (цифра 3) пред-
ставлен широкий выбор декоративных штрихов разнообраз-
ной формы. 

Кнопка Сохранить (Save) (цифра 4) позволяет сохранить 
объект в качестве формы кисти. Этот объект необходимо 
выделить, включить инструмент Имитация (Artistic Media), 
затем выбрать режим Кисть (Brush) и после щелчка на 
кнопке Сохранить (Save) на экран выводится стандартное 
диалоговое окно, которое позволит присвоить имя варианту 
кисти и сохранить его в файле формата С MX. 

Кнопка Удалить (Delete) (цифра 5) позволяет удалить 
любой из имеющихся в списке вариантов. 

 
Режим Распылитель объектов (Object Sprayer) 

 

При выборе режима Распылитель объектов (Object 
Sprayer) на инструментальной полосе Свойства (Property 
Ваг) становятся доступными следующие параметры: 

Поле Сглаживание (Freehand Smoothing) (на рисунке 30 
обозначено цифрой 1) предназначено для определения сте-
пени сглаживания основного штриха в диапазоне от 0 до 
100. 
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Рисунок 30 
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Поле Размер (Size) (цифра 2) позволяет определить мак-
симальный и минимальный размеры декоративных штрихов 
в процентах к исходному в диапазоне от 1 до 99%. 

В списке Перечень объектов (Spraylist) (цифра 3) пред-
ставлен широкий выбор декоративных образцов распыляе-
мых объектов разнообразной формы. 

Кнопка Save (цифра 4) - процесс работы ничем не отли-
чается от процесса работы в режиме Кисть (Brush). Позволя-
ет сохранить его в формате CDR. 

Кнопка Удалить (Delete) (цифра 5) позволяет удалить 
любой из имеющихся в списке вариантов. 

Список Порядок распыления (Spray Order) (цифра 6) 

предлагает список способов распределения объектов вдоль 
контура – Случайно (Ramdomly), Последовательно (Sequen-
tially), По направлению (By Direction). 

Кнопка Добавить в список объектов (Add to Spraylist) 
(цифра 7) позволяет добавить в список объектов новые эле-
менты, из которых затем может быть сформирован «играю-
щий» состав (play list). 

Кнопка Активизация списка объектов (Spraylist Dialog) 
(цифра 8) выводит на экран диалоговое окно Создание спис-
ка активных элементов (Create Playlist), в котором пред-
ставлены два окна: окно Список всех объектов (Spraylist) и 
окно Список активных объектов (Playlist). 

Поле Объекты/Интервалы (Dabs/Spacing) (цифра 9) поз-
воляет изменять соотношение количества объектов и интер-
валов. В нижнем поле Интервалы (Spacing) определяется 
интервал между совокупностями объектов, а в верхнем поле 
Объекты (Dabs) — количество этих объектов на каждую ин-
тервальную точку. 

Кнопка Вращение (Rotation) (цифра 10) выводит на 
экран дополнительное окно, в котором можно изменить па-
раметры вращения всех объектов. 

Кнопка Смещение (Offset) (цифра 11) выводит на экран 
дополнительное окно, в котором можно изменить значение 
и направление смещения объектов относительно контура. 
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Кнопка Восстановить значения (Reset Value) (цифра 12) 
позволяет вернуть исходные значения, сохраненные в соот-
ветствующем файле. 

 
Режим Каллиграфия (Calligraphic) 

 
При выборе режима Каллиграфия (Calligraphic) на ин-

струментальной полосе Свойства (Property Ваг) становятся 
доступными следующие параметры: 

Поля Сглаживание (Freehand Smoothing) (на рисунке 31 
обозначено цифрой 1) и Толщина (Width) (цифра 2) функци-
онируют так же, как и при выборе режима Кисть (Brush). 

Поле Угол (Angle) (цифра 3) служит для определения уг-
ла наклона «пера». 

 

 
                                   1          2             3 

 
Рисунок 31 

 
Режим Нажим (Pressure) 

 
При выборе режима Нажим (Pressure) на инструменталь-

ной полосе Свойства (Property Ваг) становятся доступными 
следующие параметры: 

Поля Сглаживание (Freehand Smoothing) (на рисунке 31 
обоз-начено цифрой 1) и Толщина (Width) (цифра 2) функ-
ционируют так же, как при выборе режима Кисть (Brush). 

Управление реальной толщиной штриха кисти обеспечи-
вается с помощью клавиши <↑> для увеличения толщины и 
клавиша <↓> - для уменьшения толщины. 

 
Инструмент Безье (Bezier) 

 
Исконным инструментом программы является Инстру-

мент Безье (Bezier). С его помощью можно создать любой 
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контур с максимальной точностью и рациональностью. Этот 
инструмент позволяет пользователю стать творцом формы, 
которая в графическом дизайне решает все. 

 

Построение прямолинейных сегментов 
 

Для построения прямой линии очень хорошо подойдет ин-
струмент Безье (Bezier). При этом необходимо, выбрав ин-
струмент Безье (Bezier), подвести курсор к начальной точке и 
щелкнуть левой кнопкой мыши. На месте щелчка появляется 
черная точка, отображающая первую опорную точку сегмента, 
она остается активной до создания следующей точки. 

Затем необходимо переместить курсор на новое место, 
где должна располагаться следующая точка. Две точки со-
единяются прямой линией (рисунок 32). 

 

 
 

Рисунок 32 
 

Типы опорных точек 
 
При соединении нескольких сегментов (рисунок 33) опорные 

точки (узлы) в программе CorelDRAW могут быть трех типов: 
1. Опорная точка, соединяющая две кривые «на изгиб», 

называется угловой опорной точкой (cusp node). У такой 
опорной точки управляющие линии («рычаги») независимы 
друг от друга как по направлению, так и по длине. 
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2.  Опорная точка, без излома соединяющая две кривые, 
называется гладкой опорной точкой (smooth node). У такой 
опорной точки управляющие линии («рычаги») независимы 
друг от друга только по величине, а по направлению они 
всегда составляют прямую линию, которая является общей 
касательной. Перемещение одной управляющей линии вле-
чет за собой перемещение и другой. 

 

     
 

Рисунок 33 
 

3. Опорная точка, без излома и с одинаковой кривизной 
соединяющая две кривые, называется симметричной опор-
ной точкой (symmetrical node). У такой опорной точки 
управляющие линии зависят друг от друга и по направле-
нию, и по величине. 

 
Рисование криволинейных сегментов 

 
С помощью инструмента Безье (Bezier) можно также лег-

ко создавать криволинейные сегменты. Для этого необходи-
мо включить инструмент, подвести курсор к начальной точ-
ке, нажать левую кнопку мыши и потянуть в сторону. Из 
появившейся опорной точки выдвинутся управляющие ли-
нии. Размер и угол наклона управляющих линий определяют 
кривизну сегмента, входящего в эту точку. 

Для получения выпуклого сегмента кривой первую 
управляющую точку следует перемещать в сторону предпо-
лагаемой выпуклости, а вторую – в противоположную сто-
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рону. Если вторую точку перемещать в ту же сторону, полу-
чается S-образная кривая (рисунок 34). 

 

 
 

Рисунок 34 

 
Следует использовать как можно меньше опорных точек 

для того, чтобы получать достаточно сложный контур: 
- для кривой, имеющей одно направление, требуется 

одна опорная точка; 
- для кривой, плавно изменяющей свое направление, 

требуется две опорных точки (в начале и конце); 
- для кривой, изменяющей свое направление под углом, 

требуется опорная точка в каждой точке перегиба. 
 
Инструменты группы Размерная линия (Dimension) 

 
При работе с чертежами и схемами, помимо собственно 

формы изображаемых объектов, главную роль играют пра-
вильно и точно построенные размерные линии. Для про-
грамм векторной графики составление чертеж, схем и пла-
нов - неотъемлемая задача. Для этой работы в программе 
используется шесть инструментов, создающих размерные 
линии (рисунок 35). 

 

 
                    1 2 3 4 5 6    

 
Рисунок 35 
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1.  Инструмент Автоматическая размерная линия (Auto 
Dimen-sion) создает размерную линию в зависимости от 
направления движения мыши (для однозначного переклю-
чения между вертикальными, горизонтальными и наклон-
ными размерными линиями следует использовать клавишу 
<Таb>). 

2.  Инструмент Вертикальная размерная линия (Vertical 
Dimension) служит для создания именно вертикальной раз-
мерной линии, которая остается таковой даже при измене-
нии положения объекта. 

3.  Инструмент Горизонтальная размерная линия (Ho-
rizontal Dimension) служит для создания горизонтальной 
размерной линии, которая остается таковой даже при изме-
нении положения объекта. 

4.  Инструмент Наклонная размерная линия (Slanted 
Dimension) служит для создания наклонной размерной ли-
нии, которая может изменяться вместе с объектом. 

5.  Инструмент Выноска (Callout) - для создания ярлы-
ков, прикрепляемых к объектам. 

6. Инструмент Угловая размерная линия (Angular 
Dimension) служит для создания размерной дуги, отобра-
жающей значение величины угла. 

Создание любых линейных размерных линий – процесс, 
состоящий из трёх этапов (рисунок 36): 

- первый щелчок фиксирует начальную точку размерной 
линии; 

- второй щелчок фиксирует конечную точку размерной 
линии; 

- третий щелчок фиксирует расстояние от точек до соб-
ственно размерной линии с надписью. 

Для привязки размерных или соединительных линий к 
объекту следует подвести курсор к одному из активизирую-
щихся узлов точки, который называется точкой привязки 
(snap point), и щелкнуть кнопкой мыши. 

Процесс создания угловой размерной линии состоит из 
четырех этапов (рисунок 37): 

- первый щелчок фиксирует начальную точку угла; 
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- второй и третий щелчки фиксируют точки на лучах угла; 
четвертый щелчок фиксирует расстояние от точек на лу-

чах до собственно размерной линии с надписью. 
Инструмент Выноска (Callout) служит для создания ли-

нии, которая соединяет определенную точку объекта с 
надписью, пояснением или любым другим текстовым бло-
ком. Выноски также могут быть «привязаны» к объекту. 

 

           
 

                            Рисунок 36                      Рисунок 37 

 
Инструмент Выноска (Callout) 

 

 
 

Рисунок 38 
 

Для рисования выноски первый щелчок выполняется с 
«привязкой» к опорной точке объекта, затем второй щелчок 

в точке перегиба и, наконец, третий - в начале строки тек-
ста (рисунок 38). 
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Инструменты Соединительная линия (Connector Line) и 
Интерактивный соединитель (Interactive Connector) 
 
Инструмент Соединительная линия (Connector Line) 

служит для создания соединительной линии, связывающей 
два объекта и сохраняющей эту связь при любых перемеще-
ниях и трансформациях объектов. Такая линия без объектов 
превращается в обычную прямую. Если один конец линии 
«привязан» к объекту, то второй (свободный) может быть 
«фиксирован» к странице (рисунок 39). 

Создание соединительной линии состоит в щелчке на 
опорной точке одного объекта и опорной точке другого объ-
екта. Параметры линии (цвет и толщина) изменяются, как и 
обводка любого другого объекта. 

Инструмент Интерактивный соединитель (Interactive 
Connector) предназначен для создания разнообразных блок-
схем. В отличие от инструмента Соединительная линия 
(Connector Line) данный инструмент может создавать только 
вертикальные и горизонтальные линии. При этом при переме-
щении исходных объектов привязка к опорным точкам сохра-
няется. Если требуется, привязку можно удалить (рисунок 40). 

 

      
 
                           Рисунок 39                     Рисунок 40 

 
Для того чтобы соединить два объекта с помощью ин-

струмента Интерактивный соединитель (Interactive Connec-
tor), необходимо подвести курсор инструмента к одной из 
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опорных точек первого объекта и, нажав кнопку мыши, про-
тянуть линию до одной из опорных точек второго объекта. 

При трансформировании исходного объекта соедини-
тельная линия автоматически изменяется с тем, чтобы со-
хранить связь. 

При удалении опорной точки, к которой относится со-
единительная линия, последняя осуществляет привязку к 
другой ближайшей точке. 

 
Инструмент Стрелка (Pick) 

 
Для того чтобы выполнять какие-либо действия с объ-

ектом, последний должен быть указан, «выделен» из всех 
остальных. 

Для однозначного указания на предмет предназначен 
специальный инструмент выделения Стрелка (Pick), распо-
ложенный в верхней части панели инструментов. 

Свидетельством «выделенности» являются маркеры 

(черные квадратики) вокруг объекта и крестик в центре, а 
также информация полосы состояния. Если выделено не-
сколько объектов, то маркеры охватывают их в виде «габа-
ритного прямоугольника» (рисунок 41). 

 

 
 

Рисунок 41 
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Способы выделения объектов 
С помощью инструмента Стрелка (Pick) объекты выде-

ляются несколькими способами: 
- отдельный объект проще всего выделить щелчком мыши; 
- выделить объект можно, окружив его штриховой рам-

кой (marquee). Обычно в область выделения попадают объ-
екты, которые целиком окружены штриховой рамкой; 

- для выделения объектов можно использовать клавиа-
туру. Каждое нажатие клавиши <ТаЬ> выделяет объект за 
объектом, в прямой последовательности, а сочетание кла-
виш <Shift> + <Tab> - в обратной последовательности; 

- для выделения всех объектов следует выполнить ко-
манду Объекты (Objects) меню Редактировать/Выделить все 
(Edit/Select All). Такого же результата можно достичь двой-
ным щелчком на кнопке инструмента Стрелка (Pick). 

Для отмены выделения достаточно щелкнуть кнопкой 
мыши на любом чистом месте рабочей области или нажать 
клавишу <Esc>. 

 
Другие функции Инструмента Стрелка (Pick) 

 
Маркеры, которые возникают при работе с инструментом 

Стрелка (Pick), являются не только свидетельством факта 
«выделенности», но и используются и для других целей. 

С помощью маркеров можно удобно и наглядно масшта-
бировать выделенный объект. Нажатие клавиши <Shift> вы-
зывает асштабирование от центра. Клавиша <Ctrl> ведет к 
увеличению объектов в целое число раз. Боковые маркеры 

используются для непропорционального масштабирования 
(рисунок 42). 

При повторном выделении объектов маркеры приобре-
тают форму стрелок. С помощью угловых стрелок осуществ-
ляется вращение вокруг оси. Боковые стрелки служат для 
наклона объекта по горизонтали или по вертикали. 

Также инструмент Стрелка (Pick) может перемещать 
объект или совокупность объектов, для этого нужно «захва-
тить» объект и переместить в нужном направлении. 
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Рисунок 42 
 

Инструмент Форма (Shape) 
 
Инструмент Форма (Shape) является инструментом ре-

дактирования векторных контуров. Он позволяет изменить 
форму любого объекта, что достигается путем перемещения 
опорных и управляющих точек, изменения их типа, добав-
ления и удаления опорных точек (рисунок 43). 

При выделении объекта с помощью инструмента Форма 
(Shape) отображаются все опорные точки данного объекта, а 
опорная точка, к которой подведен курсор инструмента, ак-
тивизируется. 

 

 
 

Рисунок 43 
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Работа инструмента Форма (Shape) со стандартными 
объектами и произвольными кривыми 

 
Объекты, созданные инструментом Прямоугольник 

(Rectangle), при изменении любой их опорной точки могут 
получить закругление или изменить его радиус. 

Объекты, созданные инструментом Эллипс (Ellipse), мо-
гут быть превращены в секторы или дуги. 

Объекты, созданные инструментами группы Много-
угольник (Polygon), подвергаются так называемому «сим-
метричному редактированию»: при перемещении любой 

опорной точки трансформируются в симметричный объект 
другой формы. 

При работе с текстовыми объектами инструмент Форма 
(Shape) позволяет изменить межбуквенные и межсловные 
интервалы. Для выполнения функций, возложенных на ин-
струмент Форма (Shape) при работе с произвольными кри-
выми, необходимо выделить одну или несколько опорных 
точек и приступить к редактированию. 

 
Панель Редактор узлов (Node Edit) 

 
Все традиционные функции, необходимые для работы с 

сегментами и опорными точками, сконцентрированы в па-
нели Редактор узлов (Node Edit), которая находится в меню 
Окно/Панели типа Docker (Window/Dockers), вызывается 
командой Редактор узлов (Node Edit) или с помощью кла-
виш <Ctrl> + <F 10>. 

Инструментальная полоса Свойства (Property Ваг) при 
включении инструмента Форма (Shape) дублирует все ко-
манды панели Редактор Узлов (Node Edit) (рисунок 44). 

 

 
                  1    2   3  4   5   6   7   8   9  10 11 12 13 14 15 16 17 18 

 
Рисунок 44 
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Добавление и удаление опорных точек 
 

К объектам типа «кривая» можно добавлять любое коли-
чество опорных точек. Для этого необходимо щелкнуть 
кнопкой мыши, установив курсор в требуемом месте сегмен-
та, при этом потенциальная точка отображается в виде чер-
ного кружка. Чтобы эта потенциальная точка превратилась в 
реальную, нужно еще нажать кнопку со знаком плюс (на ри-
сунке 44 обозначено цифрой 1) на инструментальной полосе 
Свойства (Property Ваг). 

Удаление опорных точек – неотъемлемая часть работы с 
формой. Для удаления одной или нескольких опорных точек 
необходимо выделить и нажать кнопку со знаком минус (циф-
ра 2) на инструментальной полосе Свойства (Property Ваг). 

 
Преобразование прямолинейных сегментов  

в криволинейные и наоборот 
 

Каждый отдельный сегмент может быть только двух ви-
дов: прямолинейным или криволинейным. При выделении с 
помощью инструмента Форма (Shape) какой-либо опорной 
точки на полосе состояния отображается тип сегмента – 
Прямой (Line) или Кривой (Curve). 

Для преобразования вида сегмента следует выделить 
требуемый сегмент, щелкнув на нем, и использовать до-
ступную в данный момент кнопку на инструментальной по-
лосе Свойства (Property Ваг): В прямую (То Line) (цифра 5) 
или В кривую (То Curve) (цифра 6) в зависимости от вида 
исходного сегмента. 

Преобразование криволинейного сегмента в прямолиней-
ный сразу даёт результат, а обратное преобразование тре-
бует дополнительной работы – ручной установки кривизны 
сегмента. С помощью появившихся на прямой управляющих 
точек необходимо добиться задуманной кривизны сегмента. 
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Соединение и разрыв контура 
 

Для превращения открытого контура в закрытый необ-
ходимо соединить начальную и конечную опорные точки, 
что выполняется двумя способами: 

1. Для непосредственного соединения опорных точек их 
следует выделить и нажать кнопку Соединить два узла (Join 
Two Nodes) (цифра 3) на инструментальной полосе Свойства 
(Property Ваг). Если опорные точки расположены друг над 
другом, то они соединяются и преобразуются в одну точку в 
месте расположения. Если опорные точки расположены на 
расстоянии друг от друга, то они соединяются в центре это-
го расстояния. 

2. Крайние опорные точки могут быть соединены с по-
мощью прямолинейного сегмента. Для этого следует исполь-
зовать кнопку Автоматическое замыкание контура (Auto-
close) (цифра 13) на инструментальной полосе Свойства 
(Property Ваг). 

Для разрыва контура в определенной точке необходимо 
эту точку выделить, а затем нажать кнопку Разорвать кри-
вую (Break Curve) (цифра 4) на инструментальной полосе 
Свойства (Property Ваг). В результате на месте одной опор-
ной точки образуются две. 

Разбить контур можно также на несколько отдельных 
под-контуров. Для отделения подконтура в самостоятельный 

объект необходимо выделить хотя бы одну опорную точку 
этого под-контура и нажать кнопку Извлечь подконтур 
(Extract Subpath). 

 
Выравнивание опорных точек 

 
При разработке фирменных знаков или шрифта довольно 

часто возникает необходимость расположения определенных 
точек строго горизонтально или вертикально, другими сло-
вами, в выравнивании. 
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Полоса Свойства (Property Ваг) располагает кнопкой Вы-
равнивание узлов (Align Nodes) (цифра 16), нажатие на ко-
торую позволяет вывести на экран одноименное диалоговое 
окно (рисунок 45). 

 

 
 

Рисунок 45 
 
Выравнивать горизонтально или вертикально, а также 

одновременно можно любое количество выделенных опор-
ных точек.  

Выравнивание управляющих точек вместе с опорными 
точками (флажок Выравнивание управляющих точек (Align 
Control Points)) позволяет совместить две кривые сложной 
формы. 

  

Масштабирование и вращение сегментов 
 

В программе CorelDRAW можно трансформировать не 
только объект целиком, но и отдельные сегменты или их 
совокупности. Это выполняется с помощью инструменталь-
ной полосы Свойства (Property Ваг), на которой для этой 
цели предусмотрены две кнопки. 

- В результате нажатия кнопки Растяжение и масштаби-
рование узлов (Stretch And Scale Nodes) (цифра 14) вокруг 
выделенных сегментов появляются маркеры, характерные 
для инструмента Стрелка (Pick). Действия по масштабиро-
ванию сегментов ничем не отличаются от действий инстру-
мента Стрелка (Pick) для объектов (рисунок 44). 
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- В результате нажатия кнопки Вращение и наклон уз-
лов (Rotate And Skew Nodes) (цифра 15) вокруг выделенных 
сегментов появляются маркеры, также характерные для ин-
струмента Стрелка (Pick). Действия по вращению и накло-
нам сегментов ничем не отличаются от действия инструмен-
та Стрелка (Pick). 

Флажок Эластичный режим (Elastic Mode) (цифра 17) 
задает особый способ трансформации выделенных сегмен-
тов: чем дальше сегмент от непосредственно трансформиру-
емого, тем меньше степень его трансформации. 

 
Инструменты Нож (Knife) и Ластик (Eraser) 

 
Рядом с инструментом Форма (Shape) на панели типа 

Flyout представлены инструменты - Нож (Knife) и Ластик 
(Eraser), которые позволяют разделять векторный объект, и 
один инструмент Свободное трансформирование (Free 
Transform), пред-назначенный для интерактивного выпол-
нения основных трансформаций (рисунок 46). 

Инструмент Нож (Knife) позволяет разбить объект на 
несколько подконтуров или несколько отдельных объектов. 
Для разбиения контура по прямой линии следует подвести 
курсор к первой точке и, когда курсор в виде ножа займет 
строго вертикальное положение, выполнить щелчок. 

Ко второй точке будет протянута «резиновая линия». 
Второй щелчок, также выполненный при вертикальном по-
ложении ножа, выполнит разбиение (рисунок 47). 

Разбиение можно произвести также способом свободного 
рисования, для этого в первой точке нужно выполнить не 
щелчок, а нажав кнопку мыши нарисовать произвольную 
линию. Кнопка отпускается в момент пересечения контура. 

На инструментальной полосе Свойства (Property Ваг) 
находятся две кнопки: 

-  Кнопка Сохранить как один объект (Leave as one 
object) препятствует разбиению исходного объекта на не-
сколько отдельных. 
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-  Флажок Автоматическое замыкание контура (Auto-
Close On Cut) обеспечивает автоматическое создание закры-
того контура после завершения работы инструмента Нож 
(Knife). 

 

 
 

Рисунок 46 
 

 
 

Рисунок 47 
 
Инструмент Ластик (Eraser) позволяет «стереть» часть 

векторного объекта. Если полоса стирания разрезает объект, 
то образуются независимые объекты. 

Ширина полосы стирания инструмента находится в диа-
пазоне от 0,025 до 2540 мм на инструментальной полосе 
Свойства (Property Ваг) в полосе Ширина ластика (Eraser 
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Thickness). При включении кнопки Автоматическое умень-
шение узлов в результате стирания (Reduce on Erase) про-
грамма автоматически обеспечивает оптимизацию контура. 

 
Инструмент Свободное трансформирование  

(Free Transform) 
 

 
 

Рисунок 48 
 

При включении инструмента на инструментальной поло-
се Свойства (Property Ваг) становятся доступными четыре 
кнопки: Свободное вращение (Free Rotation) (на рисунке 48 
обозначено цифрой 1), Свободное отражение (Free Angle 
Reflection) (цифра 2), Свободное масштабирование (Free 
Scale) (цифра 3) и Свободный наклон (Free Skew) (цифра 4). 

Инструмент Свободное вращение (Free Rotation) харак-
терен тем, что точкой вращения выделенного объекта явля-
ется место щелчка, из которого «вырастает» штриховая ли-
ния - рычаг вращения, направление которого определяет угол 
вращения, а расположение курсора на нем - точность опре-
деления угла вращения: чем дальше от центра вращения, тем 
точнее можно определять угол. Значения угла вращения 
непрерывно отображаются на полосе состояния (рисунок 49). 

Для инструмента Свободное отражение (Free Angle 
Reflection) принцип работы такой же, исключая тот факт, 
что штриховая линия в данном случае является линией от-
ражения, относительно которой происходит трансформация. 
Инструмент Свободное масштабирование (Free Scale) рабо-
тает так же, как и два предыдущих инструмента, но уже без 
штрихового рычага. Отсутствует и какая бы то ни было ин-
формация в полосе состояния. 

 

  1       2    3    4 
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Рисунок 49 
 
Инструмент Свободный наклон (Free Skew) ничем не от-

личается по принципам работы от предыдущего инструмен-
та, но на полосе состояния отображаются значения переме-
щения по осям, расстояния и угла отражения.  

 
4. Работа с текстом 

 
Одной из традиционно сильных сторон программы Corel 

DRAW является работа с текстом. В программе можно опре-
делять гарнитуру, начертание, кегль и цвет шрифта и мно-
гое другое. Неограниченные возможности предоставляются 
по внешнему оформлению шрифта с помощью цветных, де-
коративных и градиентных заливок, а также всевозможных 
эффектов. 

Ввод текста и его редактирование можно осуществлять 
как непосредственно в рабочем окне, так и в специальном 
диалоговом окне Редактирование текста (Edit Text). 

Текстовые объекты в программе CorelDRAW бывают двух 
видов: заголовочные (artistic) и абзацные (paragraph). Типы 
текста вводятся с помощью одного инструмента Текст (Text). 

 
Заголовочный текст (Artistic Text) 

 
С помощью инструмента Текст (Text) можно в любом ме-

сте вводить произвольный текст. 



50 

 
 

Рисунок 50 
 

Для набора заголовочного текста необходимо включить 
инструмент Текст (Text), подвести курсор к точке начала 
набора текста и щелкнуть кнопкой мыши, в результате чего 

на экране появляется курсор набора в виде мерцающего вер-
тикального штриха, который перемещается по мере набора 
(рисунок 50). Для перевода строки, т.е. переноса курсора на 
новую строку, необходимо использовать клавишу <Enter>. 

 
Абзацный (блочный) текст (Paragraph Text) 

 
Основной текст (main text), который чаше всего отличается 

значительным объемом, обычно оформляется полосой набора 
(колонками определенной ширины), в результате текст вы-
глядит блоками, поэтому его можно назвать блочным. 

Другой особенностью такого текста является автомати-
ческая верстка по ширине колонки, при добавлении или при 
удалении автоматически переверстывается. Важным элемен-
том такого текста является абзац, поэтому его еще можно 
назвать абзацным. 

Для создания блочного текста с помощью инструмента 
Текст (Text) необходимо поступить следующим образом: 

- Включив инструмент, нужно создать текстовый прямо-
угольник тем же способом, которым рисуется объект при по-
мощи инструмента Прямоугольник (Rectangle) или Эллипс 

Пример заголовочного текста: ¶ 
¶ 

Я ненавижу тебя за то,¶ 
Что жить без тебя нет силы.¶ 
Я ненавижу тебя за то,¶ 
Что сильней ни кого не любила.¶ 
Я ненавижу тебя за то,¶ 
Что ты мой, без конца, без остатка¶  
Я ненавижу тебя за то,¶ 
Что в твоих мне руках так сладко.¶ 
Я ненавижу тебя за то,¶ 
Что без тебя меня нет самой!¶ 
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(Ellipse). Полученный текстовый прямоугольник не имеет па-
раметров заливки или обводки, поэтому на печать не выво-
дится и, не будучи выделенным, не отображается на экране. 

-  После создания текстового прямоугольника в его ле-
вом верхнем углу начинает мерцать текстовый курсор, сиг-
нализируя «готовность инструмента к набору». 

При наборе блочного текста следует иметь в виду, что 
программа автоматически размещает текст по строкам с уче-
том выбранного типа и прочих установок, а пользователю 
следует нажимать клавишу <Enter> только в конце абзаца. 

Если в текстовом прямоугольнике набрано текста боль-
ше, чем в состоянии отобразиться при данных параметрах 
шрифта, то в маленьком прямоугольнике под полосой набо-
ра появляется условный знак «переполнения» текстового 
блока – красная треугольная стрелка (рисунок 51). 

 

 
 

Рисунок 51 
 

Для того чтобы изменить размер текстовой рамки, не-
обходимо выделить текстовый объект с помощью инстру-
мента Стрелка (Pick) и посредством маркеров масштабиро-
вания добиться требуемого размера. 

В программе предусмотрен режим, при котором высота 
текстовой рамки автоматически регулируется соответствен-
но объему введенного текста и его параметрам. 

Пример абзацного 
текста: 
Если текст превы-
шает размер знак 
«переполнения» в 
виде треугольной 
стрелки. 
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Для перехода в этот режим необходимо в разделе Абзац-
ный текст (Paragraph Text) диалогового окна Параметры 
(Options) установить флажок Расширять или сжимать рамку 
абзацного текста до размеров текста (Expand And Shrink 
Paragraph Text Frames To Fit Text). 

 
Конвертирование заголовочного текста  

(Artistic Text) в абзацный (Paragraph Text) и наоборот 
 

Может возникнуть необходимость текст, набранный в 
качестве заголовочного, превратить в абзацный и наоборот. 

Для такого случая в программе предусмотрена возможность 
конвертирования одного вида текста в другой. 

При выделении заголовочного текста в меню Текст 
(Text) становится доступной команда Конвертировать в аб-
зацный текст (Convert to Paragraph Text), а при выделении 

абзацного текста эта команда заменяется на Конвертировать 
в заголовочный текст (Convert К Artistic Text). 

Достаточно быстро можно превратить один вид текста в 
другой, если использовать кнопку Конвертировать текст 
(Convert Text), расположенную на инструментальной полосе 
Свойства (Property Ваг) (рисунок 52). 

 

 
 

Рисунок 52 

 
Диалоговое окно Форматирование текста (Format Text) 

 
Программа CorelDRAW предлагает управление парамет-

рами шрифта: выбор гарнитуры и начертания, определение 
кегля и интерлиньяжа, кернинга и трекинга, возможность 
сдвига по вертикали и вращения. Причем параметрами мож-

Конвертировать текст 
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но определять до набора текста, а также изменять парамет-
ры уже набранного и ранее форматированного текста. 

Основным и полным инструментом форматирования текста 
является диалоговое окно Форматирование текста (Format 
Text), которое вызывается на экран одноименной командой 
меню Текст (Text). В диалоговом окне шесть вкладок для аб-
зацного текста: Шрифт (Font), Выключка (Align), Интервал 
(Space), Табуляция (Tab), Рамки и колонки (Frames and Co-
lumns), Эффекты (Effects) или три вкладки для заголовочного 
текста: Шрифт (Font), Выключка (Align), Интервал (Space). 

 
Вкладка Шрифт (Font) 

 
Вкладка Шрифт (Font) диалогового окна Форматирование 

текста (Format Text) предлагает выбор гарнитуры шрифта, на-
чертания шрифта кегля и других параметров (рисунок 53). 

 

 
 

Рисунок 53  
 
Под гарнитурой шрифта понимается набор шрифтов, име-

ющих единый стилевой рисунок и единое имя, например, гар-
нитуры Times, Helvetica, Декор, Лазурского и многие другие. 
И хотя, строго говоря, гарнитура – это понятие в достаточной 
степени условное, практически всегда в наборных Шрифтах 
основным в гарнитуре принято считать прямое светлое начер-
тание. Оно определяет основные особенности шрифта. 

В списке Шрифт (Font) можно выбрать одну из гарнитур 
шрифта, инсталлированных в операционной системе. А в 
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списке Начертание (Style) - одно из четырех стандартных 
начертаний: Нормальное прямое (Normal), Нормальное кур-
сивное (Normal- Italic), Полужирное прямое (Bold) и Полу-
жирное курсивное (Bold-Italic). 

В списке Size (Кегль) определяется произвольное значение 
кегля в диапазоне от 0,001 до 3 000 пунктов, широкий диа-
пазон означает практически непрерывную шкалу размеров. 

Изменить единицу измерения можно в поле Единица из-
мерения шрифта по умолчанию (Default text units) раздела 
Текст (Text) диалогового окна Параметры (Options). 

В списках Подчеркивание (Underline), Перечеркивание 
(Strikethru) и Надчеркивание (Overscore) предлагается выбор 
линий для редактирования строк текста: Без линии (None), 
Одиночная тонкая (Single Thin), Одиночная толстая (Single 
Thick), Двойная тонкая (Double Thin), Двойная толстая 
(Double Thick), а слово «Word» в названии команды означа-
ет, что линия относится только к словам (пробелы не под-
черкиваются). 

Кнопки Редактировать (Edit...) рядом со списками выво-
дят на экран диалоговые окна Редактировать подчеркивание 
(Edit Underline), Редактировать перечеркивание (Edit 
Strikethru) и Редактировать надчеркивание (Edit Overscore), 

которые позволяют определить параметры соответствующих 
линий. Поля Толщина (Thickness) и Смещение относительно 
базовой линии (Baseline Shift) служат для ввода цифровых 
значений, определяющих толщину и положение линии. 

 
Вкладка Выключка (Align) 

 
Инструмент Свободное вращение (Free Rotation) харак-

терен тем, что точкой вращения выделенного объекта явля-
ется место щелчка, из которого «вырастает» штриховая ли-
ния - рычаг вращения, направление которого определяет 
угол вращения, а расположение курсора на нем – точность 
определения угла вращения: чем дальше от центра враще-
ния, тем точнее можно определять угол. Значения угла вра-
щения непрерывно отображаются на полосе состояния. 
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Полный набор функций вкладки Выключка (Align) до-
ступен только для абзацного текста. В этой вкладке сгруп-
пированы параметры текста, связанные с выравниванием 
относительно полосы набора. 

Полиграфисты называют выключкой «доведение строки 
в процессе набора до заданного формата», но поскольку этот 

процесс целиком переложен на компьютерную программу, то 
выключку стали понимать широко: как способ организации 
абзаца относительно условной вертикальной линии. Исходя 
из этого выключка может быть левой, центральной, правой, 
по формату и полной. Определить нужный тип можно в поле 
Выключка (Alignment) (рисунок 54). 

 

 
 

Рисунок 54 
 

Для выключки по формату и полной выключки становятся 
доступными поля определения придельных интервалов: Мак-
симальный межсловный пробел (Max. word spacing), Мини-
мальный межсловный пробел (Min. word spacing), Максималь-
ный межбуквенный пробел (Max. char, spacing). Эти значения 
необходимы программе для обеспечения автоматической 
верстки в пределах полной полосы набора. 

Под абзацными отступами понимается расстояние между 
краями строк с границей полосы набора. Отступ может быть 
как с левой, так и с правой стороны, а кроме того, к абзац-
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ным отступам относится и красная строка. При установке 
значения отступа данное значение относится только к выде-
ленному одному или нескольким абзацам. Это позволяет в 
одном документе варьировать расположение абзацев отно-
сительно боковых границ полосы набора. 

В поле Отступы (Indents) предоставляется возможность 
устанавливать отступы: для абзацного текста Красная строка 
(First line), Слева (Left), Справа (Right) (рисунок 55). 

При выделении одного или нескольких символов стано-
вится доступным поле Смещение символа (Character shift), в 
котором можно не только определить смещение символов по 
горизонтали (поле Horizontal) и по вертикали (поле Verti-
cal), но и вращение их на заданный угол (поле Rotation). 

 

   
   

Рисунок 55 
 

Все символы в строке выравниваются по базовой линии 
(baseline) - условной линии, параметры которой сохраняются в 
шрифтовом файле для каждого символа. Это дает возмож-
ность, во-первых, легко обеспечивать правильный набор стро-
ки, а во-вторых, если требуется, смещать выделенный символ 
на определенное расстояние по вертикали от базовой линии. 

Вертикальное смещение в сочетании с уменьшением сим-
вола позволяет легко формировать всевозможные индексы 
(верхние, нижние), а также использовать эту функцию в ху-
дожественных целях. 

 

Пример текста с  
выключкой влево 
    Пример текста с полной     
             выключкой 
Пример текста с  
выключкой по центру   
                   Пример текста с       
           выключкой по фoрматy  
Пример текста с  
выключкой вправо 

Под абзацными отступами 
понимается расстояние края-
ми строк и границы полосы 
 
       «Красная строка» 
Под абзацными отступами 
понимается расстояние края-
ми строк и границы полосы 
 
Левый отступ      Правый отступ 
  



57 

Вкладка Интервалы (Space) 
 

На вкладке Интервалы (Space) расположены поля для 
установки различных интервалов, а также для определения 
параметров автоматического переноса (рисунок 56). 

 

 
 

Рисунок  56 
 

В поле Символы (Character) можно определить интервалы 
между словами, в поле Межсловные пробелы (Word) - в про-
центах от ширины пробела данного шрифта, в поле Интерлинь-
яж (Line) в процентах от кегля шрифта или от высоты шрифта. 

В текстовом наборе под интерлиньяжем (leading) пони-
мают расстояние между базовыми линиями соседних строк. 
Это расстояние имеет важнейшее значение для комфортного 
вос-приятия текста. Кроме того, интерлиньяж играет не по-
следнюю роль в текстовых композициях. 

В поле Абзац (Paragraph) можно определить отбивки во-
круг выделенного абзаца, в поле До абзаца (Before para-
graph) - перед абзацем и в поле После абзаца (After 
paragraph) - после. Если эти два параметра относятся к со-
седним абзацам, то эти значения суммируются. 

При установке флажка Автоматический перенос (Use 
automatic hyphenation) становится доступным кнопка Уста-
новки переноса (Hyphenation Settings...), щелчок по которой 
выводит на экран одноименное диалоговое окно. 
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Поле Горячая зона (Hot zone) служит для определения 
ширины зоны переноса в единицах, выбираемых из списка 
рядом. В пределах этой зоны обеспечивается автоматиче-
ский перенос английского текста. При этом в полях Мини-
мальная длина слова (Min. word length). Минимальное ко-
личество символов до (Min. characters before) и Минималь-
ное количество символов после (Min. characters after) уста-
навливаются дополнительные условия переноса. Флажок 
Разбивать аббревиатуры (Break capitalized) позволяет осуще-
ствить перенос сокращенных слов. 

 
Вкладка Табуляция (Tab) 

 
Вкладка Табуляция (Tab) совершенно необходима при 

работе с данными табличного вида, поскольку с ее помощью 

можно организовывать выравнивание столбцов текста тре-
буемым образом. 

В левой части диалогового окна представлен список та-
буляторов, установленных в данном документе (рисунок 57). 
В столбце Табуляторы (Tabs) указаны координаты табулято-
ра относительно горизонтальной линейки полосы набора. 
Для изменения этой координаты достаточно ввести новое 
значение, щелкнув в пределах конкретной ячейки. 

В следующем столбце Выравнивание (Alignment) уста-
навливается тип табулятора. Для его изменения следует 
щелкнуть в пределах необходимой ячейки, которая превра-
щается в список: Левый (Left), Правый (Right), Центральный 
(Center), Десятичный (Decimal). 

Столбец Отточие (Leadered) позволяет включать или ис-
ключать символы отточия, конкретный вид которых опре-
деляется в поле Отточие (Trailing Leader). В качестве «отто-
чия» может служить не только точка, но в принципе любой 
символ, который определяется в поле Символ (Character). 

Расстояние между символами отточия устанавливается в по-
ле Интервал (Spacing). В нижней части расположено поле 
просмотра, которое отображает установки и помогает в экс-
периментах и творческих поисках. 
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Рисунок 57 
 

Кнопки диалогового окна служат для добавления еди-
ничных табуляторов (кнопка Добавить (Add tab)) и для 
множественных табуляторов (Установить табуляторы каж-
дые (кнопка Set tabs every)) через равные интервалы, размер 
которых определяется в цифровом поле справа. 

Кнопка Удалить табулятор (Delete tab) и кнопка Удалить 
все (Delete All) служат для удаления одного табулятора, выде-
ленного в списке, или всех табуляторов данного документа. 

 
Вкладка Рамки и колонки (Frames and Columns) 

 
Вкладка Рамки и колонки (Frames and Columns) доступ-

на только для абзацного текста. В ней представлены поля, 

которые позволяют определить параметры многоколоночно-
го набора (рисунок 58). 

В поле Число колонок (Number of columns) устанавлива-
ется количество колонок. Большое поле Ширина колонки и 
пробелы (Column width and gutter) служат для установки 
размеров колонки и пробелов между ними. В столбце Номер 
колонки (Column #) выбирается колонка, для которой в 
столбце Ширина (Width) определяется ширина, а в столбце 
Пробел (Cutler) - расстояние между колонками. 

Флажок Равная ширина колонок (Equal column width) 
следует устанавливать в случае, когда требуются колонки 
одинаковой ширины. В этом случае достаточно определить 
параметры одной колонки. 
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Рисунок 58 
 
В поле Ширина абзацной рамки (Paragraph frame width) 

отображается общий размер наборной полосы для информи-
рования пользователя. 

Список Вертикальное выравнивание (Vertical justification) 

предлагает возможность определить расположение неполной 
колонки: Сверху (Тор), По центру (Center), Снизу (Bottom) и 
По формату (Full). 

 
Вкладка Эффекты (Effects) 

 
Вкладка Эффекты (Effects) посвящена работе с маркера-

ми абзацев (bullets), которые широко применяются для 
оформления списков, а также с буквицами (drop caps), кото-
рые используются в заглавных абзацах. 

В списке Тип эффекта (Effect Туре) представлен соответ-
ствующий выбор: 

- Маркер абзаца (Вариант Bullet), который понимается 
как символ, размещаемый в начале каждого абзаца для бо-
лее четкого членения текста и, следовательно, лучшего вос-
приятия текста. 

- Вариант Буквица (Drop cap), который понимается как 
увеличенная первая буква абзаца, служащая сигналом начала 
текста и одновременно декоративным элементом (рисунок 59). 

- В поле Отступы (Indents) можно установить расстояние 
от края полосы набора, на котором располагается маркер аб-
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заца (Местоположение (поле Position)) и способ его размеще-
ния относительно текста. Вариант Простой маркер (Bulleted) 
обеспечивает расположение маркера внутри абзаца, а вариант 
Выступающий маркер (Hanging Indent) — расположение вне 
абзаца, текст которого набирается с отступом. 

 

 
 

Рисунок 59 
 
Следует иметь в виду, маркеры абзаца можно присвоить 

только абзацному тексту. 
В поле Расстояние от текста (Distance from text) можно 

определить интервал между буквицей. Вариант Простая бук-
вица (Dropped) позволяет разместить буквицу в пределах 
текста, а вариант Выступающая буквица (Hanging Indent) - 
в поле с отступом основного текста (рисунок 60). 

 

 
 

Рисунок 60 
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Рисунок 62 

 

Форматирование с помощью инструментальной полосы 
Свойства (Property Ваг) и панели Свойства объекта  

(Object Properties) 
 

Изменять параметры шрифта можно и с помощью ин-
струментальной полосы Свойства (Property Ваг), которая 

располагает почти всем необходимым для редактирования 
текста (рисунок 61). 

 

 
 

Рисунок 61  
 

Также предусмотрен вызов диалогового окна Формати-
рование текста (Format Text) и панели Свойства объекта 
(Object Properties) посредством кнопок. 

 

Размещение текста в объекте произвольной формы 
 
Программа CorelDRAW позволяет создавать набор в ко-

лонке произвольной формы. Для этого можно использовать 

любой закрытый графический контур в качестве контейнера 
для текста. 

Для размещения текста в 
графическом объекте (контей-
нере) необходимо включить ин-
струмент Текст (Text), подвести 
курсор к контуру объекта (кур-
сор должен изменить свою 
форму) и щелкнуть кнопкой 
мыши. После появления штри-
хового контура набора и тек-
стового курсора можно начи-
нать ввод текста (рисунок 62). 

 
Текст 

 в  
объекте 
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Направление текста вдоль произвольной траектории 
 

Текст, который связывается с объектом, может быть не 
только помещён внутрь, но и направлен вдоль контура объ-
екта как правильной, так и любой произвольной формы (ри-
сунок 63). 

Для «привязки» заголовочного текста к произвольной 

кривой необходимо выделить текстовый и графический объ-
екты, а затем выполнить команду Направить текст по тра-
ектории (Fit Text to Path...) меню Текст (Text). 

Для вывода текста непосредственно на траекторию кон-
тура необходимо включить инструмент Текст (Text), подве-
сти курсор к контуру (курсор должен изменить свою форму) 
и щёлкнуть кнопкой мыши. После появления текстового 
курсора можно начинать ввод текста. 

 

 
 

Рисунок 63 
 
Управление связанными динамически объектами (тек-

стом и кривой) осуществляется с помощью панели Напра-
вить текст по траектории (Fit Text to Path), которая вызы-
вается на экран одноименной командой меню Окно/Панели 
типа Docker (Window/ Dockers), или инструментальной по-
лосы (рисунок 64). 

В списке Ориентация текста (Text Orientation) (обозна-
чено цифрой 1) определяется ориентация текста относи-
тельно траектории. 

В следующем списке Вертикальное выравнивание (Verti-
cal Alignment) (обозначено цифрой 2) определяется разме-
щение текста относительно траектории по вертикали. 
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                   1        2         3          4        5      6 

 
Рисунок 64 

 

Если текст направляется вдоль открытого контура, то на 
панели Направить текст по траектории (Fit Text to Path) и 
на инструментальной полосе появляется еще один список 
Горизонтальное выравнивание (Horizontal Alignment), в ко-
тором определяется размещение текста по горизонтали. 

Поле Горизонтальное выравнивание (Horizontal Align-
ment) для замкнутого контура предназначено для выбора 
квадрата, с которого начинается размещение текста (обо-
значено цифрой 3). 

Флажок и кнопка Поместить на другой стороне (Place on 
other side) предназначены для размещения текста вдоль 
другой стороны контура. 

Кнопка Редактировать (Edit...) панели Направить текст 
по траектории (Fit Text to Path) служит для вывода на 
экран диалогового окна Смещения при направлении текста 
по траектории (Fit Text Р Offset), в котором можно опреде-
лить горизонтальное и вертикальное смещение текста отно-
сительно траектории. 

 

Конвертирование шрифта в кривые 
 

В программах верстки и графики шрифт может подвер-
гаться всевозможным трансформациям, однако изменить 
часть рисунка буквы они не позволяют. 

Шрифт создается в специальных программах, с помощью 
которых любой шрифт может быть отредактирован, дорабо-
тан и сохранён в одном из двух общепринятых форматов. 
Будучи инсталлированным в операционной системе, он ста-
новится доступным всем прикладным программам. 
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Однако существует возможность с помощью команды 
Преобразовать в кривые (Convert to Curves) меню Управле-
ние (Arrange) выделенный заголовочный текст конвертиро-
вать в совокупность контуров, которые сохраняют все 
внешние параметры и позволяют обращаться с ними, как с 
обычным векторным объектом. Эта команда активно ис-
пользуется в графическом дизайне. При создании логотипа 
сначала подбирается подходящий существующий шрифт, 
набирается название фирмы, используются всевозможные 
параметры форматирования, а затем шрифт конвертируется 
в кривые, с которыми и производится окончательная довод-
ка до оригинального дизайнерского уровня (рисунок 65). 

 

 
 

Рисунок 65 
 

Обтекание текстом графических объектов 
 

В программе CorelDRAW обтекание иллюстрации осно-
вано не на создании связи между конкретным текстом и 
конкретным объектом, а на том, что графическому объекту 
присваивается свойство обтекания, поэтому при размещении 

этого объекта в пределах абзацного текста автоматически 
происходит обтекание (рисунок 66). 

Пометить объект, как «обтекаемый», можно, установив 

курсор на объекте и щелкнув правой кнопкой мыши, а затем 
выполнив команду Обтекать абзацным текстом (Wrap Para-
graph Text). На инструментальной панели Свойства (Property 
Ваг) представлена кнопка Обтекать абзацным текстом (Wrap 
Paragraph Text), которая выполняет ту же функцию. 

Изменить расстояние между объектом и текстом можно 
следующим образом: необходимо выполнить щелчок правой 
кнопкой мыши, переместив курсор на объект, и выполнить 
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команду Свойства (Properties...), на панели Свойства объекта 
(Object Properties) открыть вкладку Общие (General) и в по-
ле Смещение обтекания текста (Text wrap offset) установить 
требуемое значение. 

 

 
 

Рисунок 66 
 

Диалоговое окно Edit Text 
 

Программа CorelDRAW не является текстовым редакто-
ром, тем не менее всеми основными функциями редактиро-
вания текста она располагает и даже имеет специальное 
диалоговое окно Редактирование текста (Edit Text), которое 
вызывается одноименной командой меню Текст (Text). 

Довольно большое поле, занимающее почти все окно, 
предназначено для ввода, редактирования и форматирова-
ния текста (рисунок 67). В это окно можно также импорти-
ровать текстовые файлы (кнопка Import...). 

В верхней части диалогового окна пред-ставлены поля 
для форматирования текста (выбор гарнитуры, кег-ля, 
начертания, выключки и маркирования абзацев или вклю-
чения буквицы). 

Кнопка Форматирование текста (Format Text...) выводит 
на экран одноимённое диалоговое окно, предназначенное 
для внешнего оформления. Кнопка Опции (Options) выводит 
список команд, основные из которых посвящены проверкам 
текста (проверке правописания, грамматики) и замене фраг-
ментов текста. 

Обтекание обекта     абзацным текстом  
Обтекание обекта        абзацным текстом 
Обтекание                                обекта  абзацным 
текстом                                      Обтекание обекта  
абзацным текстом    Обтекание обекта   
абзацным текстом   Обтекание обекта     
абзацным  текстом 
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Рисунок 67 
 

Включение графических объектов в текст 
 
Программа позволяет включать графические объекты в 

текстовый блок, причем эти объекты масштабируются про-
порционально шрифту. Данная функция весьма полезна для 
тех случаев, когда существует необходимость непосред-
ственно в тексте располагать какие-то графические знаки, 
например логотипы. Для размещения графического элемента 
в пределах текста используется буфер обмена Clipboard, а 
следовательно, команды Копировать (Сору), Вырезать (Cut), 
Вставить (Paste) меню Редактировать (Edit). 

 

Символы и специальные знаки 
 
В программе CorelDRAW представлена панель Символы 

и специальные знаки (Symbols and Special Characters), кото-
рая вызывается на экран одноименной командой меню с Ок-
но/Панели типа Docker (Window/Dockers) (рисунок 68). 

Объекты этой панели могут играть двоякую роль: если 
они переносятся в документ независимо, то становятся гра-
фическими объектами, а если они включаются в текст, то 
трактуются в качестве обычных символов. В верхнем списке 
панели Символы и специальные знаки (Symbols and Special 
Characters) отображен перечень шрифтовых файлов, тракту-
емых в качестве символьно-декоративных, а в поле ниже 
представлены изображения, хранящиеся в выбранном файле. 

 
Это большое поле 

предназначено для 
ввода редактирова-
ния и форматирова-

ния текста 
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Рисунок 68 
 

Выбрать символ можно щелчком кнопки мыши или с 
помощью определения так называемого (Alt-кода в поле 
Клавиша Keystroke). 

Размер символа определяется в поле Кегль (Symbol Size). 
 

 
 

Рисунок 69 
 

Команда Декоративная сетка из символов или специаль-
ных знаков (Tile Symbol/Special Character) дает возмож-
ность – перемещением из палитры одного единственного 
символа получить их правильно расположенную (в виде сет-
ки или таблицы) совокупность (рисунок 69). 

Параметры сетки определяются в диалоговом окне Па-
раметры декоративной сетки (Tile Options), которое вызы-
вается на экран одноименной командой меню панели. 

В поле Размеры сетки (Grid size) устанавливаются гори-
зонтальные и вертикальные параметры сетки в зависимости 
от выбранного варианта. 
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Проверка правописания 
 

Программа CorelDRAW располагает практически всеми 
функциями по обработке текста, в частности, всевозможные 
проверки (правописания, грамматики), функции замены и 
прочее. Все эти «удобства» ориентированы на английский 

язык и на многие европейские. В списке языков представлен 
и русский, однако практической пользы от этого нет, по-
скольку проверка не работает! 

 
5. Параметры заливок (Fill) и обводок (Outline) 

 

Для работы с параметрами обводок и заливок программа 
Corel Draw располагает инструментами, объединёнными в 
две группы: Заливка (Fill) и Обводка (Outline). 

Для того чтобы удалить заливку или обводку, использу-
ются кнопки Без заливки (No Fill) (на рисунке 70 Fill Flyout 
обозначено цифрой 6) и Без обводки (No Outline) (на ри-
сунке Outline Flyout обозначено цифрой 3). 

 

 
                1  2   3             4                    1   2  3   4  5   6    7 

 
Рисунок 70 

 

Одноцветные заливки 
 

Самый быстрый способ цветной заливки объекта - это ис-
пользование панели Палитра Цветов (Color Palette), которая 
по умолчанию выводится в правой части экрана (рисунок 71).  

Если цвета этой панели не удовлетворяют пользователя, 
то при помощи меню Окно (Windows) команды Цветовые 
палитры (Color Palettes) можно выбрать другую палитру. 

Присваивать цвет заливки из палитры цветов выделен-
ному объекту следует щелчком левой кнопкой мыши, а цвет 
обводки - правой. Также цвет можно присвоить методом 
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«перетаскивания». Достаточно «захватить» нужный цвет и 
«перенести» его на объект, при этом, если удерживать кла-
вишу <Shift>, присвоение цвета произойдёт только для за-
ливки, а клавишу <Alt> - для обводки. 

 

 
 

Рисунок 71 
 
Диалоговое окно Однотонная заливка (Uniform Fill) 

 
У этих диалоговых окон четыре режима определения 

цвета: Полный спектр цветов и возможностей работы с цве-
том предоставляет диалоговое окно Однотонная заливка 
(Uniform Fill), которое вызывается на экран щелчком по 
кнопке, обозначенной цифрой 1 на панели Заливка (Fill 
Flyout) (рисунок 72). Для присвоения цвета обводкам щел-
чок на кнопке, обозначенной цифрой 2 на панели Обводка 
(Outline Flyout), выводит совершенно идентичное окно Цвет 
обводки (Outline Color). 

- Цветовые модели (Models). Предполагают свободное 
определение цвета на цветовых полях и полосах в соответ-
ствии с цветовой моделью. 

- Смесители (Mixers). Предназначены, во-первых, для 
получения серии перехода цветов между четырьмя исходны-
ми цветами, а во-вторых, для создания «гармоничных ак-
кордов» цвета. 

- Стандартные (Fixed Palettes) и Пользовательские па-
литры (Custom Palettes). Предназначены для присвоения 
объектам плашечных цветов. 
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Рисунок 72 
 

Цветовое поле Исходный цвет (Old) отображает тот 
цвет, который до открытия диалогового окна имел выде-
ленный объект, а поле Новый цвет (New) - цвет, который 
определяется в данном диалоговом окне. В поле Составляю-
щие цвета (Components) представляются параметры цвета в 
выбранных цветовых моделях. 

Список Имя (Name) отображает имя цвета, по которому 
можно легко выбрать интересующий цвет. 

 
Панель Цвет (Color) 

 
Панель Цвет (Color), которая вызывается щелчком по 

соответствующей кнопке на панели инструментов Заливка 
(Fill) (на рисунке 70 обозначена цифрой 7), предлагает тот 
же набор способов, что и рассмотренные выше. 

 
 

Градиентные заливки (Fountain Fill) 
 

Градиентные заливки представляют собой более слож-
ные заливки, чем однотонно-цветовые. Однако в использо-
вании они также просты, как и обычное присвоение цвето-
вых параметров. 

Для вызова на экран диалогового окна Градиентная за-
ливка (Fountain Fill) (рисунок 73) необходимо щёлкнуть по 
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кнопке, расположенной на панели Заливка (Fill) (на рисунке 
70 отмечена цифрой 2). 

 

 
 

Рисунок 73 
 
Существует четыре типа градиентных заливок, выбор 

которых осществляется в списке Тип (Туре): 
- линейная (Linear) обеспечивает плавный переход вдоль 

прямой линии; 
- радиальная (Radial) обеспечивает плавный переход в 

виде концентрических окружностей; 
- коническая (Conical) обеспечивает плавный переход в 

виде конусов; 
- квадратная (Square) обеспечивает плавный переход в 

виде квадратов. 
Кроме того, градиентные заливки бывают простыми 

(между двумя исходными цветами) и сложными (в виде не-
скольких плавных переходов в пределах одного объекта). 

Если активен переключатель Двухцветная растяжка (Two 
color), то исходный и конечный цвета определяются кноп-
ками От (From) и До (То). По умолчанию равные пропорции 
обоих цветов находятся точно в середине длины растяжки, 
однако если требуется, это соотношение можно изменить с 
помощью поля Средняя точка (Mid - point) (рисунок 73). 

Список Готовые растяжки предлагает возможность ис-
пользовать ранее подготовленные образцы растяжек. Рас-
ширить этот список можно, добавив туда текущую растяжку, 
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с помощью кнопки со знаком плюс, а удалить ненужную - с 
помощью кнопки со знаком минус. 

 
Декоративные заливки 

 
Диалоговое окно Декоративная заливка (Pattern Fill) вы-

водится на экран с помощью соответствующей кнопки на 
панели инструмента Заливка (на рисунок 70 обозначена 
цифрой 3). Декоративные заливки бывают трёх видов: двух-
цветные, полноцветные и точечные. 

 

Двухцветные декоративные заливки 
 
Двухцветные заливки представляют собой декоративное 

поле, составляемое из точечных изображений. Если активен 
переключатель 2-цветная заливка (2-color), то диалоговое 
окно Декоративная заливка (Pattern Fill) имеет следующий 
вид (рисунок 74). 

В центре диалогового окна представлена кнопка, откры-
вающая список образцов для двухцветной заливки. 

 

 
 

Рисунок 74 
 

Особенностью двухцветных заливок является возмож-
ность изменить цвет рисунка (поле Передний план (Front) и 
цвет фона (поле Задний план Back)). Кроме этого, кнопка 
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создать (Create...) позволяет вывести на экран диалогового 
окна редактор двухцветной заливки (Two-Color Pattern 
Editor), которая позволяет создать свои собственные или ре-
дактировать уже имеющиеся двухцветные заливки. Для этого 
предназначено расчерченное поле битовой карты, размерность 
которой можно изменить в поле Размер битовой карты 
(Bitmap size). Размер «штриха» устанавливается посредством 
выбора переключателя в поле Размер пера (Pen size). 

 

Полноцветные векторные и точечные заливки 
 

Полноцветные заливки представляют собой также деко-
ра-тивное поле, но составленное из векторных элементов, 
каждый из которых сохраняется в отдельном файле с рас-
ширением pat. Если активен переключатель Полноцветная 
заливка (Full color) или Полноцветная точечная заливка 
(Bitmap), то диалоговое окно Декоративная заливка (Pattern 
Fill) имеет вид, приведенный на рисунок 75.  

 

 
 

Рисунок 75 
 

Исключением является, конечно, список образцов залив-
ки, которые могут представлять собой любые точечные 
изображения. 

Текстурные заливки, использованные в программе 
CorelDRAW, представляют собой точечные изображения, 
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полученные в результате генерирующихся случайно изобра-
жений на основе фрактальных преобразований, например, 
морозные узоры на окнах. 

Все параметры текстурной заливки определяются в диа-
логовом окне Текстурная заливка (Texture Fill), которая вы-
зывается щелчком на соответствующей кнопке (на рисунке 
70 обозначена цифрой 4) в группе инструментов Заливка (Fill). 

 

Текстурные заливки 
 

Для создания текстуры сначала необходимо в поле Биб-
лиотека текстур (Texture library) выбрать один из вариан-
тов, затем в списке Текстуры (Texture list) - конкретный тип 
текстуры. 

В соответствии с этим выбором в нижней части диалого-
вого окна будет выведен набор управляющих полей, причём 
у каждого типа текстуры он разный. 

Все поля имеют справа значки в виде «замочков». Назна-
чение этих значков заключается в том, что параметры тех по-
лей, у которых замки открыты, изменяются случайным обра-
зом. Если необходимо зафиксировать определённое значение, 
например конкретный цвет или процентное соотношение па-
раметра, то следует данное поле «замкнуть» (рисунок 76). По-
сле настройки всех параметров следует нажать кнопку Про-
смотр (Preview), для того чтобы программа сгенерировала 
изображение, которое отобразится в окне просмотра. 

 

 
 

Рисунок 76 
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Все параметры PostScript-заливки определяются в диа-
логовом окне PostScript-заливка (PostScript Texture), кото-
рое вызывается с помощью соответствующей кнопки на па-
нели Заливка (Fill) (на рисунке 77 - цифра 5). 
 

PostScript-заливки 
 
Конкретная заливка выбирается в списке. Если при этом 

установлен флажок Просмотр заливки (Preview fill), то в 
окне просмотра отображается реальный вид заливки. Как и 
текстурные заливки, PostScript-заливки часто отличаются 
друг от друга набором параметров, количество и тип кото-
рых зависят от характера заливки. После изменения какого-

либо параметра для отработки новых значений следует 
нажать кнопку Обновление (Refresh). 

 

 
 

Рисунок 77 

 
Инструмент Интерактивная заливка (Interactive Fill) 
 
Инструмент Интерактивная заливка (Interactive Fill) ис-

пользуется в связке с инструментальной полосой Свойства 
(Property Ваг). 

Для работы этого инструмента необходимо предвари-
тельно выделить объект, включить инструмент и выбрать в 
списке инструментальной полосы вид заливки (рисунок 78). 

Каждому виду заливки предоставляются свои собствен-
ные параметры, которые совершенно идентичны тем, кото-
рые доступны в соответствующих диалоговых окнах. 
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Рисунок 78 
 
На инструментальной полосе Свойства (Property Ваг) 

имеется кнопка Редактировать (Edit...), с помощью которой 
открывается диалоговое окно, кроме того, возможно редак-
тировать заливки на экране без вызова каких бы то ни было 
диалоговых окон (рисунок 79). 

 

 
 

Рисунок 79 

 
Диалоговое окно Параметры обводки (Outline Pen) 

 
Все параметры, которые можно присвоить контуру, распо-

лагаются в диалоговом окне Параметры обводки (Outline Реп), 

которое выводится на экран с помощью кнопки на панели ин-
струментов Обводка (Outline) (на рисунке 70 - цифра 1). 

Поле Цвет (Color) служит для определения цвета обвод-
ки. При щелчке на кнопке этого поля открывается текущая 
экранная палитра. Если требуются другие палитры или дру-
гие способы определения параметров цвета, кнопка Другие 
(Other...) обеспечит вывод на экран диалогового окна Цвет 
обводки (Outline Color). Это диалоговое окно можно вы-
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звать и специально, если нажать кнопку на панели инстру-
ментов Обводка (Outline) (на рисунке 70 - цифра 2). 

В поле Толщина (Width) можно установить значение 
толщины обводки. В списке рядом можно выбрать подходя-
щую единицу измерения или использовать её для пересчета 
значений толщины в различных единицах измерения. 

 

 
 

Рисунок 80 
 
Список Стиль (Style) предоставляет выбор различных 

стилей линии - сплошной, пунктирной, штриховой, штрих-
пунктирной и других. 

Кнопки Добавить (Add) и Заменить (Replace) позволяют 
добавить новый вариант стиля в список или заменить суще-
ствующий. 

Поле Углы (Corners) диалогового окна Параметры обвод-
ки (Outline Реп) служит для определения способа рисования 
острых углов (рисунок 80). 

Параметры (Options) обеспечивают срезание угла. Первый 
переключатель обеспечивает острый угол, второй переключа-
тель - закругление угла, а третий - срез без закругления. 

Поле Концы линий (Line Caps) определяет форму концов 
линий или штрихов, если линия не сплошная. 

В поле Стрелки (Arrows) представлены две кнопки для 
выбора формы стрелок - одна для начала открытого конту-
ра, другая для конца. Опции (Options) открывают список 
команд, которые помогают работе со стрелками. 
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Присвоение параметров одного объекта другому 
 

 
 

Рисунок 81 
 

Для того чтобы пользователю лишний раз не вспоминать, 
какие параметры были присвоены объекту, в программе 
CorelDRAW предусмотрена команда, которая позволяет авто-
матически переприсвоить определенные параметры другому 
объекту. Объект, которому будут присваиваться параметры 
другого объекта, следует выделить, а затем выполнить коман-
ду Копировать параметры у... (Copy Properties From...) меню 
Редактировать (Edit), которая выводит на экран диалоговое 
окно Копировать параметры (Сору Properties). 

 В диалоговом окне можно установить один или несколь-
ко флажков в любом сочетании: Параметры обводки (Outline 
Реп), Цвет обводки (Outline Color), Заливка (Fill) и Пара-
метры текста (Text Properties) (рисунок 81). 

 

6. Работа со слоями 
 

Под слоем понимают прозрачную плоскость, на которой 
располагаются объекты обычным образом. Эту плоскость со 
всеми её объектами можно перемещать, удалять, отобра-
жать на экране, выводить на печать. 

В каждом документе, создаваемом в программе 
CorelDraw, по умолчанию имеется четыре слоя: один слой - 
изобразительный (Layer 1), слой - для сетки (Master Grid), 
слой - для направляющих (Master Guides) и слой - для «ра-
бочего стола» (Master Desktops). 
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Добавление новых слоёв позволит легко управлять 
большим количеством объектов, регулировать распечаткой и 
отображением на экране. 

На каждой странице количество слоёв одинаково, их 
имена и параметры абсолютно идентичны. Если какой-либо 
слой отключается от вывода, например на экран, то он от-
ключается на всех страницах. Также на всех страницах одно-
временно происходит изменение порядка слоёв. Вместе с 
тем, на одном и том же слое на различных страницах со-
вершенно свободно располагаются различные объекты. 

 
Панель Диспетчер объектов (Object Manager) для работы 

со слоями 
 

Все операции со слоями (создание, удаление, фиксация и 
т.д) осуществляются с помощью панели Диспетчер объектов 
(Object Manager), которая вызывается на экран при помощи 
меню Окно\Панели типа Docker (Windows\Dockers) коман-
ды Диспетчер объектов (Object Manager) (рисунок 82). 

 

 
 

Рисунок 82 
 

Под заголовком панели расположены четыре кнопки 
(слева на - право): 

1.  Кнопка Новый слой (New layer) добавляет слой со 
стандартным именем Слой (Layer) и соответствующим по-
рядковым номером. 

2.  Кнопка Показать свойства объектов (Show Objects 
Properties) даёт возможность отобразить свойство объектов. 
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3.  Кнопка Для редактирования доступны все слои обес-
печивает доступ ко всем слоям, при включении этой кнопки 

для выполнения любых действий доступны объекты только 
активного слоя. 

4.  Кнопка Вид диспетчера слоёв (Layer Manager View) 
обеспечивает традиционный вид панели диспетчера слоёв. 

5.  При щелчке правой кнопкой мыши на пиктограмме, 
условно обозначающей слой, на экран выводится кон-
текстнозависимое меню, в котором можно определить свой-
ство слоя, удалить или переименовать слой. 

Создание нового слоя 
Новый изобразительный слой создаётся с помощью 

кнопки Новый слой (New Layer). Пользователь может созда-
вать произвольное число слоёв, ограничение обычно связано 
только с техническими параметрами компьютера. 

Присвоение имени слою 
Имя слоя можно изменить в момент создания, поскольку 

новое имя выводится в рамки для редактирования. Когда 
имя слою присвоено, его можно изменить с помощью ко-
манды Переименовать (Rename) контекстного меню. 

Активизация слоя 
Любой вновь создаваемый объект помещается на активный 

слой, поэтому для того, чтобы разместить объект на требуе-
мом слое, этот слой необходимо предварительно выделить в 
панели Диспетчер объектов (Object Manager), щёлкнув на 
строке с его именем. Имя активного слоя легко идентифициро-
вать, поскольку оно выделяется красным цветом (рисунок 82). 

Изменение порядка слоёв 
С помощью изменения порядка слоёв достаточно просто 

манипулировать большими совокупностями объектов. Для 
этого в панели Диспетчер объектов (Object Manager) требу-
ется захватить строку выделенного слоя и «перетащить» её 

выше или ниже. 
Удаление слоёв 
Выделенный в палитре слой, а вместе с ним и все объ-

екты, можно удалить следующими способами: 
- нажать клавишу <Delete> на клавиатуре; 
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- выполнить команду Удалить (Delete) контекстного меню; 
- выполнить команду Удалить слой (Delete Layer) меню 

панели Диспетчер объектов (Object Manager). 
Следует иметь в виду, что нельзя удалить стандартные 

слои: Master Grid, Master Guides, Master Desktop. 
Фиксирование слоёв 
Фиксированный слой представляет собой «нерушимое це-

лое»: объекты на таком слое не выделяются, не изменяются, 

не перемещаются и не удаляются. Знаком фиксированного 
слоя является пиктограмма «карандаша серого цвета» в строке 
слоя на панели Диспетчер объекта (Object Manager). 

Для фиксирования слоя достаточно щелчка на пикто-
грамме карандаша (значок становится «серым»), повторный 

щелчок на этой же пиктограмме снимает фиксацию. 
Временное удаление слоёв с экрана 
Фиксированный слой не может подвергаться редактиро-

ванию, но, тем не менее, объекты, расположенные на этом 
слое, продолжают отображаться на экране. Если пользовате-
лю в данный момент не нужен этот слой, его можно «спря-
тать». Для того чтобы временно удалить слой с экрана, 
можно воспользоваться несколькими способами. 

Пиктограмма в виде глаза ни панели Диспетчер объектов 
(Object Manager) и флажок Видимые (Visible) в диалоговом 
окне Свойства слоя (Layer Properties) служат для включе-
ния/включения вывода слоя на экран. 

Использование Мастер слоя (Master Layer) 
Флажок Мастер слоя (Master Layer) диалогового окна 

Свойства слоя (Layer Properties) или команда Мастер-слой 
(Master) контекстного меню позволяет превратить любой 
слой в так называемый Мастер-слой. Его назначение состоит 
в том, что все объекты, расположенные на нём, становятся 
видимыми на всех страницах многостраничного документа. 

Если же изображение Мастер-слоя требует размещение 
не на всех страницах, то следует воспользоваться флажком 
Применить свойства слоя только к текущей странице (Apply 
all property changes to the current page only), которая огра-
ничивает действия установок только текущей страницы. 
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Перемещение объектов с одного слоя на другой 
Объекты, расположенные на различных слоях, можно 

перемещать и копировать с одного слоя на другой. Для этой 
цели предназначены команды Переместить на слой (Move 
То Layer...) и Копировать на слой (Copy То Layer...), распо-
ложенные в меню панели. После выполнения команды на 
экран выводится специальная стрелка, с помощью которой 
необходимо указать на имя слоя-назначения. 

Перемещать объекты между слоями в пределах одной 
страницы можно и с помощью мыши. Для этого необходимо 
«захватить» выделенный объект в рабочем окне или в спис-
ке объектов панели и «переместить» его на требуемую стро-
ку (рисунок 83). 

 

 
 

Рисунок 83 
 

7. Векторные и цветовые эффекты 
 
В векторной программе CorelDRAW можно легко изме-

нять форму объектов с помощью инструмента Форма (Shape), 
однако во многих случаях работа с каждой опорной точкой в 
отдельности представляет значительные трудности, связанные 
с колоссальной трудоемкостью всей совокупности мелких опе-
раций. Для решения некоторых типовых задач разработаны 
программные средства, организованные в виде эффектов. 
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Простые векторные эффекты 
 
К простым векторным эффектам относятся команды, кото-

рые образуют из простых объектов сложные или, наоборот, из 
сложных – простые. В результате происходит не изменение 
(деформация) существующих форм, а только их сочетание. 

 
Команда Комбинировать (Combine) 

 
Команда Комбинировать (Combine), представленная в 

меню Управление (Arrange) и в составе инструментальной 
полосы Свойства (Property Ваг), предназначена для объеди-
нения двух или более объектов в единый объект. Использо-
вать эту команду следует, если необходимо соединять опор-
ные точки (узлы) разных объектов, создавать отверстия и 
маски (рисунок 84). 

 

 
 

Рисунок 84 

 
Перед выполнением команды Комбинировать (Combine) 

надо выделить объекты, предназначенные для объединения. 
Если объекты имели различные заливки, то в результате 
объединенному объекту будет присвоена заливка самого 
нижнего объекта. 

Следует хорошо представлять себе суть действия этой 
команды: объекты, каждый из которых согласно принципу 
аппликации имеет свой собственный уровень в «стопке» 
объектов, «втискиваются» на один уровень, что приводит к 

перераспределению заливаемых и незаливаемых областей. 
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Перераспределение происходит таким образом, что непере-
секающиеся области входят в результирующий объект, а пе-
ресекающиеся – исключаются, делаются прозрачными. 

Существует правило, которое может помочь в понимании 
процесса. Если мысленно провести линию слева направо че-
рез выделенные объекты, то с первого контура, который 
пересекла линия, начинается заливка, после второго контура 
заливка прекращается (образуется «дырка»), после следую-
щего – начинается заливка и так далее (рисунок 85). 

Такое свойство позволяет создавать выворотки и маски 
и другие интересные эффекты (рисунок 86). 

 

              
 

                 Рисунок 85                       Рисунок 86 
 

Команда Разбить комбинацию (Break Apart) 
 
В паре с командой Комбинировать (Combine) в меню 

Управление (Arrange) представлена команда Разбить комби-
нацию (Break Apart), предназначенная для разбиения мно-
гоконтурного объекта на составляющие его контуры, каж-
дый из которых снова становится отдельным объектом. Ис-
пользовать эту команду следует, если необходимо отменить 
результат действия команды Комбинировать (Combine) или 
при необходимости работать с подконтурами как с отдель-
ными объектами. 

Команда доступна в меню Управление (Arrange) или на 
инструментальной полосе Свойства (Property Ваг) при выде-
лении сложного контура (рисунок 87). 
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Рисунок 87 
 

Панель Изменение формы (Shaping) 
 
В меню Управление (Arrange) представлены еще три ко-

манды, которые являются дальнейшим развитием команды 
Комбинировать (Combine), а именно для выполнения ком-
бинирования, но с различными дополнительными условия-
ми. Эти три команды сгруппированы в панель типа Docker 
под общим названием Изменение формы (Shaping), а также 
выведены в виде кнопок на инструментальной полосе Свой-
ства (Property Ваг) (рисунок 88). 

 

 
 

Рисунок 88 
 

Следует обратить внимание на важную особенность: эти 
команды можно применять и к группам объектов (т.е. после 
использования команды Сгруппировать (Group) в меню 
Управление (Arrange)). 

 
Команда Объединить (Weld) 

 
При помощи этой команды в меню Управление (Arrange) 

или дублирующей кнопки на инструментальной полосе 
Свойства (Property Ваг) объекты комбинируются таким об-

кнопка команды  
Обеденение (Weld) 

          кнопка команды  
          Пересечение (Intersection) 

кнопка команды  
От течение (Trim) 
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разом, что результирующий объект представляет собой кон-
тур всех объектов по общему периметру (рисунок 89). 

Для выполнения объединения необходимо выделить 
один или несколько объектов, а затем нажать кнопку Объ-
единить с... (Weld То...) и с помощью появившейся стрелки 
выделить последний объект, параметры обводки и заливки 
которого и будут присвоены результирующему объекту. 

В поле Сохранить оригинал (Leave Original) различные 
сочетания флажков позволяют сохранить объекты, участву-
ющие в процессе. 

- Флажок Конечный объект(ы) (Target Object(s)) обеспе-
чивает сохранение последнего объекта, на который указы-
вают стрелкой, или выделенных объектов (рисунок 90). 

 

                     
 

                Рисунок 89                              Рисунок 90 
 

- Флажок Другие объекты (Source Object(s)) обеспечива-
ет сохранение всех остальных объектов (которые первона-
чально выделены). 

 
Команда Пересечение (Intersect) 

 
С помощью команды Пересечение (Intersect) или дубли-

рующей кнопки на инструментальной полосе Свойства 
(Property Ваг) объекты комбинируются таким образом, что в 
результате создается новый объект, форма которого совпа-
дает с площадью пересечения всех объектов. 
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Способ работы и назначение флажков идентичны коман-
де Объединить (Weld) (рисунок 91). 

 

             
 

Рисунок 91 
 

Команда Отсечение (Trim) 
 
С помощью команды Отсечение (Trim) или дублирующей 

кнопки на инструментальной полосе Свойства (Property Ваг) 
выделенные объекты комбинируются таким образом, что у 
последнего объекта отсекается часть, равная площади пере-
сечения с другими объектами, участвующими в процессе. 

Способ работы и назначение флажков идентичны коман-
де Объединить (Weld) (рисунок 92). 

 

 
 

Рисунок 92 
 

Сложные векторные эффекты 
 

Сложные векторные эффекты выделены в специальный 
пункт меню Эффекты (Effects), включающее семь команд, на-
правленных на комплексное изменение формы объекта или со-
вокупности объектов с целью имитировать какой-либо эффект. 
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Команда Перспектива (Add Perspective) 
 
Команда Перспектива (Add Perspective) в меню Эффекты 

(Effects) предназначена для деформации объектов с целью соз-
дания впечатления перспективы. Эта команда помещает выде-
ленный объект в штриховую рамку с четырьмя маркерами по 
углам. Внутри прямоугольника добавлена сетка для того, что-
бы дать возможность пользователю реально видеть трансфор-
мации горизонтальных и вертикальных линий. 

 

 
 

Рисунок 93 
 

Перемещая маркеры, можно трансформировать объект и 
получить перспективу с одной или двумя точками схода, кото-
рые представляются на экране в виде крестиков. Их также 
можно перемещать для изменения перспективы (рисунок 93). 

Команда Копировать (Сору) в меню Эффекты (Effects) 
открывает список эффектов, среди которых имеется и пер-
спектива. С помощью этой команды можно перенести пара-
метры уже имеющейся перспективы на любой другой выде-
ленный объект. 

Там же расположена команда Удалить <название эффек-
та> (Clear <название эффекта>), которая удаляет парамет-
ры эффекта, в данном случае перспективы. 

Две последние команды относятся и ко всем последующим 
эффектам. При выделении объекта, к которому применен какой-
либо эффект, программа указывает его в названии команды. 
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Команда Envelope 
 
Команда Оболочка (Envelope) в меню Эффекты (Effects) 

применяется для помещения векторных объектов в оболоч-
ку. В программе CorelDRAW управление этим эффектом 
возможно с помощью следующих средств: 

- панели типа Docker; 
- инструментальной полосы Свойства (Property Ваг); 
- интерактивного инструмента Интерактивная оболочка 

(Interactive Envelope). 
Для того чтобы вывести на экран панель типа Dockers, 

необходимо выполнить следующую команду: в меню Windows 
выбрать команду Toolbars в появившемся окне, в левой его ча-
сти, выбрать в меню Customize команду Menus. В правой части 
окна во второй колонке раскрыть меню &Windows - &Dockers, 
в первой колонке раскрыть папку Effects, выделить необходи-
мый инструмент (в нашем случае команду & Envelope) и 
нажать кнопки Add, ОК. Таким образом, мы добавили в меню 
Windows - Dockers команду Envelope, после выполнения кото-
рой на экране появится панель Envelope типа Dockers. 

Если включить инструмент Интерактивная оболочка (Inte-
ractive Envelope) и выделить им объект, то вокруг этого объек-
та появится прямоугольник с маркерами, перемещая которые 
можно добиться требуемой деформации объекта (рисунок 94). 

Способ перемещения маркеров зависит от выбора одного 
из четырех режимов редактирования оболочки, представ-
ленных на панели и полосе в виде кнопок: 

1. Режим По прямой линии (Straight Line) обеспечивает 
сегменты оболочки в виде прямых линий. 

2.  Режим По дуге (Single Are) обеспечивает сегменты 
оболочки в виде неуправляемых дуг. 

3.  Режим По двойной дуге (Double Arc) обеспечивает 
сегменты оболочки в виде неуправляемых двойных дуг. 

4.  Режим Свободный режим (Unconstrained Mode) дает 
возможность редактировать контур оболочки так же, как и с 
помощью инструмента Форма (Shape). Это означает, что 
становятся доступными не только опорные точки, но и 
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управляющие "рычаги". В данном режиме можно изменять, 
добавлять и удалять типы опорных точек. 

Для первых трех режимов предусмотрены очень важные 
клавиатурные варианты: 

- при удерживании клавиши <Ctrl> перемещение опор-
ной точки влечёт перемещение противоположной точки в 
том же направлении; 

- при удерживании клавиши <Shift> перемещение опор-
ной точки влечёт перемещение противоположной точки в 
противоположном направлении; 

- при удерживании обеих клавиш (<Ctrl> + <Shift>) пе-
ремещение опорной точки влечет перемещение трех других 
узлов во взаимно противоположных направлениях. 

 

 
 

Рисунок  94 
 
Кнопка Добавить готовую оболочку (Add Preset) выводит 

список образцов. После выбора одного из образцов его мож-
но использовать в качестве оболочки. 

В программе помимо режимов редактирования оболочки 
предусмотрено четыре режима картирования оболочки – 
способы, с помощью которых объект будет размещен в пре-
делах оболочки: 

1.  Режим Угловой (Putty) обеспечивает размещение уг-
ловых маркеров объекта на угловых опорных точках обо-
лочки, все остальные опорные точки игнорируются. 

2.  Режим Оригинальный (Original) обеспечивает размеще-
ние угловых маркеров объекта на угловых опорных точках, 
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остальные опорные точки распределяются по линии оболочки, 
при этом учитываются и управляющие точки объекта. 

3.  Режим Горизонтальный (Horizontal) обеспечивает 
широкое размещение объекта, при котором сохраняются го-
ризонтальные линии, если они есть. 

4.  Режим Вертикальный (Vertical) обеспечивает такое 
сохранение объекта, при котором сохраняются вертикаль-
ные линии, если они есть. 

Флажок Сохранить прямые (Keep lines) препятствует ис-
кажению прямых линий, которые имеются у исходного объ-
екта (рисунок 95). 

 

 
 

Рисунок 95 
 

Произведённые деформации можно удалить с помощью 
команды Отменить обводку (Clear Envelope) на инструмен-
тальной полосе Свойства (Property Ваг) или в меню Эффекты 
(Effects). 

 
Команда Пошаговый переход (Blend) 

 
Команда Blend (Пошаговый переход) в меню Эффекты (Ef-

fects) предназначена для получения совокупности промежуточ-

ных объектов в процессе пошагового перехода формы одного 
объекта в форму другого. В программе CorelDRAW управлять 
этим эффектом можно с помощью следующих средств: 
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- панели типа Docker; 
- инструментальной полосы Свойства (Property Ваг); 
- интерактивного инструмента Интерактивный переход                      

(Interactive Blend). 

Самые детальные параметры для этого эффекта доступ-
ны на панели типа Docker, которая имеет четыре вкладки, 
отображаемые с помощью одноименных кнопок: Шаги 
(Steps), Ускорение (Acceleration), Превращение цвета (Color 
Direction) и Разное (Miscellaneous). 

Для создания перехода необходимо включить инструмент 
и разместить его курсор на исходном объекте, нажать кноп-
ку мыши и протянуть штриховую линию на конечный объ-
ект. В результате образуется группа пошагового перехода с 
текущими параметрами (рисунок 96). 

 

 
 

Рисунок 96 
 

Также можно направить промежуточные объекты по "ру-
котворной" траектории: необходимо удерживать клавишу 
<А11> и с помощью мыши нарисовать требуемую траекторию. 

 
Кнопка Шаги (Steps) 

 
Первая кнопка Шаги (Steps) на панели Пошаговый пере-

ход (Blend) предназначена для определения числа промежу-
точных объектов, интервалов между ними и их вращения. 
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Переключатель Число шагов (Number of steps) дает воз-
можность указывать требуемое количество промежуточных 
объектов. Переключатель Фиксированный интервал (Fixed 
spacing) дает возможность указывать расстояние между про-
межуточными объектами. Эта функция доступна только в том 
случае, если пошаговый переход направлен вдоль траектории. 

Поле Вращение (Rotate) служит для поворота промежу-
точных элементов. 

Флажок Петля (Loop) обеспечивает изгиб траектории 
промежуточных объектов относительно точки, расположен-
ной между исходными объектами. 

 
Кнопка Ускорение (Acceleration) 

 
Кнопка Ускорение (Acceleration) на панели Пошаговый 

переход (Blend) позволяет перераспределить объекты и со-
здать неравномерное их расположение (рисунок 97). 

Поле Ускорение объектов (Accelerate objects) служит для 
создания неравных расстояний между объектами, перемеще-
ние движка влево «ускоряет» появление объектов от началь-
ного объекта, а вправо - наоборот, от конечного объекта. 

 

 
 

Рисунок  97 
 
Поле Ускорение заливки/обводки (Accelerate fills/-

outlines) выполняет ту же задачу, что и предыдущая коман-
да, но по отношению к заливке и обводке. 
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Флажок Применять к размеру (Apply to sizing) обеспечива-
ет изменение размера промежуточных объектов пропорцио-
нально «ускорению» поля Ускорение объектов (Accelerate 
objects). 

Флажок Связь ускорений (Link accelerations) предназна-
чен для синхронизаций значений в полях Ускорение объек-
тов (Accelerate objects) и Ускорение заливки/обводки 
(Accelerate fills/outlines). 

 
Кнопка Превращение цвета (Color Direction) 

 
Кнопка Превращение цвета (Color Direction) предназна-

чена для управления цветовым переходом и идентична тому 
полю, который используется в диалоговом окне Градиентная 
заливка (Fountain Fill). 

Три кнопки, представленные на этой вкладке, опреде-
ляют направление цветового перехода. 

Верхняя кнопка Переход по прямой линии (Straight Line 
Blend) обеспечивает использование цветов, расположенных 
по прямой линии в цветовом круге между цветами исходных 
объектов. 

 

 
 

Рисунок  98 
 
Две нижние кнопки Переход по часовой стрелке (Clock-

wise Path) и Переход против часовой стрелки (Counter-
clockwise) обеспечивают использование цветов, расположен-
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ных на дуге или на спирали в цветовом круге между цвета-
ми исходных объектов в соответствующем направлении (ри-
сунок 98). 

 
Кнопка Разное (Miscellaneous) 

 
На кнопке Разное (Miscellaneous) представлены четыре 

кнопки, обеспечивающие некоторые дополнительные функции. 
Кнопка Картирование узлов (Map Nodes) на экран выво-

дит особый курсор, с помощью которого необходимо на ис-
ходном и конечном объектах указать по одному узлу, что 

поможет программе обеспечить более детальный пошаговый 
переход. 

Кнопка Разбить (Split) также служит для вывода на 
экран особого курсора, с помощью которого выбирается лю-
бой промежуточный объект, перемещая который, можно по-
лучить излом.  

Кнопки Восстановить начальный объект (Fuse Start) и 
Восстановить конечный объект (Fuse End) отменяют дей-
ствие кнопки Разбить (Split). Для этого с нажатой клавишей 
<Ctrl> нужно щелкнуть на любом объекте группы пошаго-
вого перехода, а затем нажать одну из указанных кнопок, 
ставшую доступной (рисунок 99). 

 

 
 

Рисунок  99 
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Кнопки исходных объектов и траектории 
 
В нижней части панели Пошаговый переход (Blend) распо-

ложены три кнопки - Начальный объект (Start), Конечный 
объект (End) и Траектория (Path). Все они необходимы для 
определения исходных объектов и траектории (рисунок 100). 

 

 
 

Рисунок 100 
 

При выборе любой из кнопок открываются маленькие 
меню из двух команд. Первая команда с начальным словом 
Новый (New) служит для указания объектов в качестве 
начального и конечного объектов или в качестве траекто-
рии. Вторая команда со словом Показать (Show) позволяет 
определить у выделенной группы пошагового перехода ее 
начальный и конечный объекты и траекторию. 

 
Команда Контур (Contour) 

 
Команда Контур (Contour) меню Effects (Эффекты) или 

кнопка, расположенная в группе Интерактивный инструмент 
(Interactive Tool), служит для создания от исходного объекта 
серии концентрических форм, направленных наружу или 
внутрь объекта. 

На панели Contour (Контур) представлены две кнопки, 

одна из которых служит для определения параметров внеш-
него вида контуров, а вторая - для определения их цвето-
вых параметров (рисунки  101, 102). 

После включения первой кнопки в зависимости от выбо-
ра переключателя становятся доступными поля Шаги (Steps) 
и Смещение (Offset). Переключатель К центру (То center) 
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обеспечивает заполнение объекта концентрическими форма-
ми с интервалом, который определяется в поле Смещение 
(Offset). Причем следует учесть, что значение смещения не 
распределяется по диаметру (т.е. не делится пополам), а 
каждая линия смещается от предыдущей на указанное рас-
стояние, поэтому контуров получится как минимум в два 
раза меньше расчетных (например, круг диаметром 100 мм, 
смещение -10 мм, по расчету должно получиться 10 конту-
ров, а получается только 5, поскольку смещение выполняет-
ся с обеих сторон диаметра, т.е. от каждого радиуса).  

Переключатель Внутрь (Inside) обеспечивает заполнение 
объекта концентрическими формами, число которых опре-
деляется в поле Шаги (Steps), и с интервалом, который 
определяется в поле Смещение (Offset). 

Переключатель Наружу (Outside) обеспечивает создание 
концентрических форм вокруг объекта, число которых опре-
деляется в поле Шаг (Steps) с интервалом, который опреде-
ляется в поле Смещение (Offset). 

 

 
 

Рисунок 101 
 

 
 

Рисунок 102 
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Кнопка определения цвета отличается от аналогичной 
кнопки для эффекта пошагового перехода только наличием 
кнопок, присвоения цвета обводке (кнопка со значком "пе-
ро") и заливке (кнопка со значком "ведро с краской"). Если 

исходный объект имел в качестве заливки градиентную за-
ливку, то выводятся две кнопки: для определения начально-
го и конечного цветов градиента. 

 
Команда Extrude 

 
Команда Экструдирование (Extrude) меню Эффекты 

(Effects) представляет собой самый сложный эффект, суть 
которого заключается в том, что программа добавляет к вы-
деленному объекту боковые плоскости, как бы выдавливая 

контур объекта и тем самым создавая видимость объемного 
объекта. Управление этим эффектом такое же, как и эффек-
том Пошаговый переход (Blend). Для этого необходимо 
включить инструмент, разместить курсор на объекте (форма 
курсора меняется), нажать кнопку мыши и протянуть штри-
ховую линию в направлении экструзии, а точка, в которой 
мышь отпускается, становится точкой схода, она отмечается 
крестиком (рисунок 103). 

На панели Экструдирование (Extrude) представлено пять 
вкладок: Точка схода (Vanishing Point), Вращение (3D Rotation), 
Освещение (Lighting), Цвет (Color Wheel) и Фаска (Bevels). 

 

 
 

Рисунок 103 
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Кнопка Точка схода (Vanishing Point) 
 
Кнопка расположена на панели Экструдирование 

(Extrude) и служит для определения основных параметров, 
создающих объём (рисунок 104).  

 

 
 

Рисунок 104 
 
В списке под окном просмотра предоставляется выбор 

способа экструдирования: 
- вариант Уменьшение в глубину (Small Back) обеспечива-

ет точку схода позади объекта и уменьшение задней грани; 
- вариант Уменьшение вперёд (Small Front) обеспечива-

ет точку схода впереди и уменьшение передней грани; 
- вариант Увеличение в глубину (Big Back) обеспечивает 

точку схода впереди объекта и увеличение задней грани; 
- вариант Увеличение вперед (Big Front) обеспечивает 

точку схода позади объекта и уменьшение задней грани; 
- вариант Параллельно в глубину (Back Parallel) обеспе-

чивает параллельность боковых граней, уходящих в глубину, 
и равенство передней и задней граней; 

- вариант Параллельно вперед (Front Parallel) обеспечи-
вает параллельность боковых граней, выступающих вперед, 
и равенство передней и задней граней. 

Представляем типы точек схода: Точка схода привязана к 
объекту (VP Locked То Object), Точка схода привязана к стра-
нице (VP Locked То Page), Копировать точку схода от (Copy 
VP From...), Общая точка схода (Shared Vanishing point). 
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В поле Глубина (Depth) определяется длина боковых ре-
бер в процентах от расстояния до точки схода. 

Поля (Н и V) позволяют изменять вид вкладки Глубина 
(Depth) и выводят цифровые поля для более точного опре-
деления параметров. 

В поле Точка схода (Measured from) можно установить 

точные координаты точки схода относительно центра объ-
екта (переключатель Object center) или начала координат 
страницы (переключатель Page origin). 

 
Вкладка Вращение (Rotation) 

 
Она позволяет осуществить поворот объекта в простран-

стве, что призвано для усиления ощущения трехмерности. 
Эта вкладка имеет два варианта, первый из которых 

позволяет выполнять операцию вручную, вращая объемный 
фирменный знак компании Corel, а второй – с помощью 
определения цифровых значений. Поля с номерами 1, 2 и 3 
соответствуют осям X, Y и Z (рисунок 105). 

 

 
 

Рисунок 105 

 
Вкладка Освещение (Lighting) 

 
С помощью вкладки Освещение (Lighting) можно "вклю-

чить" от одного до трех источников освещения, которые еще 
более усиливают впечатление объемности экструдироемого 
объекта (рисунок 106). 
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Источники освещения включаются посредством кнопок с 
соответствующими номерами. Размещение источников выпол-
няется в окне просмотра с каркасом куба. Источники свободно 
перемещаются по точкам пересечения линий каркаса. Каждый 
источник может иметь собственную интенсивность свечения, 
значение которой определяется в поле Интенсивность (Intensi-
ty). По необходимости можно выделить требуемый источник (в 
окне просмотра он помечается черным кружком) и переместить 
движок в нужное положение. Флажок Использовать полноцвет-
ный диапазон (Use full color range) обеспечивает более точное 
соотношение света и тени. Вкладка Цвет (Color Wheel). 

Немаловажным фактором имитации пространства на 
плоскости являются цветовые эффекты. Вкладка Цвет (Color 
Wheel) предоставляет несколько вариантов цветовой залив-
ки элементов (рисунок 107). 

 

                
 

                           Рисунок 106                  Рисунок 107 

 
Переключатель Использовать заливку объекта (Use 

object fill) обеспечивает использование цвета или другой за-
ливки самого объекта. Если установлен флажок Ковровая 
заливка (Drape fills), то заливка заполняет весь объект без 
разбиения на грани. 

Переключатель Сплошная заливка (Solid fill) обеспечива-
ет заполнение поверхностей, имитирующих объем, сплош-
ным цветом, который выбирается из палитр, предоставляе-
мых кнопкой в поле Использовать (Using). 
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Переключатель Плавная заливка (Shade) призван обеспе-
чить плавный переход для более реальной имитаций осве-
щения. Цвета, определяемые с помощью кнопок От (From) и 
До (То), создают градиентную заливку с учётом параметров 
источников освещения. 

 
Вкладка Фаска (Bevels) 

 
Завершающим штрихом в обеспечении иллюзии трех-

мерности является создание у объекта фаски (скошенный 
край по всему периметру объекта), которую в реальности 
имеют очень многие предметы. 

Вкладка Фаска (Bevels) дает возможность создавать фас-
ку у объекта и изменять ее параметры. Для того чтобы со-
здать фаску, необходимо установить флажок Применить 
фаску (Use Bevel), а затем определить ее параметры. Сде-
лать это можно интерактивно в поле просмотра, перемещая 
выделенную точку на схеме или вводя необходимые значе-
ния в цифровые поля (рисунок 108). 

 

 
 

Рисунок 108 

 
Поле Глубина фаски (Bevel depth) задает размер фаски, а 

поле Угол фаски (Bevel angle) – угол наклона среза. 
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Команда Линза (Lens) 
 
Команда Линза (Lens) меню Effects (Эффекты) превраща-

ет выделенный объект, имеющий замкнутый контур и не 
входящий в группу, в некий фильтр с разнообразными свой-
ствами, влияющими на отображение объектов, расположен-
ных ниже, например, увеличивая его или фильтруя цвета и 
так далее. Если линза расположена над группой объектов, то 
она изменяет вид каждого объекта индивидуально. 

При выполнении этой команды на экран выводится па-
нель типа Docker, в которой представлен список линз и по-
ле просмотра с условной моделью эффекта. В зависимости 

от выбранной линзы предоставляются те или иные парамет-
ры эффекта. 

- Линза Прозрачная (Transparency) обеспечивает смеши-
вание цвета нижележащего объекта и цвета линзы, который 
можно выбрать с помощью кнопки Цвет (Color), с учетом 
значения в поле Уровень (Rate), определяющего в процентах 
уровень прозрачности линзы - чем больше значение, тем 
прозрачнее линза (рисунок 109). 

 

 
 

Рисунок 109 
 

- Линза Увеличение (Magnify) увеличивает нижележащий 

объект в соответствии со значением поля Коэффициент уве-
личения (Amount). 

- Линза Яркость (Brighten) определяет яркость нижеле-
жащего объекта в зависимости от значения поля Уровень 
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(Rate). Диапазон значений: от -100 до +100%. При +100% 
все цвета переходят в белый цвет, при 0% линза не оказы-
вает влияния на цвета нижележащих объектов, при - 100% 
все цвета переходят в черный. 

- Линза Инвертировать (Invert) предназначена для ин-
вертирования цветов нижележащего объекта: черный цвет - 
в белый, белый цвет - в черный и т.д. Если инвертирование 
затрагивает фон, что не всегда желательно, то стоит устано-
вить флажок Удалить фон (Remove Face). Тогда эффект ин-
вертирования коснется только изобразительных элементов 
(рисунок 110). 

 

 
 

Рисунок 110 
 
- Линза Цветной фильтр (Color Limit) фильтрует все 

цвета в нижележащем объекте, кроме цвета линзы, устанав-
ливаемого с помощью кнопки Цвет (Color). Интенсивность 
фильтрации определяется в поле Rate (Уровень): чем ниже 
значение, тем больший процент других цветов попадает в 
результирующий цвет. К этому эффекту также можно при-
менить флажок Удалить фон (Remove Face). 

- Линза Сложение цветов (Color Add) предназначена для 

смешивания цветов нижележащего объекта и линзы по 
принципу аддитивной модели RGB. Поля идентичны полям 
линзы Цветной фильтр (Color Limit). 

- Линза Окрашенная серая шкала (Tinted Grayscale) вы-
водит нижележащий объект в градациях серого, но с ис-
пользованием цвета линзы, определяемого с помощью кноп-
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ки Цвет (Color). Этот фильтр может использоваться для со-
здания тонированных фотографий. 

- Линза Инфракрасная шкала (Heat Мар) конвертирует 
цвета нижележащего объекта в цвета, характерные для ин-
фракрасной шкалы: в светлые и теплые, или темные и хо-
лодные цвета. Поле Смещение палитры (Palette rotation) 
определяет положение на палитре, с которого начинается 
конвертирование. 

- Линза Цветовой фильтр с растяжкой (Custom Color 
Map) изменяет цвета нижележащих объектов в соответствии 
с цветовой растяжкой, определяемой кнопками От (From) и 
До (То). Кнопка между ними взаимно меняет цвета. Направ-
ление растяжки выбирается в списке: вариант По прямой 
(Direct Palette) осуществляет растяжку по прямой линии че-
рез цветовой круг, а варианты Прямая радуга (Forward 
Rainbow) и Обратная радуга (Reverse Rainbow) осуществля-
ют растяжку по цветовому кругу в соответствующем направ-
лении (по часовой стрелке или против). 

- Линза Контурный режим (Wireframe) изменяет цвета 
обводки и заливки нижележащих объектов в соответствии с 
установками полей Обводка (Outline) и Заливка (Fill) в про-
извольном соче-тании. И то и другое можно отключить с 
помощью соответствую-щего флажка. 

- Линза "Рыбий глаз" (Fish Eye) увеличивает или умень-
шает и деформирует нижележащие объекты, как это делают 
сильно выгнутые фотографические линзы. Степень действия 
линзы в диапазоне от -1000 до +1000%, которая устанавли-
вается в поле Уровень (Rate). 

При выборе варианта Без линзы (No Lens Effects) уда-
ляются все параметры линзы объекта, и он из линзы пре-
кращается в "обыкновенный" объект. 

Флажок Заморозить (Frozen) фиксирует изображение, 
видимое через линзу, позволяет перемещать объект - линзу 
с сохранением этого изображения (рисунок 111). 

Флажок Точка зрения (Viewpoint) служит для перемещения 
изображения, видимого сквозь линзу, без перемещения объ-
ектов под линзой и самого объекта-линзы. При установке 
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флажка появляется кнопка Редактировать (Edit), после нажа-
тия на которую на экран выводится маркер в виде крестика. 
Перемещение маркера приводит к перемещению изображения. 

 

 
 

Рисунок 111 
 

Команда Обтравочный клип (Power Clip) 
 
Команда Обтравочный клип (Power Clip) в меню Эффекты 

(Effects) открывает небольшое меню с командами, предназна-
ченными для создания и редактирования этого эффекта. 

Любой объект может быть помещён в другой объект с 
той целью, чтобы быть по форме объекта-контейнера. 

Все объекты, входящие в клип, становятся единым объ-
ектом. Трансформировать обтравочный клип можно как це-
ликом, так и каждый объект по отдельности. Команда Ре-
дактировать содержание (Edit Contents) в разделе Обтра-
вочный клип (Power Clip) меню Эффекты (Effects) выводит 
на экран только объект-содержание, который можно под-
вергнуть всем необходимым изменениям – всем видам транс-
формаций без ограничения. Для редактирования вложенных 
клипов команду необходимо выполнить несколько раз. 

После завершения процесса внесения поправок необхо-
димо выполнить команду Закончить редактирование данно-
го уровня (Finish Editing This Level), которая снова помеща-
ет отредактированный объект в контейнер. 
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По умолчанию объект-содержание помещается в центр 
контейнера, отменить это свойство можно, удалив флажок 

Автоматическое центрирование нового содержания обтра-
вочного клипа (Autocenter new Power Clip contents) в разде-
ле Редактировать (Edit) диалогового окна Параметры 
(Options) (меню Windows команда Toolbars). 

 
Инструмент Интерактивная прозрачность  

(Interactive Transparency) 
 
Инструмент Интерактивная прозрачность (Interactive 

Transparency), кнопка которого расположена на инструмен-
тальной панели, привносит некоторые принципы точечной 
графики в программу векторной графики, а именно принцип 
полупрозрачной маски, которая широко применяется в про-
грамме Adobe Photoshop. 

Суть этого принципа заключается в создании точечного 
изображения в градациях серого, которое служит маской для 
цветовых параметров объектов. 

Инструмент Интерактивная прозрачность (Interactive 
Transparency) «работает в паре» с инструментальной поло-
сой Свойства (Property Ваг), которая даёт возможность ис-
пользовать все виды заливок, а также изменять параметры 
прозрачности. Вид полосы Свойства (Property Ваг) зависит 
от типа выбранной заливки (рисунок  112). 

 

 
 

Рисунок 112 
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Кнопка Edit (Редактировать) в левой части полосы пред-
назначена для вывода на экран основного диалогового окна 
соответствующей заливки. 

Из особенностей этой полосы следует обратить внимание 
на список режимов слияния маски прозрачности, которые 
обеспечивают восемнадцать способов взаимодействия цветов 
вышележащего и нижележащего объектов. 

В списке представлены следующие режимы: Нормальный 
(Normal), Сложение (Add), Вычитание (Substract), Разница 
(Difference), Усиление (Multiply), Ослабление (Divide), Если 
светлее (If Lighter), Если темнее (If Darker), Текстуризация 
(Texturize), Цветовой тон (Hue), Насыщенность (Saturation), 
Яркость (Lightness), Обращение (Invert), Логическое «и» 
(And), Логическое «или» (Or), Логическое «исключающее 
или» (Хог), Красный (Red), Зеленый (Green), Синий (Blue). 

 

Инструмент Интерактивная деформация  
(Interactive Distortion) 

 
Инструмент Интерактивная деформация (Interactive 

Distortion), кнопка которого расположена в группе Интерак-
тивный инструмент (Interactive Tool), предназначен для лю-
бителей «острых деформаций», поскольку с его помощью 
объекты преобразуются до полной неузнаваемости. Этот ин-
струмент также работает в паре с инструментальной поло-
сой Свойства (Property Ваг), в которой представлены кнопки 
трех типов деформации: «Тяни-Толкай» (Push and Pull), Зиг-
заг (Zipper) и Скручивание (Twister) (рисунок 113). 

Работа с данным инструментом ничем не отличается от 
применения других интерактивных инструментов, однако 
итоговый результат зависит от очень многих факторов, ча-
сто случайных (например, от исходного положения курсора 
или от расстояния, на которое он перемещается, и так да-
лее), что затрудняет получение «деформации по заказу». 

Разнообразие «продукции» этого инструмента безгра-
нично, даже если использовать в качестве исходного объек-
та простой прямоугольник (рисунок 114). 
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Рисунок 113 
 

 
 

Рисунок 114 
 

Инструмент Интерактивная тень 
 (Interactive Drop Shadow) 

 
Инструмент Интерактивная тень (Interactive Drop Sha-

dow), кнопка которого расположена в группе Интерактив-
ный инструмент (Interactive Tool), предназначен для созда-
ния теневого эффекта (рисунок 115). 

Этот инструмент также управляется с помощью инстру-
ментальной полосы Свойства (Property Ваг). 

В списке Направление тени (Drop Shadow Direction) пред-
ставлены следующие варианты размещения тени: Внутрь 
(Inside), По центру контура (Middle), Наружу (Outside), Усред-
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ненная (Average). А в списке Границы тени (Drop Shadow 
Edges) – варианты границ для первых трех типов тени: Ли-
нейная (Linear), Квадратная (Squared), Инвертированная квад-
ратная (Inverse Squared), Жесткая (Flat). 

 

 
 

Рисунок 115 

 
Цветовые эффекты 

 
Особенностью данной версии программы CorelDRAW 

являются цветовые фильтры, которые могут применяться не 
только к точечным изображениям, но и к векторным объек-
там. Команда Цветовые настройки (Color Adjustment) в ме-
ню Эффекты (Effects) выводит список из команд-фильтров, 
из которых шесть доступны для векторных объектов. 

- Фильтр Яркость-Контраст-Интенсивность (Brightness-
Contrast-Intensity) служит для настройки тоновых характе-
ристик изображения. Поле Яркость (Brightness) определяет 
изменение освещенности всего тонального диапазона, поле 
Контраст (Contrast) – изменение различия между светлыми 
и темными тонами, а поле Интенсивность (Intensity) – из-
менение светлых тонов (темные остаются без изменений). 

- Фильтр Цветовой баланс (Color Balance) позволяет из-
менить соотношение цветов в выделенном изображении. 
Сложность этого эффекта заключается в том, что любое из-
менение влияет на общий баланс цветов, например, измене-
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ние одного цветового компонента обязательно отразится на 
других цветах. 

- Фильтр Гамма (Gamma) предназначен для изменения 
соотношения яркости и контраста в средней части тонового 
диапазона, что позволяет сохранить уровни теней и светов. 
По умолчанию принято значение 1, что означает влияние на 
изображение, поскольку гамма в своей основе является от-
ношением входного сигнала (в данном случае исходного 
цвета) к выходному (в данном случае результата работы 
фильтра). При увеличении значения гаммы цвета осветля-
ются, при уменьшении – затемняются. 

- Фильтр Цветовой тон/Насыщенность/Светлота (Hue/ 
Saturation/Lightness) предназначен для изменения цветового 
тона, а также его насыщенности. 

- Фильтр Негатив (Invert) предназначен для получения 
негативных цветов заливки или точечного изображения. В 
результате черный и белый цвета заменяют друг друга, а 
прочие цвета заменяются на дополнительные. 

- Фильтр Постеризация (Posterize) предназначен для 
уменьшения количества оттенков цвета, т.е. позволяет све-
сти изображение к нескольким локальным цветам. Такой 
прием широко используется в графике, например в плакат-
ной. Эта команда может использоваться в качестве инстру-
мента для подготовки изображения к трассировке. 

 

Фильтры группы 3D Effects 
 

Фильтры группы Трехмерные эффекты (3D Effects) в 
меню Точечные изображения (Bitmaps) предназначены для 
создания некоторой имитации объемности, размещения или 
видимости плоских объектов в пространстве. 

 
Фильтр Вращение в пространстве (3D Rotate) 

 
Фильтр Вращение в пространстве (3D Rotate) предна-

значен для вращения точечного изображения, может ис-
пользоваться для имитации перспективных деформаций. 
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В диалоговом окне представлено поле для интерактивного 
вращения, а поля По вертикали (Vertical) и По горизонтали 
(Horizontal) позволяют изменить значения вращения в диапа-
зоне от -75 до 75. Флажок Лучшее размещение (Best fit) обес-
печивает оптимальное размещение изображения в границах 
габаритного прямоугольника (рисунок 116). 

 

 
 

Рисунок 116 
 

Фильтр Цилиндр (Cylinder) 
 

 
 

Рисунок 117 

 
Фильтр Цилиндр (Cylinder) предназначен для имитации 

растягивания изображения на цилиндрическую поверхность. 
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В диалоговом окне представлены в виде переключателей 
два режима расположения цилиндра: 

Горизонтальный (Horizontal) и Вертикальный (Vertical). 
Поле Эффект (Percentage) позволяет определить величину 
эффекта в диапазоне от -100 до 100. 

В окне просмотра справа условно отображаете характер 
деформации (рисунок 117). 

 
Фильтр Emboss 

 
Фильтр Тиснение (Emboss) предназначен для имитации 

рельефного тиснения. Однако для этого фильтра годятся не 
всякие изображения, а только те, у которых высокий кон-
траст и небольшой диапазон цвета. 

В диалоговом окне поле Глубина (Depth) определяет вы-
соту тиснения, а поле Уровень (Level) – количество исход-
ного цвета, который переходит в тиснение. В поле Направ-
ление (Direction) можно определить угол, под которым вид-
но тиснение. 

В поле Цвет тиснения (Emboss color) представлены сле-
дующие варианты (рисунок  118): 

 

 
 

Рисунок 118 
 

- Original color (Исходный цвет) – используются исход-
ные цвета точечного изображения; 
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- Серый (Gray) и Черный (Black) – удаляются исходные 
цвета и изображение представляется в серых или черных 
тонах; 

- Другой цвет (Other) позволяет выбрать произвольный 
цвет для тиснения. 

 
Фильтр Page Curl 

 
Фильтр Завиток угла страницы (Page Curl) предназначен 

для имитации трехмерности страницы, что и подчеркивает 
наличие завитка (рисунок 119). 

 

 
 

Рисунок 119 
 

В диалоговом окне можно выбрать один из четырех уг-
лов страницы, который "собственно и загибается". В поле 
Направление (Direction) определяется, вдоль вертикальной 
(переключатель Vertical) или горизонтальной (переключа-
тель Horizontal) стороны располагается завиток. В поле Бу-
мага (Paper) задается тип бумаги: непрозрачная (пере-
ключатель Opaque) или прозрачная (переключатель Trans-
parent), а в поле Цвет (Color) - цвет завитка (поле Curl) и 
фона (поле Background). 

Поля Ширина (Width) и Высота (Height) позволяют уста-
навливать размеры завитка в процентах от соответствующих 
размеров изображения. 
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Фильтр Перспектива (Perspective) 
 
Фильтр Перспектива (Perspective) дает возможность по-

лучить перспективные деформации. 
В диалоговом окне представлены два переключателя, 

выбор которых определяет вид деформации: переключатель 
Перспектива (Perspective) обеспечивает возможность пе-
ремещать в окне просмотра два маркера в различных нап-
равлениях одно-временно, а переключатель Сдвиг (Shear) – 
перемещать два маркера в одном направлении (рисунок 120). 

 

 
 

Рисунок 120 

 
Фильтр Дисторсия (Pinch/Punch) 

 
Фильтр Дисторсия (Pinch/Punch) предназначен для дефор-

мации изображения на вогнутой или выпуклой поверхности. 
В диалоговом окне в поле Дисторсия (Pinch/Punch) 

определяется степень кривизны в диапазоне от -100 до 100. 

Центр кривизны можно определить интерактивно с помо-
щью инструмента Центр (Set Center), кнопка которого рас-
положена с левой стороны окна. 

 
Фильтр Сфера (Sphere) 

 
Фильтр Сфера (Sphere) представляет собой "усиленный" 

вариант фильтра Дисторсия (Pinch/Flinch), а именно де-
формация обеспечивается более, чем на полусферу. 
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В диалоговом окне управление осуществляется так же, 
как в окне предыдущего фильтра. 

 

Фильтры группы Художественные техники 
 (Art Strokes) 

 
Фильтры группы Художественные техники (Art Strokes) 

могут иметь интерес для тех пользователей, кто использует 

различные техники художественного творчества из своей до 
компьютерной практики. 

 
Фильтр Уголь (Charcoal) 

 
Фильтр Уголь (Charcoal) предназначен для имитации ри-

сунка, который традиционно выполняется палочками дре-
весного угля. 

В диалоговом окне можно определить размер палочки угля 
(поле Size) и силу подчеркивания краев штриха (поле Edge). 

 
Фильтр Цветные мелки (Conte Crayon) 

 
Фильтр Цветные мелки (Conte Crayon) предназначен 

для имитации рисунка цветными мелками небольшого ас-
сортимента (скажем, набор школьных мелков). Позволяет 
создавать рисунки в техниках сангины и сепии. 

В диалоговом окне в поле Цвет мелка (Conte Colors) 
можно выбрать в любом сочетании пять цветов для мелков, 
в поле Цвет бумаги (Paper Color) – для бумаги (можно вы-
брать любой цвет из рисунка с помощью инструмента Пи-
петка (Eyedropper)). Поля Нажим (Pressure) и Текстура 
(Texture) предназначены для изменения характера штрихов 
и уровня зернистости. 

 
Фильтр Восковые мелки (Crayon) 

 
Фильтр Восковые мелки (Crayon) предназначен для 

имитации рисунка восковыми мелками. 
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В диалоговом окне определяются размер мелка (поле 
Size) и степень выраженности очертаний (поле Outline). 

 
Фильтр Кубизм (Cubist) 

 
Фильтр Кубизм (Cubist) предназначен для преобразова-

ния точечного изображения в некое подобие кубистического 
течения в живописи. 

В диалоговом окне немного требуется, чтобы преобразо-
вать изображение: определить размер "кубика" (поле Size) и 
яркость изображения (поле Brightness). Поле Цвет бумаги 
(Paper Color) поможет выбрать достойный цвет основы. 

 
Фильтр Импрессионизм (Impressionist) 

 
Фильтр Импрессионизм (Impressionist) предназначен для 

преобразования точечного изображения и имитации импрес-
сионистической манеры живописи. 

В диалоговом окне импрессионистические эффекты до-
стигаются определением следующих параметров: в поле 
Стиль (Style) можно выбрать живопись штрихами (переклю-
чатель Strokes) и пятнами (переключатель Dabs), в поле 
Штрих (Stroke) или Пятно (Dab Size) в зависимости от пере-
ключателя можно определить размер мазка, в полях Цвет-
ность (Coloration) и Яркость (Brightness) - насыщенность 
цвета и света соответственно. 

 
Фильтр Мастихин (Palette Knife) 

 
Фильтр Мастихин (Palette Knife) предназначен для ими-

тации изображения с помощью специальной лопаточки - ма-
стихина, которым обычно удаляют излишки краски, но ма-
стера виртуозно используют его в качестве рисующего ин-
струмента. 

В диалоговом окне Ширина лезвия (Blade Size), Расту-
шевка краев (Soft Edge) и Угол (Angle), определяются зна-
чения, необходимые для задуманной имитации. 
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Фильтр Пастель (Pastels) 
 
Фильтр Пастель (Pastels) предназначен для имитации ху-

дожественной техники пастели – рисование цветными мел-
ками с нежными и тонкими оттенками цветов. 

В диалоговом окне предоставляется выбор двух типов 
пастели: 

• переключатели Светлая (Soft) для чистой и нежной 
пастели и Темная (Oil) для пастели на масляной основе. По-
ля Размер штриха (Stroke Size) и Вариация цвета (Hue 
Variation) определяют «техническую» и цветовую характери-
стики изображения. 

 
Фильтр Перо и тушь (Реп & Ink) 

 
Фильтр Перо и тушь (Pen & Ink) предназначен для имита-

ции техники рисунка пером и тушью, техники очень скромной 
по средствам, но очень сильной по выразительности. 

В диалоговом окне предлагается всего два варианта 
штрихов: 

• перекрестные штрихи (Crosshatch) и Гравировка точ-
ками (Stippling). Поля Плотность (Density) и Нажим пера 
(Ink Pools) позволяют изменять характер рисунка: от легко-
го и изящного до плотного и насыщенного. 

 
Фильтр Пуантилизм (Pointillist) 

 
Фильтр Пуантилизм (Pointillist) предназначен для ими-

тации художественной техники пуантилизма. 
Используется принцип смешения цветов - отдельные 

цветовые мазки, нанесенные рядом, на определенном рас-
стоянии сливаются и образуют иную цветовую картину 
(мерцающую атмосферу). Этот принцип в автоматическом 
варианте используется в цветной полиграфии. 

Диалоговое окно позволяет с помощью всего двух полей 
Размер пятна (Size) и Яркость (Brightness) любому желаю-
щему проявить себя на ниве пуантилизма. 
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Фильтр Граффити (Scraperboard) 
 
Фильтр Граффити (Scraperboard) предназначен для ими-

тации техники процарапывания краски, сквозь царапины 
проступает цветная или белая подложка. 

В диалоговом окне переключатель Цветная (Color) обес-
печивает цветную, а переключатель Белая (White) - белую 
подложку. Поля Плотность (Density) и Размер царапины 
(Size) позволяют добиться нужного эффекта. 

 
Фильтр Набросок (Sketch Pad) 

 
Фильтр Набросок (Sketch Pad) предназначен для имита-

ции рисунка карандашами (простым или цветными). 
В диалоговом окне переключатель Графитовый (Grap-

hite) обеспечивает параметры, характерные для простого ка-
рандаша, а переключатель Цветной (Color) – для цветных 
карандашей. Поле Стиль (Style) дает возможность опреде-
лить диапазон от небрежного способа рисования (Rough) до 
аккуратного (Fine) (рисунок 121). 

 

  
 

Рисунок 121 

 

Поле Грифель (Lead) для простого карандаша определяет 

степень мягкости карандаша от твердого слева (6Н) до мяг-
кого справа (6Б). Для цветных карандашей это поле заменя-
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ется на Нажим (Pressure). В поле Абрис (Outline) определя-
ется интенсивность проработки контуров. 

 

Фильтр Акварель (Watercolor) 

 
Фильтр Акварель (Watercolor) предназначен для имита-

ции художественной техники акварели – живописи водными 

красками. 

В диалоговом окне представлено пять полей, которые 
решают все проблемы акварели: Размер кисти (Brush Size), 

Зернистость (Granulation), Количество воды (Water 

Amount), Bleed (Растекание краски) и Яркость (Brightness). 

 

Фильтр Цветной маркер (Water Marker) 

 
Фильтр Цветной маркер (Water Marker) предназначен 

для имитации рисунка с помощью цветных маркеров, обыч-
но используемых для выделения фрагментов текста. Рисунок 

ввиду значительной толщины фетровой палочки маркера 
чаще всего получается декоративно-абстрактным. 

В диалоговом окне предлагается три варианта – Обыч-
ный (Default), Упорядоченный (Order) и Случайный 

(Random). Поля Размер (Size) и Вариации цвета (Color 

Variation) позволяют изменить толщину рисующего элемен-
та маркера и величину контраста цветов соответственно. 

 

Фильтр Текстурная бумага (Wave Paper) 

 
Фильтр Текстурная бумага (Wave Paper) предназначен 

для имитации рисунка или живописи на текстурной бумаге, 
например на промокательной бумаге или на салфетках. 

В диалоговом окне – достаточно скромное меню: рису-
нок можно выполнить в цвете (переключатель Color) и в 

чернобелом варианте (переключатель Black & White), а 
кроме того, можно определять степень нажима инструмента 
(поле Brush Pressure). 



122 

Фильтры группы Размытие (Blur) 

 

Фильтры группы Размытие (Blur) предназначены для 

уменьшения резкости изображения и сглаживания контуров. 

Программа предлагает девять фильтров, управление которыми 

сводится к определению одного - двух параметров. 

 

Фильтр Направленное сглаживание (Directional Smooth) 

 
Фильтр Направленное сглаживание (Directional Smooth) 

обеспечивает очень незначительное размытие, программа 
анализирует изображение на предмет выявления пикселов с 
идентичными тоновыми значениями, в этом направлении и 

происходит размытие. 
В диалоговом окне одно поле Процент (Percentage) опре-

деляет силу эффекта. 

 
Фильтр Размытие по Гауссу (Gaussian Blur) 

 
Фильтр Размытие по Гауссу (Gaussian Blur) предназна-

чен для получения размытия с использованием функции 

Гаусса. 
В диалоговом окне поле Радиус (Radius) определяет сте-

пень размытия: чем больше значение, тем сильнее размытие. 
 
Фильтр Удаление "зазубрин " (Jaggy Despeckle) 

 
Фильтр Удаление "зазубрин" (Jaggy Despeckle) предназна-

чен для смягчения достаточно контрастных изображений низ-
кого разрешения с характерным "ступеньками" или "зазубри-
нами". 

В Диалоговом окне поля По горизонтали (Width) и По 
вертикали (Height) определяют количество соседних пиксе-
лов, по горизонтали (слево направо) и по вертикали (сверху 
вниз) для размытия. Флажок Симметрично (Symmetn) обес-
печивает идентичность установок на обоих полях. 
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Фильтр Низкий контраст (Low Pass) 
 

Фильтр Низкий контраст (Low Pass) предназначен для 
уменьшения резких границ и мелких деталей. 

В диалоговом окне поля Эффект (Percentage) и Радиус 
(Radius) определяют параметры размытия: большие значе-
ния уменьшают различие между уровнями светов и теней, 
тем самым уменьшается общий контраст изображения. 

 
Фильтр Размытие в движении Motion Blur 

 
Фильтр Размытие в движении (Motion Blur) предназна-

чен для имитации художественного приема, которым часто 
пользуются при изображении предмета в движении. 

В диалоговом окне поле Расстояние (Distance) и поле На-
правление (Direction) определяют параметры размытия: длину 
размытия и угол его наклона. В поле Заполнение областей вне 
изображения (Off-image sampling) предлагается три варианта: 
Игнорировать пиксели вне изображения (Ignore pixels outside 
image), Использовать цвет фона (Use paper color) и Использо-
вать краевые пиксели (Sample nearest edge pixel). 

 
Фильтр Радиальное размытие (Radial Blur) 

 
Фильтр Radial Blur (Радиальное размытие) предназначен 

для имитации размытия, получаемого при вращении пред-
мета. Центр вращения можно определить с помощью ин-
струмента Центр (Set Center) в диалоговом окне. Поле Эф-
фект (Amount) определяет степень размытия. 

 
Фильтр Сглаживание (Smooth) 

 
Фильтр Сглаживание (Smooth) предназначен для уменьше-

ния тонального различия соседних пикселов, это ведет к об-
щему сглаживанию и потере мелких деталей. Данный фильтр 
не оказывает очень сильного влияния на изображение. 
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В диалоговом окне поле Эффект (Percentage) определяет 
степень сглаживания. 

 
Фильтр Смягчение (Soften) 

 
Фильтр Смягчение (Soften) предназначен для обеспече-

ния легкого размытия при определенном сохранении мелких 
деталей. 

В диалоговом окне поле Эффект (Percentage) определяет 
степень смягчения. 

 
Фильтр Трансфокация (Zoom) 

 
Фильтр Трансфокация (Zoom) предназначен для имита-

ции размытия, возникающего в процессе трансфокации 
(удаления или приближения предмета в оптической систе-
ме). Центр транс-фокации можно определить с помощью ин-
струмента Центр (Set Center, в диалоговом окне. 

Поле Эффект (Amount) определяет степень размытия. 
 

Фильтры группы Трансформирование цвета  
(Color Transform) 

 
Фильтры группы Трансформирование цвета (Color 

Transform) предназначены для экзотических трансформаций. 
Такие изображения достаточно модны в молодежных изда-
ниях и на Web-cepвepax. 

 
Фильтр Цветовые плоскости Bit Planes 

 
Фильтр Цветовые плоскости (Bit Planes) сокращает цвета 

изображения до основных цветов модели RGB и отображает 
тоновые изменения в изображении с использованием чистых 
цветов. Этот фильтр используется для анализа градиентов. 

В диалоговом окне поля Красный (Red), Зеленый (Green) и 
Синий (Blow) позволяют изменять площадь каждой цветовой 
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плоскости. Флажок Применить ко всем плоскостям (Apply to all 
planes) обеспечивает идентичные установки на всех полях. 

 
Фильтр Полутоновый растр (Color Halftone) 

 
Фильтр Полутоновый растр (Color Halftone) позволяет 

получить изображение, имитирующее результат полиграфи-
ческого исполнения (цветоделение и растрирование). 

В диалоговом окне в поле Максимальный радиус растро-
вой точки (Max dot radius) определяется параметр, модели-
рующий миниатюру растра полиграфического оттиска. Поля 
Голубой (Cyan), Пурпурный (Magenta), Желтый (Yellow) и 
Черный (Black) дают возможность установить угол наклона 
растра для каждого цвета. 

Следует обратить внимание на этот фильтр, поскольку 
он является прекрасной моделью полиграфического процесса 
в области цветоделения и растрирования. Изменяя его па-
раметры, можно с определенной долей условности смодели-
ровать, например, условия для появления муара. 

 
Фильтр Психоделический (Psychedelic) 

 
Фильтр Психоделический (Psychedelic) предназначен для 

конвертирования изображения в так называемые "электри-
ческие цвета": оранжевый, розовый, голубой и зеленый. 

В диалоговом окне поле Уровень (Level) позволяет изме-
нить некое условное значение, хотя предугадать результат 
очень трудно. 

 
Фильтр Соляризация (Solarize) 

 
Фильтр Solarize (Соляризация) предназначен для имита-

ции фотографического приема кратковременной засветки 
фотобумаги сильным светом во время проявления. В резуль-
тате образуется изображение с негативными и позитивными 
элементами, что приводит иногда к интересным, хотя и слу-
чайным эффектам. 
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В диалоговом окне поле Уровень (Level) позволяет изме-
нять интенсивность соляризации. 

 
Фильтры группы Контур (Contour) 

 
Фильтры группы Контур (Contour) предназначены для 

различного рода выявлений областей с резкими переходами 
или сильным контрастом, которые можно трактовать в ка-
честве линейных контуров. 

 
Фильтр Выявление краев (Edge Detect) 

 
Фильтр Выявление краев (Edge Detect) предназначен 

для выделения в изображении элементов с резким контра-
стом и преобразования их в линии на фоне однотонного 
цвета. Этот фильтр полезен для высококонтрастных изобра-
жений с мелкими деталями, например, текстом. 

В диалоговом окне в поле Цвет фона (Background color) 
можно выбрать один из трех переключателей: Белый (White), 
Черный (Black) и Другой (Other). Последний вариант позволя-
ет определить практически любой цвет для фона. Поле Чув-
ствительность (Sensitivity) служит для регулировки уровня 
контраста, необходимого для усиления контура. 

 
Фильтр Выделение краев (Find Edges) 

 
Фильтр Выделение краев (Find Edges) так же, как и 

предыдущий фильтр, предназначен для выделения резких 
границ и отображения их в виде линейных контуров на свет-
лом фоне. 

В диалоговом окне в поле Тип контура (Edge Туре) пред-
ставлены два варианта: Смягченный (Soft) и Однотонный 
(Solid). Поле Уровень (Level) позволяет управлять интен-
сивностью эффекта. 
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Фильтр Оконтуривание (Trace Contour) 
 
Фильтр Оконтуривание (Trace Contour) предназначен 

для выявления резких изменений цвета в изображении и 
отображения их цветными контурами на светлом фоне. 

В диалоговом окне поле Тоновый уровень (Level) служит 
для определения порогового значения уровня. Переключате-
ли в поле Тип контура (Edge Туре) определяют способ вы-
явления контура: при выборе переключателя Снизу (Lower) 
очерчивается край ниже по тону, чем установленный уро-
вень, а переключателя Сверху (Upper) - выше. 

 
Фильтры группы Имитация (Creative) 

 
Фильтры группы Имитация (Creative) предназначены для 

моделирования некоторых материальных техник, имеющих 
изобразительную составляющую, например мозаику, декора-
тивную плитку, витраж и прочее. 

 
Фильтр Ремесла (Crafts) 

 
Фильтр Ремесла (Crafts) позволяет получить изображе-

ния из элементов, характерных для различных ремесел, 
профессий или занятий. В диалоговом окне в списке Вид 
(Style) можно выбрать следующие варианты: Головоломка 
(Puzzle), Шестерни (Gear), Мраморные шары (Marble), Ле-
денцы (Candy), Керамические плитки (Ceramic Tile) и Фиш-
ки для игры в покер (Poker Chips). 

Поле Размер (Size) позволяет изменить размер элемента, 
поля Завершенность (Complete) и Яркость (Brightness) опре-
деляют процент изображения покрываемого элементами и 
яркость элементов соответственно. Поле Вращение (Rota-
tion) служит для установки угла вращения элементов (у 
каждого вида элемента свои ограничения). 
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Фильтр Кристаллизация (Crystalize) 
 
Фильтр Кристаллизация (Crystalize) предназначен для 

разбиения изображения на цветные кристаллики неправиль-
ной формы. 

В диалоговом окне поле Размер (Size) определяет размер 
кристаллика. 

 
Фильтр Ткани (Fabric) 

 
Фильтр Ткани (Fabric) предназначен для имитации кол-

лажа из различных тканных материалов. 
В диалоговом окне в списке Вид (Style) можно выбрать 

следующие варианты: Ручная вышивка по канве (Needle 
point), Коврик (Rug Hooking), Лоскутное одеяло (Quilt), Те-
семка (String), Ленты (Ribbons) и Коллаж из тканей (Tissue 
Collage). 

Поле Размер (Size) позволяет изменить размер элемента, 
поля Завершенность (Complete) и Яркость (Brightness) опре-
деляют процент изображения, покрываемого элементами, и 
яркость элементов соответственно. Поле Вращение (Rota-
tion) служит для установки угла вращения элементов (у 
каждого вида элемента свои ограничения). 

 
Фильтр Рама (Frame) 

 
Фильтр Рама (Frame) предназначен для создания обрамле-

ния, образец которого - точечное изображение (рисунок 122). 

Диалоговое окно данного фильтра состоит из двух вкла-
док. Вкладка Выбор (Select) позволяет определить совокуп-
ность изображений, которые вместе составят раму. Этот 
набор можно сохранить для последующего использования, 

если нажать кнопку со знаком плюс и в появившемся диало-
говом окне ввести произвольное имя. Настройка (Modify) 
предлагает различные настройки рамы. В поле Цвет (Color) 
можно изменить цвет, поля Непрозрачность (Opacity) и Раз-
мытие/Растушевка (Blur/Feather) служат для настройки 
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«плотности» или «бесплотности» рамки, поля По горизонта-
ли (Horizontal) и По вертикали (Vertical) – размерности 
рамки. Кнопка с видом замочка позволяет устанавливать 
идентичные значения. В поле Вращение (Rotate) опреде-
ляется угол вращения. 

Кнопки Отражение по горизонтали/вертикали (Flip) да-
ют возможность легко заменить тип ориентации: «право-
налево», «верх на низ» и наоборот. 

 

 
 

Рисунок 122 
 

Кнопки Перенести центр (Align) и Восстановить центр 
(Re- center) служат для определения произвольного центра 
рамки и для восстановления его исходного положения. 

Список Слияние (Blend) предлагает варианты взаимодей-
ствия цветов изображения и цвета рамы. 

 
Фильтр (Glass Block) 

 
Фильтр Стеклянные блоки (Glass Block) предназначен 

для имитации изображения, получаемого при рассматрива-
нии его через стену из стеклянных блоков. 

В диалоговом окне два поля Ширина блока (Block width) 
и Высота блока (Block height) служат для определения раз-
мерности блоков. 
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Фильтр Детские игры (Kid's Play) 
 
Фильтр Детские игры (Kid's Play) предназначен для имита-

ции изображений, составленных из предметов детских забав. 
В диалоговом окне в списке Игра (Game) представлены сле-

дующие варианты: Крокетные колышки (Lite Pegs), Строитель-
ные блоки (Building Block), Рисование пальцем (Finger Paint), 
Рисование ограниченным числом красок (Paint By Numbers). 

Поле Детализация (Detail) позволяет изменить уровень 
обобщенности, а с помощью поля Яркость (Brightness) опре-
деляют яркость элементов. 

 
Фильтр Мозаика (Mosaic) 

 
Фильтр Мозаика (Mosaic) предназначен для имитации 

изображения, составленного из цветных камешков. 
В диалоговом окне поле Размер (Size) определяет размер 

элементов, поле Цвет фона (Background Color) - цвет под-
ложки. Флажок Виньетка (Vignette) устанавливается при со-
здании эллипсовидной виньетки вокруг рисунка. 

 
Фильтр Частицы (Particles) 

 
Фильтр Частицы (Particles) предназначен для заполнения 

рисунка частицами в виде звезд или пузырьков (рисунок 123). 
 

 
 

Рисунок 123 
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В диалоговом окне в списке Вид (Style) представлены два ва-
рианта: Звезды (Stars) и Пузырьки (Bubbles). Поле Размер (Size) 
служит для определения размера частицы, поле Плотность 
(Density) – количества на определенной площади, поля Цвет-
ность (Coloration) и Прозрачность (Transparency) – насыщенно-
сти цвета и его прозрачности соответственно. Поле Угол (Angle) 
позволяет расположить все частицы под углом. 

 
Фильтр Распыление (Scatter) 

 

Фильтр Распыление (Scatter) предназначен для создания 
изображения, в котором исходные пикселы «распылены». 

В диалоговом окне поля По горизонтали (Horizontal) и 
По вертикали (Vertical) определяют степень распыления со-
ответственно слева направо и сверху вниз. 

 

Фильтр Задымленное стекло (Smoked Glass) 
 

Фильтр Задымленное стекло (Smoked Glass) предназна-
чен для имитации изображения, видимого сквозь цветное 
размытое стекло. 

В диалоговом окне цвет выбирается в поле Цвет (Color), 
а его оттенок - в поле Оттенок (Tint). Степень размытости 
устанавливается в поле Размытие (Blurring). 

 

Фильтр Витраж (Stained Glass) 
 

Фильтр Витраж (Stained Glass) предназначен для имита-
ции изображения, напоминающего витраж из цветного стек-
ла со свинцовыми перемычками. 

В диалоговом окне поле Размер (Size) позволяет изме-
нять размер элементов витража, поле Интенсивность осве-
щения (Light Intensity) имитирует освещенность витража 
снаружи (чем сильнее освещенность, тем эффектнее витраж 
на темном фоне). 

Поля Цвет перемычки (Solder Color) и Толщина перемычки 
(Solder Width) позволяют имитировать витражи с различными 
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материалами. Флажок Трехмерное освещение (3D Lighting) 
прибавит реальности за счет имитации объема стекол. 

 
Фильтр Виньетка (Vignette) 

 
Фильтр Виньетка (Vignette) предназначен для создания 

декоративного окружения вокруг изображения. Стилистика 
виньеток связана с классической фотографией и способна 
вызывать ностальгические чувства. 

В диалоговом окне в поле Цвет (Color) можно выбрать 
черный, белый или любой произвольный цвет, а в поле 
Форма (Shape) - одну из форм: Эллипс (Ellipse), Круг 
(Circle), Прямоугольник (Rectangle) и Квадрат (Square). 

Поля Сдвиг (Offset) и Затухание (Fade) обеспечивают 
толщину виньетки и степень ее растушевки. 

 
Фильтр Вихритель (Vortex) 

 
Фильтр Вихритель (Vortex) предназначен для создания 

рисунка в виде водоворота или вихря вокруг определенного 
центра. Результат напоминает некоторые полотна Винсента 
Ван Гога. 

В диалоговом окне в списке Вид (Style) можно выбрать 
один из видов завихрений: Обычное (Brushed), Слоистое 
(Layered), Широкое (Thick) и Тонкое (Thin), а инструментом 
Центр (Set Center), кнопка которого расположена рядом со 
списком - определить его центр. Поле Размер (Size) позво-
ляет установить длину штриха. 

В полях Внутреннее направление (Inner Direction) и 
Внешнее направление (Outer Direction) определяются 
направление вращения пикселов вокруг центра и краевых 
пикселов соответственно. 

 
Фильтр Погодные явления (Weather) 

 
Фильтр Погодные явления (Weather) предназначен для 

имитации рисунков, на которых изображаются погодные яв-
ления (дождь, снег и туман). 
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В диалоговом окне в поле Прогноз погоды (Forecast) 
можно выбрать один из вариантов: Снег (Snow), Дождь 
(Rain) или Туман (Fog). 

Поля Сила (Strength) и Размер (Size) позволяют опреде-
лить погодные явления различной силы и величины состав-
ляющих элементов. Для дождя дополнительно выводится 
поле Направление (Direction), с помощью которого получа-
ется «косой дождь». 

Распределение элементов в любых атмосферных явлени-
ях носит случайный характер, поэтому в диалоговом окне 
предусмотрена кнопка Случайно (Randomize), которая за-
пускает механизм случайного распределения. 

 
Фильтры группы Деформация (Distort) 

 
Фильтры группы Деформация (Distort) предназначены 

для преобразования точечных изображений с различного 
рода деформациями: сдвигами, разбиениями, рябью и про-
чим. Фильтры данной группы обеспечивают очень эффект-
ный результат, который подчас полностью разрушает ис-
ходное изображение. 

 
Фильтр Блоки (Blocks) 

 
Фильтр Блоки (Blocks) предназначен для разбиения изоб-

ражения на блоки и случайного распределения их по плоско-
сти. 

В диалоговом окне размеры блоков определяются с помо-
щью полей Ширина блока (Block width) и Высота блока (Block 
height). Максимальное расстояние между блоками устанавлива-
ется посредством поля Максимальный сдвиг (Max. offset (%)). 

Области, которые освободились от блоков, заполняются 
разными способами, перечень которых приведен в списке Не-
определенные области (Undefined Areas): Исходное изображе-
ние (Original Image), Негативное изображение (Inverse Image), 
Черный цвет (Black), Белый цвет (White) и Другой цвет 
(Other). В последнем случае можно определить любой цвет. 
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Фильтр Смещение (Displace) 
 
Фильтр Смещение (Displace) предназначен для измене-

ния изображения в соответствии с другим изображением, 
которое называется картой смещения (displacement map). 
При этом значения карты смещения оказывают влияние на 
форму, цвет и деформацию исходного изображения. В папке 
Corel\Graphics9\ Custom\Displace хранится целый набор та-
ких карт смещения. Разумеется, что можно разработать и 
собственные карты смещения. 

Выбор карты смещения осуществляется из списка в пра-
вом нижнем углу, а ее вид отображается в окне просмотра 
над списком. 

В поле Режим масштабирования (Scale mode) диалогового 
окна представлены два переключателя: Повторение (Tile) обес-
печивает повторение карт смещения таким образом, чтобы за-
полнялась вся площадь изображения, а Растяжение (Stretch to 
fit) обеспечивает растяжение одной карты смещения на всю 
площадь изображения. Это ведет к различным эффектам. 

В списке Неопределенные области (Undefined areas) 
можно выбрать один из двух вариантов: Заполнить гранич-
ными пикселями (Repeat Edges) и Вставить отсеченные 
фрагменты (Wrap Around). 

Поля По горизонтали (Horizontal) и По вертикали 
(Vertical) служат для определения степени смещения по го-
ризонтали (слева направо) и по вертикали (сверху вниз). 

 
Фильтр Сдвиг (Offset) 

 
Фильтр Сдвиг (Offset) предназначен для сдвига изобра-

жения по горизонтали и вертикали. 
В диалоговом окне поля По горизонтали (Horizontal) и 

По вертикали (Vertical) обеспечивают сдвиг рисунка в пик-
селях или процентах. В последнем случае следует установить 
флажок Сдвиг в процентах от размеров изображения (Shift 
value as % of dimensions). В списке Неопределенные области 
(Undefined Areas) предлагается три варианта: 
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- Вставить отсеченные фрагменты (Wrap Around) - осво-
бодившееся место заполняется той частью изображения, кото-
рая «выталкивается» с противоположной стороны; 

- Заполнить граничными пикселями (Repeat Edges) - 
освободившееся место заполняется пикселями, дублирующи-
ми расположенные вдоль границ изображения. Это приводит 
к формированию полос; 

- Цвет (Color) – освободившееся место заполняется цве-
том, который выбирается с помощью инструмента Пипетка 
(Eyedropper) из изображения или определяется традицион-
ными методами. 

 
Фильтр Пикселизация (Pixelate) 

 
Фильтр Пикселизация (Pixelate) предназначен для созда-

ния мозаики из виртуальных элементов различной формы. 
В диалоговом окне в поле Режим пикселизации (Pixelate 

mode) представлены три переключателя для выбора типа 
мозаики: Квадратная (Square), Прямоугольная (Rectangular) 
и Радиальная (Radial). Поля Ширина (Width) и Высота 
(Height) служат для определения размеров элементов моза-
ики, а поле Непрозрачность (Opacity) - их непрозрачности. 
Для радиальной мозаики с помощью инструмента Центр (Set 
Center) определяется произвольный центр вращения. 

 
Фильтр Рябь (Ripple) 

 
Фильтр Рябь (Ripple) предназначен для имитации ряби 

на воде и соответствующего отражения в ней. В диалоговом 
окне в поле Первичная волна (Primary Wave) поля Частота 
(Period) и Амплитуда (Amplitude) служат для задания разма-
ха и высоты волн. В поле Перпендикулярная волна 
(Perpendicular Wave) определяется только ее амплитуда. 

Для того чтобы дополнительно деформировать изобра-
жение, можно установить флажок Деформирующая рябь 
(Distort ripple) или определить угол распространения волн. 
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Фильтр Скручивание (Swirl) 
 
Фильтр Скручивание (Swirl) позволяет закручивать 

изображение сильнее в центре, чем по краям, создавая ил-
люзию перемешивания краски в ведре. 

В диалоговом окне в поле Направление (Direction) мож-
но установить, в какую сторону будет происходить закручи-
вание изображения: по часовой стрелке (переключатель 
Clockwise) или против нее (переключатель Counter-
Clockwise). Кнопка инструмента Центр (Set Center) служит 
для задания произвольного центра закручивания. 

Угол основного вращения определяется в поле Полные 
витки (Whole Rotations), а дополнительного — в поле До-
полнительное вращение (Additional Degrees). 

 

Фильтр Разбиение (Tile) 
 

Фильтр Разбиение (Tile) предназначен для заполнения 
плоскости исходным изображением. Этот фильтр может при-
годиться Web-дизайнерам для экспериментов с фоновым 
изображением. 

В диалоговом окне поля Горизонтальные элементы 
(Horizontal Tiles) и Вертикальные элементы (Vertical Tiles) 

определяют количество элементов по горизонтали и по вер-
тикали. Для обеспечения равных значений достаточно «уто-
пить» кнопку с изображением замка. 

 

Фильтр Жидкая краска (Wet Paint) 
 
Фильтр Жидкая краска (Wet Paint) предназначен для ими-

тации живописи, которая выполняется не очень умелым худож-
ником, допускающим растекание краски. Иногда это напоми-
нает лист акварели, пережившей короткий ливень (рисунок 124). 

В диалоговом окне поле Эффект (Percent) определяет 
длину потоков краски, а поле Влажность (Wetness) - харак-
тер преобладающей краски в потоках: отрицательные значе-
ния дают темные потоки, а положительные - светлые. 
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Рисунок 124 
 

Фильтр Водоворот (Whirlpool) 
 

Фильтр Водоворот (Whirlpool) предназначен для размы-
вания изображения многочисленными струями, характерны-
ми для водоворота или потоков дыма и газа. 

В диалоговом окне представлены следующие поля, оказы-
вающие влияние на вид, количество и поведение струй: поле 
Интервал (Spacing) определяет расстояние между струями, по-
ле Длина струи (Smear Length) - длину струи, поле Кручение 
(Twist) - степень завихрения струй, а поле Детализация (Streak 
Detail) - степень детализации, заключающейся в количестве 
«прожилок». Флажок Искривление (Warp) обеспечивает дефор-
мацию рисунка в соответствии с направлением струй. 

Прихотливый характер фильтра не позволяет так просто 
запомнить параметры, поэтому в диалоговом окне преду-
смотрена возможность сохранения их в качестве стиля. Для 
этого используется кнопка со знаком плюс. 

 

Фильтр Ветер (Wind) 
 

Фильтр Ветер (Wind) предназначен для имитации струй 
ветра, возникающих, видимо, при перемещении предмета 
или «воздуха». 

В диалоговом окне поля Сила (Strength) и Непрозрач-
ность (Opacity) определяют соответственно длину струй и 
их видимость, а поле Угол (Angle) – их направление. 
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Фильтры группы Noise 
 

Фильтры группы Помехи (Noise) добавляют в изображе-
ние пиксели со случайными цветовыми значениями и тем 
самым как бы смягчают изображение в выделенной области. 
В основном их следует применять для создания своеобраз-
ных декоративных текстур. 

 
Фильтр Добавить шум (Adel Noise) 

 
Фильтр Добавить шум (Add Noise) обеспечивает случай-

ное распределение пикселей в изображении. 
В диалоговом окне предлагаются три способа получения 

шума с помощью следующих переключателей: 
1. Переключатель По Гауссу (Gaussian) – цветовые зна-

чения шума распределяются с использованием нормальной 
кривой распределения, при этом большинство цветов, до-
бавляемых фильтром, совпадают с исходными. 

2. Переключатель Пиковый тип (Spike) – цветовые зна-
чения шума распределяются с использованием узкой кривой 
распределения, напоминающей пик, при этом образуются 
мелкие и светлые элементы. 

3. Переключатель Равномерный тип (Uniform) – цвето-
вые значения шума распределяются с использованием слу-
чайных чисел.  

Поля Уровень (Level) и Плотность (Density) определяют 
общую насыщенность шума. В поле Цветовой режим (Color 
mode) представлены три переключателя, определяющих ха-
рактер цветовых флуктуаций: по интенсивности (переключа-
тель Intensity), случайно (переключатель Random) и с ис-
пользованием цвета (переключатель Single). 

 
Фильтр Диффузия (Diffuse) 

 
Фильтр Диффузия (Diffuse) позволяет слегка перетасо-

вать пикселы с целью уменьшения  резкости. 
В диалоговом окне существует единственное поле Уровень 

(Level), определяющее интенсивность воздействия фильтра. 
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Фильтр Пыль и царапина (Dust & Scratch) 
 

Фильтр Пыль и царапина (Dust & Scratch) предназначен 
для удаления мелких деталей (в том числе и погрешностей) 
с помощью размытия. 

В диалоговом окне поле Радиус (Radius) определяет ра-
диус размытия, а поле Порог (Threshold) – тоновый уро-
вень, выше которого происходит размытие. 
Фильтры Максимум (Maximum) и Минимум (Minimum) 

 
Фильтр Максимум (Maximum) позволяет увеличить 

светлые зоны, а фильтр Минимум (Minimum) – темные зо-
ны изображения. Результат в том и другом случаях напоми-
нает живопись широкой кистью. 

В диалоговых окнах в поле Эффект (Percentage) опреде-
ляется интенсивность фильтра, а в поле Радиус (Radius)  - 
значение зоны расширения (ширина кисти). 

 
Фильтр Медина (Medina) 

 
Фильтр Медина (Medina) заменяет центральный пиксель 

на пиксель со средней яркостью всех пикселов в  пределах 
установленного радиуса и тем самым создает размытие и 
удаляет шум в изображении. 

В диалоговом окне поле Радиус (Radius) определяет ра-
диус размытия в диапазоне от 1 до 20 пикселов. 

 
Фильтр Удалить муар (Remove Moire) 

 
Фильтр Удалить муар (Remove Moire) предназначен для 

борьбы с розетками, возникающими при сканировании 
изображений с полиграфических оттисков. Борьба эта дале-
ко не всегда успешна, даже если предпринимать усилия руч-
ными методами, однако в достижении быстрого эффекта 
данный фильтр может помочь. 

В диалоговом окне поле Эффект (Amount) определяет сте-
пень «борьбы»: чем выше значение, тем больше погрешностей. 
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В поле Качество (Quality) предлагается выбор качества 
(переключатель Better) за счет скорости (переключатель 
Faster) или наоборот. Очень важным для лучшего результата 
является установка оптимального разрешения в поле Вы-
водное значение (Output). Если сканированное изображение 
имеет разрешение 300 dpi, то результирующее (без муара) 
должно иметь разрешение 200 dpi, т.е. составлять две трети 
от исходного. Хотя, безусловно, необходимы эксперименты с 
каждым конкретным изображением. 

 
Фильтр Удалить шум (Remove Noise) 

 
Фильтр Удалить шум (Remove Noise) предназначен для 

борьбы с шумом, а именно с мелкими погрешностями, кото-
рые часто возникают при сканировании изображений или 
оцифровке видеокадров. 

В диалоговом окне флажок Автоматически (Auto) призван 
обеспечить автоматическую настройку фильтра, однако при от-
сутствии видимых улучшений следует перейти на «ручное уп-
равление», состоящее в использовании одного поля Порог (Thre-

shold) для определения уровня яркости, выше которого шум 
удаляется. Меньшие значения обеспечивают больший эффект. 

 
Фильтры группы Sharpness 

 
На конечном этапе цветовой или тоновой коррекции необ-

ходимо выполнить усиление общей резкости изображения. Эта 
процедура часто неизбежна после любых трансформаций изо-
бражений (уменьшения, увеличения, поворота и так далее) и 
практически всегда необходима после сканирования. 

 

Фильтр Адаптивная контурная резкость (Adaptive Unsharp) 
 
Фильтр Адаптивная контурная резкость (Adaptive 

Unsharp) предназначен для усиления контуров. 
В диалоговом окне существует единственное поле Эффект 

(Percentage), определяющее степень действия эффекта. 
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Фильтр Направленная резкость (Directional Sharpen) 
 
Фильтр Направленная резкость (Directional Sharpen) также 

предназначен для усиления контуров, его особенностью явля-
ется изменение контраста только в определенном направле-
нии, что чуть-чуть меньше приводит к зернистости. 

В диалоговом окне – единственное поле Эффект (Per-
centage), определяющее степень действия эффекта. 

 
Фильтр Цветовой контраст (High Pass) 

 
Фильтр Цветовой контраст (High Pass) уменьшает коли-

чество цветовых уровней путем сохранения резких цветовых 
переходов и подавления остальной части рисунка. Это поз-
воляет выявить освещенные области и блики. 

В диалоговом окне поле Радиус (Radius) служит для 
установки ширины границы, которая сохраняется, а поле 
Эффект (Percentage) определяет степень действия эффекта. 

 
Фильтр Резкость (Sharpen) 

 
Фильтр Резкость (Sharpen) предназначен для усиления 

резкости изображения за счет увеличения контраста на гра-
ницах цвета. 

В диалоговом окне поле Уровень граничных контрастов 
(Edge level (%)) определит интенсивность выявления гра-
ничных кон-трастов, а поле Порог (Threshold) - тоновый 
уровень, ниже которого усиление контраста не происходит. 

Флажок Сохранить цвета (Preserve Colors) используется 

для предотвращения значительного изменения цветовых ха-
рактеристик. 

 
8. Импортирование и экспортирование изображений 
 
При импортировании или экспортировании обязательно 

необходимо наличие соответствующего конвертера – моду-
ля, который преобразует информацию, сохраненную в одном 



142 

формате, в информацию, "понятную" для данной програм-
мы. При использовании технологии OLE беспокоиться о 
конвертерах нет необходимости. С другой стороны, техноло-
гия вносит некоторые ограничения по работе с объектами, 
например, они не могут быть клонированы, к ним нельзя 
применить эффекты (в исключение попадает обтравочный 
клип (Power-Clip)), их нельзя комбинировать и выполнять 
некоторые другие операции. 

 
Буфер обмена Clipboard 

 
Простейшим средством обмена информацией является 

буфер обмена Clipboard, который может выполнять некото-
рые простейшие задачи: переносить тексты и графические 
элементы из программы CorelDRAW в практически все тек-
стовые редакторы и программы верстки (и наоборот), если 
последние поддерживают технологию OLE. 

В меню Редактировать (Edit) и на стандартной инстру-
ментальной полосе представлены традиционные команды: 
Копировать (Сору), Вырезать (Cat), Вставить (Paste). 

 
Технология "drag-and-drop" 

 
Технология "drag-and-drop" (дословно "перенести и бро-

сить") позволяет вручную переносить информацию из одной 
программы в другую в следующих случаях. 

• Если векторный объект переносится из одного доку-
мента программы CorelDRAW в другой (при нажатой левой 
кнопке мыши). 

• Если векторный объект переносится на поверхность 
рабочего стола операционной среды, откуда он может быть 
также "отбуксирован" в другую программу, например при 

обмене графической информацией между программами 
CorelDRAW и Corel PHOTO-PAINT. 
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Команды Открыть (Open) и Импортировать (Import) 
 
Команда Открыть (Open...) в меню Файл (File) открыва-

ет документы, созданные другими программами, в основном 
это касается векторных форматов файлов, например стан-
дартного формата EPS, широко используемого в компью-
терной полиграфии. 

После выполнений команды на экран выводится диало-
говое окно Открыть рисунок (Open Drawing), в котором 
предоставляется возможность "навигации" по иерархии фай-
ловой структуры для поиска нужного файла в соответству-
ющей папке (рисунок 125).  

Здесь всегда присутствует окно просмотра, которое при 
установке флажка Просмотр (Preview) обеспечит отображе-
ние сохраненной с документом уменьшенной копии страни-
цы (небольшого точечного изображения). При невозможно-
сти чтения или отсутствия изображения окно просмотра пе-
речеркнуто большим крестом. 

Под полем просмотра расположены информационные 
строки, отображающие данные о выделенном в списке фай-
ле, а именно: 

- строка Версия документа (File Version) отображает но-
мер версии программы, в формате которой сохранен доку-
мент; 

- строка Степень сжатия (Compression ratio) указывает 
процент сжатия выделенного файла (хотя векторный формат 
и сам по себе экономен в размере, тем не менее программа 
обеспечивает автоматическое сжатие); 

- строка Сохранен (Last saved by) указывает данные о 
версии программы (платформе) и даже ее релиз (например, 
build 337). 

В поле Ключевые слова (Keywords) и Примечания 
(Notes) отображается информация, которая может помочь 
самому пользователю или третьему лицу отыскать нужный 
файл. Разумеется, если данная информация была введена 
при сохранении файла. 
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Флажок Сохранить слои и страницы (Maintain layers and 
pages) обеспечивает попытку конвертирования данных о 
слоях и страницах при открытии документа в формате, от-
личном от CDR. 

Команда Импортировать (Import...) в меню Файл (File) 
служит для импортирования документа в открытый актив-
ный документ программы CorelDRAW, и делается это дву-
мя способами: 

 

 
 

Рисунок 125 
 

- с установлением связи с исходным документом (в этом 
случае изображение в документ программы CorelDRAW не 
включается, а подгружается при открытии документа); 

- без установления такой связи (в этом случае изображе-
ние внедряется в документ программы CorelDRAW и уве-
личивает размер файла). 

Диалоговое окно Импортировать (Import) отличается от 
диалогового окна Открыть рисунок (Open Drawing) не толь-
ко в несколько раз большим списком допустимых форматов, 
но и в части дополнительных функций (рисунок  126). 

В строке Размер изображения (Image size) при импорти-
ровании точечной графики указываются размерность в пик-
селях и глубина цвета в битах. 

В строке ниже приводится формат файла, а также его 
особенности, например, использование технологии сжатия и 
некоторые другие. Если формат файла допускает сохранение 
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примечаний, то его текст будет выведен в поле Примечания 
(Notes). 

Флажок Связать с файлом высокого разрешения для вы-
вода по технологии OPI (Link to high resolution file for 
output using OPI) в самом низу для ускорения работы про-
граммы позволяет использовать в документе версию файла с 
низким разрешением, а при окончательном выводе докумен-
та на устройства с высоким разрешением - "подменить" его 
на изображение с соответствующим разрешением. 

 

 
 

Рисунок 126 
 
Флажок Проверить "водяной знак" (Check for Watermark) 

обеспечит запуск модуля, который проведет поиск тайных 
сведений об изображении. 

Флажок Свести многослойные точечные изображения 
(Combine multi-layer bitmap) позволяет конвертировать 
многослойное изображение, например, из Формата програм-
мы Adobe Photoshop (PSD) или формата программы Corel 
PHOTO-PAINT (СРТ), в "обычное" - однослойное, а флажок 
Сохранить слои и страницы (Maintain layers and pages), 
наоборот, позволяет сохранить распределение векторных 
объектов по слоям и по страницам. 

Флажки Применить размещенный профиль ICO (Apply 
embedded ICC profile) и Извлечь размещенный профиль 
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ICC (Extract embedded ICC profile), которые характерны и 
для диалогового окна Открыть рисунок (Open Drawing), 

позволяют применить к данному документу размещённый в 
импортируемом файле цветовой профиль или извлечь его и 
сохранить в отдельном файле формата Image Color Matching 
(ICM). Программа поддерживает размещение цветовых про-
филей в следующих графических форматах: CRT, CDR, 
JPEG, PICT и EPS. 

Для размещения изображения в некоторых форматах 
требуются дополнительные сведения (например, форматы 
PS, PRN или PCD). В таком случае на экран выводятся до-
полнительные диалоговые окна. Если для импортирования 
достаточны установки по умолчанию, то следует установить 
флажок Не выводить диалоговое окно фильтра (Suppress 
filter dialog), и импортирование будет выполнено с текущи-
ми установками. 

В программе CorelDRAW для размещения импортиро-
ванного изображения после выполнения команды на экран 
выводится особый курсор, с помощью которого можно раз-
местить изображение в любом месте документа, щёлкнув им 
в точке размещения (уголок курсора соответствует левому 
верхнему углу изображения). Следует иметь в виду, при 
этом возможно пропорциональное масштабирование, если 
этим же курсором "очертить" область. При нажатой клавише 
<Alt> допускается непропорциональное масштабирование. 

Если требуется точное управление масштабированием или 
кадрированием, то следует воспользоваться списком, располо-
женным в диалоговом окне Импортировать (Import) правее и 
ниже строки с именем файла. В списке три варианта: 

- Вариант Полное изображение (Full Image) принят по 
умолчанию, изображение импортируется без всяких изменений. 

- Вариант Изменение параметров изображения (Resamp-
le) – на экран выводится диалоговое окно, в котором можно 
изменить размерность и разрешение импортируемого изоб-
ражения (в нижней части диалогового окна отображаются 
размеры в байтах исходного и измененного изображений). 
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- Вариант Кадрирование изображения (Crop) – на экран 
выводится Диалоговое окно, в котором вручную или изменяя 
значения в соответствующих полях Сверху (Тор), Слева (Left), 

Ширина (Width), Высота (Height), можно ограничить 
площадь импортируемого изображения (рисунок 127). 

Флажок Связь с внешним изображением (Link bitmap 
externally) диалогового окна Импортирование (Import) обес-
печивает особый режим импортирования – связанное изоб-
ражение (linked image). 

Помимо импортирования изображений с размещением их 
в документе и соответствующего увеличения объема файла 
существует возможность импортирования изображений без 
размещения, а только с указанием ссылки на них. Изобра-
жения, на которые имеется ссылка, называются связанными 
(linked images). 

Использование связанных изображений имеет свои по-
ложительные и отрицательные стороны. 

К положительным относятся: уменьшение размера фай-
ла, возможность независимой и параллельной обработки без 
обращения к документу CorelDRAW, а также в случае мно-
жественного использования изображения в различных доку-
ментах достаточно внести один раз изменения с тем, чтобы 
они автоматически отразились во всех документах. 

 

 
 

Рисунок 127 
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Связанные изображения 
 
Из отрицательных факторов можно упомянуть неукосни-

тельное соблюдение соответствия ссылки и реального рас-
положения изображения. 

Для работы со связанными изображениями предусмотре-
на специальная панель типа Docker, которая называется 
Диспетчер связей (Link Manager) и отображает список всех 
связанных точечных изображений (рисунок 128). 

 

 
 

Рисунок 128 
 

Каждая строка списка содержит информацию о связан-
ном изображении, статус изображения, уменьшенное изоб-
ражение, имя и адрес файла, а также страницу, на которой 
расположено изображение. 

В нижней части панели последовательно расположены 
три кнопки: 

– Первая кнопка слева позволяет удалить связь с выделен-
ным изображением и разместить его в документе, в результа-
те этого строка данного изображения удаляется из панели. 

– Вторая кнопка предназначена для обновления статуса 
всех «устарелых» изображений. 

– Третья кнопка служит для загрузки приложения, в ко-
тором можно отредактировать выделенное изображение. 

Следует обратить внимание на то, что приложение, ко-
торое призвано обрабатывать данное изображение, опреде-
ляется программой CorelDRAW, исходя из данных операци-
онной системы в соответствии расширения файла, и про-
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граммой, которая с ним «ассоциируется». Вследствие этого 
на экран может быть вызван не графичеcкий редактор, а 
программа-просмотрщик (например, ACDSee) или програм-
ма-браузер (например, MI Explorer). 

Кнопка в правом нижнем углу предназначена для ручно-
го обновления списка, при этом, если изображение оказа-
лось удаленным из папки, указанной в ссылке, в поле стату-
са отображается красный крест. Для восстановления связи 

необходимо установить указатель на строке и щелкнуть 
правой кнопкой мыши, затем из контекстного меню выбрать 
команду Восстановить разорванную связь (Fix Broken Link), 
которая позволит вывести на экран диалоговое окно Опре-
делить местоположение точечного изображения (Locate 
External Bitmap). Если изображение не окончательно удале-
но, то можно изменить его адрес. 

 
Экспортирование изображений 

 
Для экспорта изображений в другой доступный формат 

требуется выполнить команду Экспортировать (Export...) в 
меню Файл (File), которая выводит на экран одноименное 
диалоговое окно (рисунок 129). 

Флажок Только выделенные объекты (Selected only) поз-
воляет экспортировать в другой формат не весь документ, а 
только выделенные объекты. 

Список Сортировка типов файлов (Sort type) позволяет 
изменить порядок отображения списка Типы файлов (Files 
of type): 

По умолчанию (Default), По расширению (Extension), По 
описанию (Description), В порядке использования (Most 
Resently Used), Сначала векторные (Vector), Сначала точеч-
ные (Bitmap), Сначала текстовые (Text), Сначала анимиро-
ванные (Animation). 

Флажок Без пробелов и специальных символов (No white 
spaces, special characters) обеспечивает замену в имени фай-
ла пробелов - на символ подчеркивания, а специальных 
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символов на соответствующие символы, принятые в файлах 
для Web- страниц. 

 

 
 

Рисунок 129 
 

В списке форматов файлов выбирают один из многих дос-
тупных форматов и после щелчка на кнопке Экспортировать 
(Export) на экран выводится специальное диалоговое окно, в 
котором следует определить уточняющие данные для конверти-
рования векторного изображения формата CDR в иной формат. 

 
9. Работа с точечными изображениями, конвертирование 

 
Программа CorelDRAW - яркий представитель программ 

векторной графики, она воплощает практически все дости-
жения в этой области. Одно из достоинств векторной графи-
ки - возможность интегрирования в векторный документ 
точечных изображений. 

Изменение параметров точечного изображения 
Основными параметрами точечного изображения явля-

ются геометрический размер и разрешение. Для их измене-
ния в пределах программы CorelDRAW используется ко-
манда Изменение параметров изображения (Resample...) в 
меню Точечные изображения (Bitmaps), которая выводит на 
экран диалоговое окно (рисунок 130). 

В поле Размер изображения (Image size) указываются те-
кущие значения по ширине (поле Width) и по высоте (поле 
Height). 
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В соседних полях можно установить иные значения в од-
ной из единиц измерения, которая выбирается в списке, а 
также в процентном соотношении. 

В поле Разрешение (Resolution) указываются текущие зна-
чения разрешения по горизонтали (поле Horizontal) и по вер-
тикали (поле Vertical). В соседних полях можно установить 
требуемые значения, которые будут одинаковы при установ-
ленном флажке Идентичные значения (Identical values) или 
могут быть разными, если флажок не установлен. 

 

 
 

Рисунок 130 
 

В нижней части диалогового окна отображаются размеры 
файла до (строка Original image size) и после (строка New 
image size) изменения параметров. Флажок Сглаживание 
(Anti-alias) обеспечивает некоторое размытие на резких гра-
ницах и тем самым уменьшает «зубчатость» изображения 
при низком разрешении. 

Конвертирование векторного изображения в точечное 
Программа CorelDRAW позволяет выполнить растериза-

цию векторного изображения и получить точечное изобра-
жение с заданными параметрами. 

Для этого необходимо выделить соответствующие объ-
екты и выполнить команду Конвертировать в точечное 
изображение (Convert to Bitmap...) в меню Точечные изоб-
ражения (Bitmaps). На экран выводится одноименное диало-
говое окно, в котором следует определить параметры, без 
которых точечное изображение невозможно, - разрешение и 
глубина цвета (рисунок 131). 
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В поле Разрешение (Resolution) можно выбрать из списка 
типовые значения разрешения (72, 96, 150, 200 и 300 dpi) или 
ввести свои собственные в диапазоне от 60 до 10000 dpi. 

В списке поля Цвет (Color) представлены шесть вариан-
тов цветовых моделей и режимов: Черно-белый штрих (1-
bit) (Black and White), 16 цветов (4-bit) (Colors 16), Града-
ции серого (8-bit) (Grayscale), Индексированный цвет (8-bit) 
(Paletted), Цвет модели RGB (24 bit) (RGB Color), Цвет мо-
дели CMYK (32-bit) (CMYK Color). 

Флажок Имитация (Dithered) устанавливается для того, 

чтобы при конвертировании более широкой цветовой гаммы 
в менее широкую недостающие цвета имитировались соче-
танием имеющихся. 

 

 
 

Рисунок 131 
 

Флажок Прозрачный фон (Transparent Background) обес-
печивает маскирование тех областей, которые не заняты 
объектами. 

Флажок Использовать цветовой профиль (Use Color 
Profile) обеспечивает при конвертировании учёт параметров 

цветового профиля активного в данный момент внешнего 
устройства, например цветного принтера. 

Флажок Сглаживание (Anti-aliasing) устанавливается, ес-
ли требуется смягчение резких границ в изображении. 

Конвертирование точечных изображений в другие 
цветовые модели 

Имеющиеся точечные изображения могут быть конвер-
тированы в другие цветовые модели или режимы, а именно: 

- в черно-белое штриховое изображение; 
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- в изображение в градациях серого; 
- в дуплексное изображение; 
– полноцветное изображение в моделях RGB, CMYK 

или LAB; 
– изображение в индексированных цветах (paletted). 
Следует иметь в виду, что любое конвертирование свя-

зано с потерями, особенно при конвертировании в цветовое 
пространство с меньшим охватом, например цветовой моде-
ли RGB в цветовую модель CMYK. При этом обратное кон-
вертирование потери не восстанавливает. 

 Конвертирование в черно-белое штриховое изобра-
жение 

 Команда Черно-белый штрих (1 bit) (Black and White) в 
меню Точечные изображения/Конвертировать в (Bitmaps, 
Convert То) выводит на экран диалоговое окно Конвертиро-
вать в 1-битовое изображение (Convert to 1 Bit) (рисунок 132). 

При выборе в списке Тип конвертирования (Conversion) 
определенных вариантов меняется вид поля параметров. 

- Вариант Штриховое изображение (Line Art) дает воз-
можность установить пороговое значение, определяющее, 
какие тоновые уровни и цветовые оттенки переходят в чер-
ный, а какие - в белый цвет. 

 

 
 

Рисунок 132 
 
- Варианты Имитация со случайным разбросом (Error 

Diffusion). Имитация с помощью образцов (Ordered), Jarvis, 
Stucki, Floyd-Steinberg, Cardinality-Distribution предлагает 
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различные способы имитации тоновых уровней. В этих слу-
чаях в качестве параметра выступает поле Интенсивность 
(Intensity), которое определяет уровень случайности. 

- Вариант Halftone (Растровое изображение) обеспечива-
ет получение изображения, напоминающего полиграфиче-
ский растр для черной краски. В этом случае устанавлива-
ются типичные для растрирования параметры. 

Конвертирование в изображение в градациях серого 
Любое точечное изображение может быть представлено 

в градациях серого. Для этого необходимо выделить изоб-
ражение и выполнить команду: Градации серого (8-bit) 
(Grayscale) в меню Точечные изображения/Конвертировать 
в (Bitmaps/Convert То). 

Этот процесс не требует никаких дополнительных уста-
новок. В результате образуется точечное изображение, каж-
дый пиксель которого описывается восемью битами, а сле-
довательно, может иметь 256 градаций: значение 0 означает 
черный, а значение 255 - белый цвет. 

Конвертирование в дуплексные изображения 
Дуплексное изображение (duotone) - особый способ печа-

ти монохромного тонового изображения двумя (тремя, че-
тырьмя) красками, из которых основной является черная 
краска, а остальные краски - светлые (серая, светло-корич-
невая, голубая или зеленая). Этот способ печати традицион-
но применялся для расширения тонового диапазона и ком-
пенсации недостаточного количества тонов при использова-
нии одного цвета. 

Для создания дуплексного изображения необходимо вы-
полнить команду Дуплекс (8-bit) (Duotone) в меню Точеч-
ные изображения/Конвертировать в (Bitmaps/Convert То). 
На экран выводится одноименное диалоговое окно. 

Конвертирование в цветовые модели RGB, CMYK и Lab 
Точечные изображения могут быть конвертированы в 

цветовые модели RGB, Lab и CMYK, наиболее используе-
мые в компьютерных технологиях, связанных с графикой на 
экране и полиграфическим репродуцированием. 
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Для конвертирования выделенного объекта необходимо 
выполнить соответствующую команду Цвет модели RGB 
(RGB Color) (24-bit), Цвет модели Lab (Lab Color) (24-bit)  
или Цвет модели CMYK (CMYK Color) (32-bit) в меню То-
чечные изображения/Конвертировать в (Bitmaps/Convert То). 

Следует иметь в виду, что конвертирование в цветовую 
модель CMYK имеет некоторые особенности, связанные с 
тем, что она является аппаратно-зависимой. При конвертиро-
вании одного и того же изображения, но для разных внешних 
устройств, программа получит различающиеся результаты. 

Конвертирование в изображение с индексированны-
ми цветами 

Изображение в индексированных цветах представляет 
собой одноканальное 8-битное изображение с 256 предуста-
новленными цветами. Такие изображения используются, ес-
ли в цветном изображении важнее небольшой размер файла, 
чем обилие цветовых нюансов. Ранее такие изображения 

находили применение в связи с ограничениями видеоадап-
теров, потом их актуальность постепенно уменьшалась, а в 

настоящее время они испытывают новую волну востребо-
ванности в связи с развитием Internet. 

В результате выполнения команды Индексированный (8-
bit) (Paletted) в меню Точечное изображение/Режим 
(Bitmap/Mode) на экран выводится диалоговое окно Кон-
вертировать в индексированные цвета (Convert to Paletted). 

 

10. Работа с многостраничными документами 
 
Программа CorelDRAW не относится к классу программ 

верстки, где имеется полный набор средств для работы с 
многостраничными документами, однако и у нее существует 
возможность обработки документов, состоящих из множе-
ства страниц (допускается установка до 999 страниц). Отсут-
ствие многих функций, облегчающих работу верстальщика, 
ограничивает реальный объем документа несколькими стра-
ницами, впрочем, номенклатура и таких документов безгра-
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нична — это рекламные буклеты, краткая документация, 
наборы прайс-листов, тонкие брошюры и многое другое. 

Установка параметров страницы 
Основной командой для установки параметров страницы 

является команда Параметры страницы (Page Setup...) в ме-
ню Компоновка (Layout), в результате выполнения которой 
на экран выводится раздел Формат (Size) диалогового окна 
Параметры (Optionbs) (рисунок 133). 

В верхней части диалогового окна расположены переклю-
чатели для выбора типа страницы - Традиционные форматы 
(Normal Paper) и Этикетки (Labels). В списке Paper (Формат 
бумаги) представлен обширный список форматов, которые су-
ществуют в мировой практике. Если все-таки ни один формат 
не подходит, то, используя поля Ширина (Width) и Высота 
(Height), можно установить требуемые параметры. 

В списке рядом выбирается необходимая единица изме-
рения. Кнопка Сохранить параметры формата страницы 
(Save Custom Page) служит для сохранения задаваемых фор-
матов страницы. 

В поле Разрешение (Resolution) выбирается вариант из 
списка или вводится произвольное значение разрешения. 

 

 
 

Рисунок 133 
 

Кнопка Использовать параметры принтера (Set From 
Printer) обеспечивает перенос параметров страницы и раз-
решения, которые установлены у текущего принтера. 
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В разделе Компоновка (Layout), который вызывается по-
средством выбора одноименной строки в левой части диало-
гового окна Параметры (Options), предоставляется несколь-
ко вариантов раскладки страниц документа, шесть вариан-
тов макетов (каждый вариант наглядно иллюстрируется 
схемами в окне просмотра), что собственно может суще-
ственно повлиять на макет документа. 

Флажок Разворот (Facing pages) служит для отображения 
на экране двух соседних страниц (разворота), которые 
обычно читатель воспринимает одним взглядом. 

Список из двух пунктов Начать с (Start on) становится 
доступным при установке флажка Разворот (Facing pages) и 
позволяет указать, с какой страницы (левой (Left Side) или 
правой (Right Side)) начинается разворот. 

Раздел Фон (Background) диалогового окна Параметры 
(Options) предназначен для определения общего фона для 
всей страницы. 

Этот фон может представлять собой сплошную заливку 
или любое точечное изображение. Для выбора одного из 
этих вариантов предназначены переключатели – Сплошная 
заливка (Solid) и Точечное изображение (Bitmap). 

Добавление страниц 
По умолчанию в любом документе изначально использу-

ется одна страница. Для добавления новых страниц предна-
значены две кнопки со знаками плюс, нажатие на первую из 
них позволит добавить одну страницу перед текущей, а на 
вторую – после текущей страницы. Также добавить одну 
или несколько страниц можно с помощью команды Добавить 
страницу (Insert Page...) в меню Компоновка (Layout), кото-
рая выводит на экран одноименное диалоговое окно. 

В поле Добавить ... страниц (Insert pages) можно устано-
вить значение в диапазоне от 1 до 998. В нижней части рабо-
чего окна документа появляются Вкладки с номерами страниц, 
позволяющие открывать нужную страницу (рисунок 134). 

Переключатели До (Before) и После (After) служат для 
выбора положения вводимых страниц, соответственно до 
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или после страницы, номер которой вводится в поле Стра-
ница (Page). 

Переход с одной страницы на другую осуществляется с 
помощью блока управления страницами или с помощью ко-
манды Перейти к странице (Go to Page...) в меню Компо-
новка (Layout), открывающей одноименное диалоговое ок-
но, в котором можно указать конкретный номер страницы. 

 

 
 

Рисунок 134 
 

Удаление страниц 
Ненужные страницы, разумеется, можно удалять. Для 

этого предназначена команда Удалить страницу (Delete 
Page...) в меню Компоновка (Layout), которая выводит на 
экран одноименное диалоговое окно. 

В поле Удалить страницу (Delete page) указывается но-
мер страницы, которая подлежит удалению. При установке 
флажка в поле По страницу ... включительно (Through to 
page ... Inclusive) вводится номер последней страницы, ко-
торая должна быть удалена. 

Присвоение имени странице 
Номера страниц, которые используются в программе 

CorelDRAW, носят достаточно условный характер, процеду-
ру их присвоения нельзя ставить в соответствие механизму 
присвоения страниц, который принят в текстовых редакто-
рах и в программах верстки. Подчеркивает это качество воз-
можность присвоения имени странице, что позволяет поль-
зователю лучше ориентироваться в содержании страниц до-
кумента. 
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Для присвоения имени предназначена команда Переиме-
новать страницу (Rename Page...) в меню Компоновка 
(Layout), которая открывает одноименное диалоговое окно. 

Имя, введенное в этом диалоговом окне, отображается 
на вкладке соответствующей страницы. 

Параметры страницы на инструментальной панели 
Property Ваг 

При отсутствии выделенных объектов инструментальная 
панель Свойства (Property Ваг) отображает текущие пара-
метры страницы и позволяет их изменить (рисунок 135). 

 

 
 

Рисунок 135 
 
В первом списке слева можно выбрать формат страницы, 

далее расположены поле для произвольной установки раз-
мера страницы, две кнопки, позволяющие выбрать ориента-
цию страницы, и, наконец, две кнопки (одна над другой), из 
которых верхняя служит для изменения параметров всех 
страниц, а нижняя - только текущей. 

Последнее свойство означает, что в данной версии про-
граммы CorelDRAW документ может состоять из страниц 
различных размеров и различной ориентации. 
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РАЗДЕЛ II. MACROMEDIA FLASH 
 

1. Web-дизайн, понятие Web - сайта и основы 
построения сайтов 

 
Сегодня, путешествуя по Internet, можно найти много очень 

хорошо выполненных сайтов, которые быстро загружаются, 
привлекательны на вид, имеют четко разграниченную по раз-
делам информацию и удобные функции навигации. Такие сай-
ты просто приглашают Вас посетить их, расслабиться, задер-
жаться на некоторое время, развлечься и узнать что-то новое. 

Если Вы задерживаетесь на каком-либо сайте на длитель-
ное время и даже не осознаете этого, то, по всей видимости, 
такой сайт очень хорошо продуман. Вернитесь обратно и по-
пробуйте осмыслить полную картину. Можете ли Вы увидеть 
структуру, организацию? Легко ли воспринимается информа-
ция? Понимание движения информационных потоков – это 
первый шаг в создании функционального, удобного в работе 
сайта. Если Вы поймете, как работает эта концепция, и при-
мените ее при создании собственного сайта, то уже тем самым 
опередите большинство других разработчиков. 

Планирование информационного потока 
Многие Web-мастера не тратят время на то, чтобы про-

думать информационный поток, а ограничиваются только 
размещением текста и изображений на странице. Хотя на 
многих сайтах Вы можете встретить хвастливые уверения, 
что у них гораздо больше посетителей, чем у конкурентов, 
однако это не самый лучший индикатор качества исполне-
ния. Лучшим показателем является время: если пользовате-
ли остаются на Вашем сайте достаточно долго для того, 
чтобы пройти по разным его уровням и разделам, то Вы 
вправе быть уверенными в хорошо выполненной работе. Это 
означает, что они могут найти то, что им нужно, осмотреть 
остальное и без особого труда вернуться обратно. 

Чтобы сделать свой сайт эффективным, Вы должны ви-
зуализировать поток информации и выбираемые пользова-
телем пути. 
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Другими словами, Вы должны видеть свой сайт с точки 
зрения пользователя. Процесс планирования может потребо-
вать больших затрат труда, однако если он доставляет вам 
удовольствие, то вполне вероятно, что Ваш сайт будет пре-
восходен. 

С таким инструментом в руках, как Frontpage, Вы имеете 
все возможности для создания самого посещаемого сайта. 
Как будет выглядеть Ваш сайт и какую информацию Вы на 
нем разместите, во многом зависит от Вашей потенциальной 
аудитории. В этой главе мы обсудим сайты, предназначен-
ные как для Internet, так и для Intranet. 

Как построить хороший сайт 
Самые лучшие Web-сайты – это те, которые привлека-

тельно выглядят, ёмко выражают основную идею и не за-
ставляют пользователей ждать получения информации на их 
экранах слишком долго. Вот несколько советов по созданию 
успешного сайта. 

Четко сформулируйте назначение Вашего сайта. Каковы 
ваши цели? Только присутствие в Internet? Если так, то не 
удивляйтесь, что Ваш сайт, как и многие другие, постигнет 
участь большинства. Старайтесь формулировать Ваши цели 
настолько четко, насколько это возможно. Возможно, Вы хо-
тите, чтобы сайт представлял продукцию Вашей компании. 
Это хорошо, но Вы должны задуматься о том, как Вы собирае-
тесь представлять эти продукты. Как Вы хотите позициониро-
вать Ваши продукты на сетевом рынке? Глубокое выяснение 
этих вопросов поможет Вам четко сформулировать цель. Без 
четко определенной цели Ваше детище будет обречено на за-
бвение где-то на задворках Всемирной Паутины. 

Обязательно думайте о своей аудитории. Кто будет ос-
новной (и вторичной) аудиторией Вашего сайта? Какого они 
возраста? Чем они занимаются? Сколько времени они про-
водят на Вашем сайте? В отношении каждой порции инфор-
мации, каждой картинки и каждой детали спросите себя, 
как отреагирует на это Ваша аудитория. 

Используйте быстро загружаемые элементы. Причина 
номер один, почему люди быстро уходят с сайта (или не по-
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сещают его вовсе) - слишком долгая загрузка информации. 
Большой объем графических файлов вызывает желание как-
то повлиять на ход событий, и самое простое - это нажать 
на кнопку Stop, остановив загрузку. 

Сделайте Ваш сайт визуально привлекательным. Вы, 
несомненно, видели в Internet немало скучных сайтов. Что 
же делает их неинтересными? Возможно, недостаток цвета и 
разнообразия текста, заголовков. Вы, вероятно, видели так-
же беспорядочные и эклектичные сайты, в которых исполь-
зуется слишком много шрифтов разных размеров или слиш-
ком много цветов. Создавая свой собственный сайт, помни-
те, что продуманное форматирование страниц приблизит 
Вас еще на один шаг к заветной цели. 

Не пытайтесь разместить все на одной странице. Будьте 
внимательны, не перегружайте свои страницы слишком 
большим количеством информации. Все мы знаем, что писа-
тели любят писать, а дизайнеры-графики - рисовать эф-
фектные картинки. Ваша задача как разработчика сайта – 
создать тонкую гармонию между этими двумя различными 
группами людей. Постарайтесь установить равновесие между 
текстовой и изобразительной информацией. Думайте о тех, 
кто будет читать Ваши страницы; думайте о том, как трудно 

воспринимается большое количество текста на экране ком-
пьютера, и наполняйте Ваши страницы содержимым в соот-
ветствии с этим. Попробуйте добавить пустое пространство, 
увеличивая поля страницы, или использовать табличное 
размещение текста. Размещая на страницах графику, имейте 
в виду ее реальное значение: служит ли она основной цели, 
или работает только как украшение? Но при этом не забы-
вайте, что иногда красивая графика сама по себе может 
быть целью. В идеале каждый Web-сайт должен хорошо вы-
глядеть, содержать полезную информацию и быть удобным 
для просмотра. 

Разумно организуйте содержимое. Возможно, Вам знако-
мо утверждение, что содержание первично, а форма вторич-
на? И это правда, но форма подачи содержания тоже важна. 
Сколько раз при посещении очередного сайта Вы говорили 
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себе: "Здесь нет ничего интересного"? Возможно, где-то глу-
боко внутри и захоронено что-то ценное, но откопать это 
что-то можно, лишь случайно на него натолкнувшись. Если 
у Вас есть информация, которую, как Вы считаете, ваши по-
сетители должны увидеть, не прячьте ее вглубь сайта. Сде-
лайте важную информацию настолько легко доступной, 
насколько это возможно. Не забывайте, что Ваш сайт будет 
иметь, по всей видимости, не один уровень вложенности. 

Вторичный материал упорядочивайте по группам взаимосвя-
занной информации. Предположим, что Вы создаете интер-
активный каталог музыкального магазина. Вы бы поместили 
в один список и джазовые компакт-диски, и записи рок-
групп? Разумеется, нет. Это, конечно, очень простой при-
мер, его смысл в том, что, рассматривая всю Вашу инфор-
мацию в терминах соответствующих категорий, Вы намного 
лучше сможете организовать свой сайт. 

Предусмотрите на сайте кнопки навигации. Большинство 
разработчиков используют кнопки, адресующие к различ-
ным разделам сайта. Эти кнопки, как правило, присутствуют 

на всех страницах сайта и обычно расположены плотной 
группой в одном и том же месте страницы. Единообразие и 
компактность их расположения существенно упрощают про-
смотр сайта. Пользователю достаточно просто нажать кноп-
ку, чтобы перейти в другой раздел сайта. 

Ниже перечислены некоторые рекомендации, касающие-
ся планирования кнопок навигации: 

- Обязательно должна быть кнопка, с помощью которой 
пользователи могли бы вернуться обратно к начальной 
странице. Если Ваш пользователь забрался на пять уровней 
вглубь, то надо предоставить ему возможность одним нажа-
тием кнопки вернуться на первую страницу. А если он увяз-
нет, нажимая кнопку Back в своем браузере, то, скорее все-
го, он очень быстро уйдет с Вашего сайта и больше никогда 
не вернется. Другими словами, не полагайтесь на навигаци-
онные способности браузера пользователя, обязательно до-
бавьте эти возможности на свой сайт. 
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- Будьте готовы к тому, что у некоторых посетителей 
Вашего сайта отключен просмотр графики в браузере. Очень 

полезно наряду с графическими кнопками навигации иметь 
и их текстовую версию. Тем самым для просмотра Вашего 

сайта пользователь сможет выбрать удобный для него вари-
ант. Не сомневайтесь: пройдет еще немало времени, пока на 
Web-страницах останутся только графические кнопки. 

Итак, постарайтесь максимально упростить перемещение 
по Вашему сайту. Разрабатывая сайт, спросите себя, между 
какими точками следует навести мосты. От ответа на этот 
вопрос во многом будет зависеть, насколько легким и увле-
кательным будет путешествие по сайту. 

Воспользуйтесь картой навигации Проводника Frontpage. 
Карта навигации (Navigation view) может оказаться особенно 
полезной, когда у Вас возникнут трудности с представлени-
ем информации. Начните работу с главной страницы и иди-
те вглубь. Это визуальное представление поможет "увидеть" 
содержимое Вашего сайта, более ясно организовать его и 
избежать глобальных изменений при модификации сайта. 
Вы более четко сможете представить себе структуру сайта и, 
возможно, у Вас появятся новые идеи по его улучшению. 

Тщательно протестируйте свой сайт. Существует целый 
ряд различных браузеров, и в каждом из них Ваш сайт может 
выглядеть по-разному. Проверьте работу Вашего сайта, ис-
пользуя как можно больше различных браузеров, при этом на 
различных платформах (как минимум, Windows 95, Windows 
NT, UNIX и Macintosh) и при различных скоростях модема. 
Нередко кнопка навигации, помещенная в угол страницы, в 
каком-нибудь браузере оказывается посреди окна; такие вещи 
случаются сплошь и рядом. Опытные Web-дизайнеры прове-
ряют в своих сайтах каждую страницу и каждую ссылку в не-
скольких различных браузерах. Все связи внутри сайта Вы 
сможете легко проверить с помощью команды Verify 
Hyperlinks (Проверить гиперссылки) или протокола состояния 
гиперссылок (Hyperlink Status View) Проводника. 

Другой хороший способ проверки Вашего сайта - это 
операция Preview In Browser (Предварительный просмотр в 
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браузере) в Редакторе. Она позволит Вам визуально иссле-
довать страницу в любом браузере, установленном на Вашем 
компьютере и при различных размерах окна. Например, если 
Вы обычно работаете в разрешении 1024x768, то Вы сможе-
те воочию посмотреть, как страница будет выглядеть в раз-
решении 640x480. 

Если Вы хорошо относитесь к своей аудитории, то 
предоставьте посетителям возможность легко находить ин-
формацию на Вашем сайте. С помощью Frontpage Search 
Component (Поискового Компонента Frontpage) Вы сможете 
оснастить свой сайт полным механизмом поиска. 

Планирование сайта Intranet 
Разработка сайта Intranet Вашей организации – задача 

не менее сложная. Вы должны учитывать практически все те 
же моменты, что и при разработке сайта Internet, за не-
сколькими исключениями. Так как обычно Вы точно знаете, 
на какую аудиторию ориентирован сайт Intranet, то Вы мо-
жете позволить себе быть более конкретным и целенаправ-
ленным. Вам желательно точно выяснить, какие типы ком-
пьютеров стоят в сети, насколько быстро они работают, ка-
кие типы браузеров в основном используются, как они под-
ключены к Вашему сайту (через модем или через прямое 
подключение). Знание этих деталей может значительно по-
мочь при разработке Web-сайта. Как и при разработке сайта 
Всемирной Паутины, ключ к успеху лежит в тщательном 
первоначальном планировании. 

Если Ваша компания велика, то и сайт может быть 
немал, а за обслуживание различных его разделов может от-
вечать много сотрудников. Frontpage значительно упрощает 
управление сетями Intranet. 

Нужна ли Вашей организации сеть Intranet? До сих пор 
многие компании для распространения служебной информа-
ции (приказов, новостей, списков телефонов) используют 
старомодный печатный метод. Нередко затем эта информа-
ция в печатном виде рассылается в различные географиче-
ские регионы. При каждом изменении возникает необходи-
мость в перепечатке и повторной рассылке. Обновление и 
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распространение информации подобным образом не только 
обходится для компаний в немалую сумму, но и приводит к 
расходу природных ресурсов. 

Напротив, если у Вас есть сайт Intranet, то можно легко 

и быстро обновить информацию и довести ее до сведения 
всех (или тех, кто имеет соответствующие права доступа). 
Разные подразделения компании могут самостоятельно от-
вечать за обслуживание и обновление своих разделов сайта. 
Так что обычно этот процесс проходит просто и безболез-
ненно. 

Проблемы планирования 
Создавая сайт Intranet, Вы столкнетесь с теми же самыми 

проблемами дизайна, организации и навигации, которые неиз-
бежно встанут перед вами при создании Web-сайта в Internet. 
Кроме этого, обратите особое внимание на следующие момен-
ты, тщательный анализ которых на начальном этапе работы 
поможет Вам избежать многих проблем в будущем: 

Кто из сотрудников компании или организации будет 
иметь доступ к сайту? Какая информация будет на нем раз-
мещена? Должна ли вся находящаяся на нем информация 
быть доступной всем? 

Кто будет обновлять информацию на сайте? Кто за какие 
разделы и задачи будет отвечать? Прежде чем приступать к 
созданию сайта, уясните это себе настолько ясно, насколько 
возможно, потому что по мере разработки перед Вами может 
встать целый ряд задач, которые кому-то придется регу-
лярно выполнять. Frontpage позволяет достаточно просто 
распределять задания, для этого существует перечень зада-
ний (Tasks View) Проводника. 

Каким образом Вы не позволите сайту выйти из-под 
контроля? Для эффективного контроля за объемом сайта 
Вам придется определить круг лиц, имеющих полномочия 
модифицировать и добавлять материал. Если любой сотруд-
ник Вашей компании будет иметь возможность по своему 
усмотрению добавлять страницы, редактировать информа-
цию, расставлять ссылки и тому подобное, то на Вашем сай-
те очень скоро начнется Вавилонское столпотворение. Для 
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регулирования пользовательских привилегий Frontpage 
предоставляет вам возможность устанавливать права про-
смотра, редактирования и администрирования. 

Возможно, в Вашей организации уже установлена сеть и 

Вы при желании можете отыскать в ней любой файл или 
просмотреть документ, но этот процесс нельзя назвать про-
стым и изящным: Вы должны подключиться к нужному 
компьютеру сети, скопировать файл на свой компьютер или 
открыть его на другом компьютере, запустить соответству-
ющую прикладную программу, чтобы этот файл просмот-
реть, и т.д. Вдобавок к этому, просматривая содержимое 
удаленного компьютера, Вы видите только список файлов. 
Не слишком информативное представление, не правда ли? И 
даже если Вы знаете, где следует искать определенный файл, 

найти его в сети может оказаться достаточно утомительной 
задачей, особенно если Вы не знаете его точное имя. 

Сети Intranet позволяют перевести обмен информацией 
на визуальный уровень. Предположим, что необходимо по-
смотреть коммерческий отчет Вашей фирмы за предыдущий 
квартал, содержащийся в файле Microsoft Excel. В традици-
онном варианте построения сети Вы должны будете найти 
соответствующий файл, открыть его и загрузить в Excel на 
своем компьютере. 

С появлением Intranet-сайта у сотрудников компании 

появляется возможность извлечь нужную им информацию 
без необходимости запоминать ее расположение в сети. Все, 
что теперь им придется сделать, - это найти на сайте стра-
ницу с информацией о продажах компании, а затем щелчком 
на ссылке открыть файл из сети. А еще лучше, если необхо-
димой информации будет отведена на сайте своя собствен-
ная страница. Если они не смогут быстро найти страницу 
коммерческой информации (что может являться следствием 
плохой разработки проекта), то найдут ее в течение не-
скольких секунд с помощью механизма поиска. 

Серверы 
Для размещения сайта в Intranet Вам понадобится Web- 

сервер. Лучше всего, если Web-cepвep будет установлен на 
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выделенном компьютере, подобно традиционным сетевым 
серверам. Чем быстрее и мощнее будет этот компьютер, тем 
лучше будет работать сайт. 

Выбор Web-cepвepa зависит от ожидаемого траффика в 
сети. Если Ваша компания относительно невелика, вероятно, 
Вы сможете ограничиться единственным сервером на базе 
Персонального Web-cepвepa Frontpage или Персонального 
Web- cepвepa Microsoft. Эти серверы не рассчитаны на об-
работку большого объема информации, так что для более 
обширной сети Вам может потребоваться сервер, способный 
обрабатывать больше информации. 

Безопасность 
Для защиты большинства файлов в Вашей сети Intranet 

Вы можете использовать стандартные сетевые средства за-
щиты, ведь, в конечном счете, эти файлы расположены в 
обычной сети. Если необходимо, например, дать право на 
изменение определенных файлов в Intranet строго опреде-
ленному кругу лиц, то Вы вполне можете разграничить до-
ступ и на сетевом уровне. 

В дополнение к обычным сетевым средствам защиты 
Frontpage предоставляет три дополнительных уровня досту-
па к Web-сайтам. Используемый Вами Web-cepвep также 
может взаимо-действовать с этими средствами безопасности: 

- просмотр (уровень конечного пользователя); 
- авторский доступ (просмотр, модификация и поддерж-

ка сайта при помощи Frontpage); 
- административный доступ (назначение и изменение 

привилегий); администраторы также имеют все права автор-
ского доступа. 

Информационное наполнение 
Существует масса областей, в которых можно с успехом 

применить мощь технологии Intranet: 
    - Сделайте служебную информацию и документы об-

щедоступными. Сайты Intranet весьма удобно использовать 
для опубликования директив начальства, обучающих руко-
водств, расписаний, каталогов продукции и тому подобного. 
Это позволит сэкономить много времени, усилий и денег. 
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Представьте, что продавщица отдела кроватей и ванн уни-
вермага хочет предложить ароматизировать полотенца для 
праздничной распродажи, и для этого ей необходима ин-
формация об имеющихся в наличии духах. И вот, вместо то-
го чтобы обратиться к заведующему парфюмерным отделом, 
который передаст запрос помощнику, а тот, в свою очередь, 
переадресует ее к файлу с информацией о ценах, наличии и 
т.д., наша продавщица просто заглянет в соответствующий 
раздел Intranet-сайта универмага и сама непосредственно 
найдет всю необходимую информацию. 

- Держите сотрудников в курсе новостей компании. Сай-
ты Intranet – идеальная доска объявлений для размещения 

бюллетеней новостей Вашей компании и официальных со-
общений, предназначенных Вашим сотрудникам. Если Вы 

хотите проинформировать своих сослуживцев насчет еже-
годного пикника, то поместите это объявление в место, до-
ступное для всеобщего обозрения. 

- Используйте Intranet в быту. То, что основное предна-
значение сетей Intranet состоит в том, чтобы рационализи-
ровать поток информации внутри компании или организа-
ции, вовсе не означает, что для них нельзя придумать более 
увлекательное применение. 

- Свяжите Ваш Intranet-сайт с Internet. С помощью 
брандмауэров (firewall) и Рrоху-серверов Вы можете связать 
свои сайты с Internet без ущерба для безопасности Вашей 
сети Intranet. Поместите на видное место ссылки на сайты 
конкурентов, чтобы Ваши сотрудники всегда были в курсе 
их достижений, или на другую полезную и своевременную 
информацию, которую Вашим сослуживцам не мешало бы 
знать. Если информация о Вашей компании появится на дру-
гих сайтах Internet, сделайте ссылки на них; пусть персонал 
по достоинству оценит Вашу работу. 

Средства создания Web-анимации. Macromedia Flash 
Более полумиллиона человек по всему миру используют 

Flash для создания красочных и, в тоже время, компактных 
Web- ресурсов. Дизайнеров новый Macromedia Flash при-
влечет улучшенными возможностями создания графики, а 
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профессиональные разработчики смогут привнести новые 
идеи в свои приложения, благодаря использованию скрип-
тов, форм и подключению серверных возможностей. 

Macromedia Flash позволяет создавать яркие, запомина-
ющиеся пользователям Web-сайты, благодаря возможности 
сочетать четкость и гибкость векторной графики с растром, 
звуком, анимацией и богатыми интерактивными идеями. 

Имея удобную среду разработки, Macromedia Flash легко 
интегрируется в существующий процесс создания Web-узла, 
благодаря возможностям импорта из Macromedia FreeHand 
и Fireworks. 

Macromedia Flash также предоставляет широкий набор 
средств разработки насыщенных Web-приложений, включая 
тесную интеграцию с Macromedia Generator. 

 
2. Инструменты рисования Macromedia Flash 

 
Используйте инструменты рисования Flash (drawing 

tools) для создания рисунков. Вы можете также импортиро-
вать рисунки из любых векторных программ, таких как 
Macromedia FreeHand, Adobe Illustrator, и растровые изоб-
ражения из Adobe Photoshop или любых других программ. 

Рисовать во Flash легко, если понять основные принци-
пы, такие как использование инструментов, выделение, свя-
зывание и разбиение. 

Выберите различные инструменты из панели инструмен-
тов рисования (рисунок 136).  

В зависимости от выбранного инструмента внешний вид 
панели может измениться и может появиться выпадающее 
меню в нижней части панели. Эти изменения показывают, 
что может делать выбранный инструмент. Например, при 
выборе карандаша Вы можете выбрать толщину, цвет и 
стиль линий, а также автоматическое закругление (smoothed) 
или, напротив, заострение (straightened). 
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Рисунок 136 
 

Рисование линий и штрихов 
Используйте карандаш и кисточку, чтобы создать линию 

или штрих. Линия является одинарным элементом. Штрих ки-
сточки - это заполненная область с контуром (рисунок 137). 

 

 
 

Рисунок 137 
 
Линия, созданная карандашом и кисточкой  
При рисовании линии Flash может сглаживать кривые, 

превращать их в изломанные линии или оставить в точно-
сти такими, как Вы нарисовали. Вы выбираете эти опции, 
используя выпадающее меню. Помимо этого Вы можете ука-
зать толщину, стиль и цвет линии. 

Карандаш рисует линии и кривые, как и обычный каран-
даш. Flash может сделать линии прямыми или закруглить 
кривые. Он распознает основные геометрические очертания 
автоматически, но Вы можете использовать инструменты из-
менения для того, чтобы создать необходимые кривые. В до-
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полнение к этому можно вручную изменить форму линий в лю-
бое время. У линий есть три свойства: цвет, толщина и стиль. 

Используйте возможности изменения карандаша, чтобы 
изменить внешний вид линий. Вы можете выбрать цвет ли-
нии (щелкнув на прямоугольник с цветом по умолчанию - 
появится выпадающее окно) и выбрать цвет из списка, или 
щелкнуть на иконку с палитрой, чтобы создать новый цвет. 
Также выберите следующие возможности изменений. 

Выпадающее меню карандаша  
В этом меню выбираете, что будет делать Flash с ваши-

ми линиями (рисунок 138). 
– Straighten (Выпрямление) распознает линии и кривые 

и "выпрямляет" их. То есть, если Вы выберете эту опцию и 
нарисуете волнистую линию, как только Вы отпустите 
мышь, она превратится в зигзагообразную. 

– Smooth (Сглаживание) не выпрямляет линии и не рас-
познает кривые. То есть, если Вы выберете эту опцию и 
нарисуете зигзагообразную линию, она будет волнообразной 
(т.е. сглаженной). 

 

 
 

Рисунок 138 
 

- Ink (чернила) оставляет линии такими, как Вы их 
нарисовали, не сглаживая и не выпрямляя. 

- Oval рисует овалы или круги. Ведите мышью по диаго-
нали из начальной точки к конечной. Если нажат "магнит", 
то как только у Вас получается круг, кружочек около курсо-
ра становится темнее и больше. 
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- Rectangle рисует квадраты и прямоугольники. При 
нажатом "магните" как только получается квадрат, кружок 
около курсора становится больше и темнее. 

- Line рисует прямую линию из начальной точки к ко-
нечной. При нажатом магните можете получить горизон-
тальную или вертикальную линии, если отпустите мышь, 

как только около курсора появится более темный и большой 
кружок. 

Толщина линии  
Эта опция для карандаша также открывает выпадающее 

меню. Толщина линии может быть от толщины волоса до 10 
поинтов (points). 

Чтобы выбрать отличную от заданных толщину линии, 
выберите в меню раздел Custom, который откроет окошко 
свойства линии (Line Settings) (рисунки 139, 140). Введите 
нужное вам значение толщины линии. 

 

                                        
 

                  Рисунок 139                    Рисунок 140 
 
Примечание. Некоторые тонкие линии могут выглядеть 

одинаковыми на экране, но на принтерах с высоким разре-
шением или при приближении они будут выглядеть пра-
вильно. 

Стиль линии  
Этот инструмент указывает тип линии, который Вы хо-

тите нарисовать. Выберите один из встроенных типов линии 
или Custom для создания собственного стиля (рисунок 141). 
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В диалоговом окне Line Style выберите стиль линии из 
выпадающего меню "Тип" (Туре). Каждый тип линии имеет 
разные свойства. Вы можете выбирать из следующих типов 
линии: 

Solid создает цельную линию. 
Dashed создает прерывистую линию, Вы можете изме-

нять расстояние между отрезками линии. 
Dotted создает прерывистую линию, состоящую из точек. 
Ragged создает неровную линию, выглядящую как нари-

сованную от руки. Попробуйте изменять значения, чтобы 
изменять шероховатости линии. Шероховатые линии обычно 
выглядят лучше с выбранной опцией Sharp Corners 

Stippled создает линию с множественными точками раз-
ных размеров. Линия выглядит неровной, пушистой. 

Hatched создает линию с очень маленькими отрезками 
прямой. Выглядит очень шероховатой.  

 

 
   

Рисунок 141 
 

Примечание. Стиль линии Solid лучше выглядит в Web. 
Когда Вы делаете штрихи при помощи кисточки, можно 

указать размер и очертания кисточки, а также цвет или гра-
диент заполнения. Кисточка может рисовать между или 
внутри созданного рисунка или только в выделенном эле-
менте рисунка. 
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Кисточка рисует прямые с областью заливки, как и 
настоящая кисточка. "Краска" для кисточки может быть про-
стым цветом, градиентом или быть созданной из готового 
файла (bitmaps). В дополнение к обычным мазкам кисти ис-
пользуйте эти различные опции для кисточки. Например, 
Вы можете рисовать между уже готовыми элементами или 
только в заполненной области. Можно выбрать несколько 
размеров и форм кисти. 

Используйте дополнительные опции кисти, чтобы изме-
нять мазки. 

Fill Color открывает выпадающее окошко Color, чтобы 
выбрать цвет для рисования. Нажмите на рисунок палитры, 
чтобы создать свой собственный цвет. Закрашивание цветом 
бэкграунда совсем не то же самое, что использование ласти-
ка. Вы создаете рисунок, закрашенный бэкграундом, кото-
рый можно выделить, передвигать или изменить форму. 

Brush Size (верхнее выпадающее окошко) меняет размер 
кисти. Экспериментируйте с разными значениями размера и 
формы, чтобы получить различные кисти. 

Brush Shape (нижнее выпадающее окошко) меняет форму 
кисти. 

Pressure Modifier. Если у Вас есть дигитайзер, эта опция 
позволяет регулировать силу нажима. 

Варианты рисования кистью 
Это выпадающее подменю помогает выбрать, как штрихи 

кисти будут применяться к рисованию. 
В основном используется Paint Normal, но другие опции 

создают необычные эффекты (рисунок 142). 
Paint Normal рисует сверху любые линии и заливки. 
Paint Fills рисует поверх заливки, но оставляет линии 

нетронутыми. 
Paint Behind (рисование между) рисует на частях "хол-

ста", на которых нет рисунка. 
Paint Selection рисует только поверх выделенной области. 
Paint Inside рисует только область заливки там, где Вы 

начали рисовать и никогда не будете рисовать около линий. 
Эта опция работает, как умная книжка-раскрашка, в которой 
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Вы никогда не нарисуете за границу линии. Если рисовать 
на пустом месте, Вы не сможете нарисовать ни на какой об-
ласти заливки. 

 

 
 

Рисунок 142 
 
Замок заливки 
 Этот инструмент кисти "запирает" размер, угол заливки 

или градиента. Все последующие нанесения градиента или 
заливки будут выглядеть продолжением закрытой части. 

Изменение формы линии 
Flash не имеет каких-либо рычажков для изменения 

формы линий. Тем не менее Вы можете изменять линию из 
любой части, используя инструмент "стрелка". Стрелка будет 
изменяться в соответствии с тем, какое изменение Вы мо-
жете произвести на данном отрезке линии, мазка кисточки 
или заливки. 

После того, как рисунок был нарисован кисточкой, была 
изменена форма волос и добавлен еще один штрих (рисунок 
143). 

 
 

Рисунок 143 
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Чтобы изменить форму отрезка линии, выберите стрелку 
в панели инструментов "рисование". Чтобы изменить форму, 
потяните из любой точки отрезка линии. Потяните с нажа-
той кнопкой Ctrl, чтобы создать новую угловую точку. 

Flash может укоротить или удлинить линию. Для этого 
нужно всего лишь потянуть в соответствующую сторону, 
держа мышь на конечной точке. Если конечная точка явля-
ется углом, он может стать острее, если Вы потяните в ту 
или иную сторону (рисунок 144). 

 

 
 

Рисунок 144 
 

Изменение формы штриха кисточки 
Вы можете изменять форму штриха так же, как и форму 

заливки. Впоследствии можно сделать обводку штриха ки-
сти, использовав чернильницу. 

Приближение изменяет форму штриха легче. Некоторые 
штрихи легко изменяются, если Вы видите только их конту-
ры. Для этого выберите View > Outlines . 

Форма штриха изменяется так же, как форма линии или 
форма заливки. 

Чтобы изменить форму штриха кисточки: 
* Выберите стрелку и приблизьте указатель мыши к 

элементу, который Вы собираетесь изменять. Нажмите Ctr и 
ведите мышью в том случае, если нужно получить угол. 

* Чтобы удалить часть контура, выберите ластик. 
На рисуноке 145 показан штрих кисточки в обычном ре-

жиме и в режиме контура. 
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Рисунок 145 
 

Выпрямление и сглаживание линий 
Вы можете выпрямить или сгладить кривые и линии как 

во время рисования, так и позднее. 
Примечание. Регулировать степень автоматического 

сглаживания и выпрямления Вы можете, используя File > 
Assistant. 

Используйте значок выпрямления или выберите Modify 
> Curves > Straighten, чтобы достичь небольшого выпрям-
ления линий и кривых. Выпрямление не влияет на уже вы-
пряменные линии. 

Вы можете использовать технику выпрямления, чтобы 
Flash распознавал форму (рисунок 146). Flash делает геомет-
рически идеальными любые круги, овалы, прямоугольники, 
квадраты, треугольники и полукруги, которые нарисованы с 
отключенным распознованием формы. Формы, которые сопри-
касаются или связаны с другой формой, не распознаются. 

Сглаживание закругляет кривые в нескольких направле-
ниях. Сглаживание также воспроизводит количество отрез-
ков кривых. Тем не менее, сглаживание не возымеет эффек-
та на выпрямленных отрезках. Оно полезно, когда у Вас 
возникает проблема изменения формы для нескольких очень 
коротких линий. 

 

                 
 

Рисунок 146 
 

Повторные сглаживания или выпрямления делают каж-
дый отрезок все более и более сглаженным или прямым, в 

включение опции  
распознавания кривых,  
сделало эти кривые 
 
такими 
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зависимости от того, насколько искривленными или прямы-
ми были изначально каждые отрезки линии. 

Чтобы сгладить кривую выделенной заливки или изо-
гнутой линии: 

Выберите стрелку и щелкните на иконку сглаживания 
или выберите Modify > Curves > Smooth. 

  - иконка сглаживания. 
Чтобы выпрямить выделенную заливку или кривую ли-

нию: Выберите стрелку и затем щелкните на иконку вы-
прямления или выберите Modify > Curves > Straighten. 

  - иконка выпрямления. 
Чтобы включить распознавание кривых: 
Выберите стрелку и щелкните на иконку выпрямления 

или выберите Modify > Curves > Straighten. 

 - оптимизирование кривых. 
 Еще одной возможностью сгладить кривые является их 

оптимизация. Эта опция сглаживает линии и заливку при 
помощи распознавания кривых, использованных для обозна-
чения элементов. Оптимизирование кривых также оптими-
зирует размер флэш исходника и размер конечного ролика. 
Как при использовании кнопки "сглаживание", эту команду 
можно применять несколько раз. 

Чтобы оптимизировать кривые: 
- Выберите элемент рисунка для оптимизации и нажми-

те Modify > Curves > Optimize. 
- В диалоговом окне Optimize Curves укажите степень 

сглаживания. Конечный результат зависит от выбранных 
кривых. Оптимизация уменьшает количество кривых. 

- Подключите дополнительные опции: 
Включите опцию Use Multiple Passes, чтобы повторять 

процесс сглаживания до "упора". Это то же самое, что и много-
кратное нажатие кнопки " сглаживание". Включите Show To-
tals Message, чтобы появлялось окно предупреждения, которе 
сигнализирует о невозможности дальнейшей оптимизации. 

Использование ассистента 
Команда File > Assistant открывает диалоговое окно ас-

систента. Используйте опции в этом окне, чтобы указать 
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значения для закругления линий (smoothing), распознавания 
линий и кривых и опций для намагничивания. 

Каждое значение может быть отключено и включено и 
каждая опция имеет набор доступа (tolerances). Эксперимен-
триуйте со значениями, чтобы получить наиболее оптималь-
ные настройки для Ваших целей. Включите опции, выбрав 
уровни доступа. Уровни доступа зависят от разрешения на Ва-
шем мониторе и приближения сцены (100, 200, 300% и т.д). 
Как и для рисования, приближение рабочего поля предостав-
ляет лучший контроль. Каждая опция имеет набор доступа. 

Snap to grid {"прибить" к разметке). Означает рассто-
яние от разметки, к которому будет "прибиваться" линия. 
Опции: выключить, быть близко, нормально, должно быть 
на расстоянии и всегда прибиваться (Off, Must be close, 
Normal, Can be Distant, Always Snap). 

Connect lines (состыковка линий). Означает, насколько 
близко к концу линии, которую Вы нарисуете, будет гото-
вый отрезок линии. Опции: выключить, быть близко, нор-
мально, должно быть на расстоянии (Off, Must be Close, 
Normal, Can be Distant). Эти опции также контролируют ве-
тикальное и горизонтальное распознавание линий: как 

близко от реальной горизонтальности и вертикальности 
должна быть нарисована линия, чтобы Flash сделал линию 
идеально горизонтальной или вертикальной. 

Smooth curves (сглаживание кривых). Указывает коли-
чество сглаживания, примененного к кривым линиям, нари-
сованным карандашом (опция карандаша должна быть 
Straighten or Smooth). (Легче изменить форму сглаженных 
кривых, поскольку сглаженные кривые ближе всего по виду 
к рисунку от руки). Может быть выключено, закруглено, 
нормально и сглажено (Off, Rough, Normal, and Smooth). 

Примечание. Вы можете сгладить даже готовый отрезок 
кривой, используя Modify > Curves > Smooth and Modify > 
Curves > Optimize. 

Recognize lines (распознавание линий). Обусловливает, на-
сколько прямо участок линии будет нарисован перед тем, 
как распознает ее и сделает идеально прямой. Варианты: 
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выключено, точно, нормально и приблизительно (Off, Strict, 
Normal, Tolerant). 

Если распознавание линий (Recognize lines) выключено в 
момент, когда Вы рисуете, можно позднее сделать распозна-
вание, выбрав Modify > Curves > Straighten. 

Recognize shapes (распознавание кривых). Контролирует, 
насколько точно Вы должны рисовать овалы, круги, квадра-
ты и прямоугольники и 90- и 180-градусные углы. Для них 
будут распознаны как геометрические кривые и нарисованы 
более аккуратно. Опции: Отключено, точно, нормально и 
приблизительно (Off, Strict, Normal, Tolerant). 

Если распознавание кривых отключено в момент, пока 
Вы рисуете, можете произвести распознавание позднее, вы-
делив одну или несколько кривых и выбрав Modify > Curves 
> Straighten. 

Click accuracy (точный щелчок). Обозначает, насколько 

близко к предмету должен приблизиться указатель перед 
тем, как Flash распознает предмет. Опции: точно, нормально 
и приблизительно (Strict, Normal, Tolerant). 

Выделение графических элементов 
Flash имеет несколько инструментов для выделения. 
Инструмент "стрелка" - это основной инструмент для 

выделения. Выберите стрелку в панели "рисование" или 
нажмите А. Вы можете переключиться на стрелку из любого 
другого инструмента, нажав пробел. 

Как и в большинстве графических приложений, щелкни-
те на элемент, чтобы выделить его (инструментом "стрел-
ка"). В отличие от других графических программ, как только 
Вы кликните на другой элемент, он добавится к уже выде-
ленному. Вы можете изменить настройки так, чтобы не-
сколько элементов выделялось только при щелчке мыши с 
нажатым Shift (edit- >preferences). 

Приводим другие способы выделения. 
- Чтобы выделить все примыкающие друг к другу элемен-

ты рисунка, щелкните на нем дважды инструментом "стрелка". 
- Чтобы выделить все элементы в область квадрата, 

нажмите кнопку мыши, и не отпуская, нарисуйте квадрат. 
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Символы, группы и текст должны быть полностью захваче-
ны областью квадрата, чтобы быть выделенными. 

 - Чтобы выделить все предметы областью произвольной 
формы, обозначьте эту область при помощи инструмента 
"лассо". Когда фигура, нарисованная лассо, замыкается, лас-
со превращается в стрелку, и Вы можете двигать выделен-
ный участок. 

- Чтобы одновременно выделить несколько областей, 
нажмите Shift (лассо или стрелка должны быть выбраны). 

- Чтобы выделить всё во всех слоях сцены, выберите 
Edit > Select All, или нажмите Control-А (Windows) или 
Command-А (Macintosh). 

- Чтобы снять выделения со всего, выберите Edit > 
Deselect All, или нажмите Control-Shift-A (Windows) или 
Command-Shift-A (Macintosh). 

- Чтобы предотвратить от выделения сгруппированные 
объекты или символы, выделите их и выберите Modify > 
Arrange > Lock. Выберите Modify > Arrange > Unlock All, 
чтобы снять"замок" со всех сгруппированных объектов и 
символов. 

Выделенная область рисования выглядит текстуризиро-
ванной, выделенные линии становятся "утолщенными" и 
текстуризированными, сгруппированные объекты, символы 
и текст становятся "обведенными" квадратом (рисунок 148). 

 

             
             
                   Рисунок 147                             Рисунок 148                                       

невыделенный             выделена 
    элемент   выделена    заливка 
                         обводка 

     выделены    выделен символ 
        обводка         (или группа) 
       и заливка 
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Выделенные элементы не разбивают и не стирают дру-
гие элементы, пока они остаются выделенными. Если Вы 
снимете выделение с элемента рисунка, который располо-
жен над другим элементом рисунка в том же слое, область, 
которая была закрыта верхним элементом, переместится и 
разобьет нижний элемент (рисунок 148). 

 Передвижение графических элементов 
 Чтобы передвинуть все элементы, кроме линий, пере-

тащите их, используя инструмент "стрелка". Щелкните, что-
бы выделить линию перед тем, как передвигать ее. При по-
пытке передвинуть невыделенную линию, Вы измените ее 
форму, но не сможете передвинуть ее. Если выделено не-
сколько предметов, а Вам нужно передвинуть только один, 
снимите выделение и выделите только тот объект, который 
нужно передвинуть. 

Используя стрелки клавиатуры (вверх-вниз, влево-вправо), 
Вы сможете передвигать предмет на расстояние в 1 пиксель. 
Если Вы нажмете Shift вместе с клавишами вперед-вверх, вле-
во или вправо, то предмет передвинется на 8 пикселей. 

Используйте инспектора, если Вам нужно передвинуть 
объект в определенное место. Введите значения места рас-
положения в окне инспектора (windows->inspector). 

Если Вы передвигаете выделенную заливку поверх дру-
гой заливки и затем снимите выделение, та часть рисунка, 
которая находится под верхним, вырежется. Это схоже с 
традиционными программами рисования (рисунок 149). 
 

 
 

Рисунок 149 
 
Чтобы понять это, нарисуйте линию поверх заливки. Как 

Вы и ожидали, линия разрежет заливку, не сливаясь ни с 
одной частью этой заливки. Во Flash линии сами по себе 
разделяются после того, как они соединяются с заливкой в 
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какой-либо точке, результатом становятся три куска линии, 
как и показано на рисунке 150, где приняты следующие обо-
значения: 1- заливка; 2 - линия, нарисованная поверх за-
ливки; 3 - две кривые и три отрезка линии, полученные в 

результате соединения линии и заливки и последующего 
разделения. Вы можете выделять, передвигать и изменять 
форму каждого отрезка независимо от другого. 

 

 
                     1                2                  3 

 
Рисунок 150  

 
Соединение и разделение (connection and segmentation) 

практически то же самое, что посетить и вырезать в других 
программах (join и cut). Корневые с тем же цветом сливают-
ся друг с другом. Кривые разного цвета разделяют друг дру-
га. Используйте эти возможности, чтобы создавать маски, 
эффект вырезания и др. К примеру, лист, вырезанный в 
красном квадрате слева, был получен так: рисуем красный 
квадрат, затем берем не- сгруппированный рисунок листа и 
накладываем на красный квадрат. Затем снимаем выделение 
с листа и передвигаем черный лист вправо. На красном 
квадрате "вырезан" силуэт листа (рисунок 151). 

 

 
 

Рисунок 151 
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Группирование кривых предотвращает соединение и раз-
деление (connection and segmentation). 

Копирование линий и атрибутов заливки 
Копирование линий и атрибутов заливки таких, как 

толщина, цвет, градиент, для использования в другом гото-
вом рисунке получается с использованием чернильницы, пи-
петки и ведерка с заливкой. Скопируйте атрибуты готового 
элемента при помощи пипетки и затем нанесите их на дру-
гой элемент, используя ведерко с заливкой и чернильницу. 

Чтобы изменить атрибуты заливки или линии: ____  
1. Чтобы скопировать атрибуты готового элемента, вы-

берите пипетку и щелкните на линию или заливку, которые 
Вы хотите скопировать.  

Когда Вы щелкните пипеткой на линию, инструмент ав-
томатически сменяется на чернильницу. Когда Вы щелкаете 
на область заливки, пипетка меняется на ведерко заливки. 
Щелкните на линию или заливку, которым Вы хотите 

назначить скопированные атрибуты.  
2. Чтобы назначить другой (отличный от копируемого) 

цвет и толщину линии или заливки, выберите другие линию 
и заливку из выпадающих меню в панели инструментов Ри-
сование.   

3. Щелкните на линию или заливку, которым вы хотите 
задать эти атрибуты. 

Чернильница. Чернильница меняет цвет, толщину и 
стиль нарисованной линии. Нарисуйте линию. Щелкните на 
чернильницу и выберите другой цвет, стиль и т.д. Щелкните 
на нарисованную линию. Она поменяет свои атрибуты. Если 
Вы выделите несколько линий и щелкните чернильницей на 
них, то все выделенные линии поменяют атрибуты. 

Примечание. Инструмент "пипетка" очень полезен для 
изменения атрибутов линии. Также имейте в виду, что чер-
нильница не изменит линий в сгруппированном символе. 

Инструмент "ведерко с заливкой" (заливка). Инстру-
мент "заливка" заполняет закрытые области цветом или 
градиентом. Щелкните на область, которую Вы хотите за-
лить цветом. Если Вы выделите несколько заливок и затем 



186 

щелкните на них этим иструментом (предварительно поме-
няв цвет), все выделенные элементы сменят цвет. 

Примечание. Рисование цветом бэкграунда - не то же 
самое, что стирание ластиком. Когда Вы рисуете цветом 
бэкграунда, Вы создаете элемент, который можно выделять, 
двигать, менять ему форму точно так же, как и любому дру-
гому элементу (мазок кисти или заливка). 

Используйте опции для ведерка с заливкой, чтобы ме-
нять внешний вид заливки. 

Fill Color (цвет заливки) открывает выпадающее меню 
цвета (Color). Щелкните на любой цвет, чтобы его выбрать. 
Чтобы создать новый цвет, щелкните на палитру (Color 
Palette). 

Gap Size (размер промежутка) открывает выпадающее 
меню с опциями, указывающими размер промежутка между 
линиями, который можно заполнять. Выберите close, чтобы 
Flash автоматически заполнял промежутки. Выберите е 
Don't Close Gaps, если Вы хотите закрасить промежутки 
другим цветом. 

Примечание. Приближение или удаление не влияют на 
величину промежутка. Если расстояние между двумя линия-
ми (промежуток) слишком велико, Вам необходимо закра-
сить его вручную.  

 Lock Fill (замок заливки) закрывает размер, угол и 
центр текущей заливки. Все последующие нанесения залив-
ки будут являться как бы продолжением этой. Когда Вы вы-
бираете заливку с помощью пипетки, замок заливки появля-
ется автоматически. Если Вы хотите нанести новый гради-
ент, отключите замок заливки. 

 Transform Fill (изменить заливку) регулирует размер, 
угол и центр заливки. Когда выбрана эта опция, ведерко с 
заливкой превращается в стрелку. Нарисуйте круг. Залейте 
градиентом. Выберите эту опцию и меняйте месторасполо-
жение и направление градиента. Если Вы не видите краев 
градиента, выберите View > Work Area. 

Инструмент "пипетка". Пипетка берет информацию о 
цвете и стиле готового изображения. Когда Вы щелкаете на 
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область инструментом "пипетка", она "копирует" цвет и 
стиль. Если Вы кликаете на область заливки, около пипетки 
появляется значок кисточки, если кликаете на линию - по-
является карандаш. Значения инструментов "карандаш" и 
"ведерко с заливкой" при щелчке пипетки меняются на тот 
цвет и стиль, которые "скопировала" пипетка. 

Если Вы нажмете Shift и щелните пипеткой, цвет, кото-
рый она "скопирует", одновременно появится и в инстру-
менте "карандаш", и в инструменте " ведерко заливки", и в 
инструменте "текст". 

Примечание. Пипетка не может скопировать информа-
цию из содержимого сгруппированных символов, пока Вы не 
сделаете modify ->break apart. 

Ластик стирает линии и заливку. Вы можете задать оп-
ции ластику так, что он будет стирать только линии, только 
заливку, только выделенную заливку или только ту заливку, 
которую Вы начали стирать. Используйте опции ластика, 
чтобы выбрать один из пяти размеров или изменить форму 
ластика. 

Примечание. Ластик может стирать линии и заливки 
только в сцене, он не стирает группы объектов, символы 
или текст. Если Вам нужно стереть часть группы, выделите 
эту группу и выберите Edit > Edit Selected или Modify > 
Break Apart. 

Выпадающее меню Ластика. Опции в выпадающем ме-
ню определяют, как ластик будет стирать. Опции очень по-
хожи на те, которые Вы видели в инструменте Кисточка: 

- Normal опция - ластик стирает и линии, и заливки. 
- Erase Fills стирает только заливку. Если Вы попадаете 

на линии - они остаются. 
- Erase Lines стирает только линии. При попадании на 

заливку она остается нетронутой. 
- Erase Selected Fills стирает только выделенную заливку 

и не затрагивает линии вне зависимости, выделены они или 
нет. 

- Erase Inside стирает только ту область заливки, с кото-
рой Вы начали стирать (если вы начали стирать с пустого 
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места, ластик не сотрет ничего). Линии не затрагиваются в 
этой опции. 

Водопроводный кран. Стирает отрезок линии или об-
ласть заливки. Щелкните на ластик, а потом на кран. Если 
Вы щелкните затем на линию или заливку, все отрезки ли-

нии и заливки будут стерты.  
 

3. Работа с объектами 
 

Вращение и перевороты 
Вы можете переворачивать, вращать или изменять раз-

мер одного или нескольких элементов одновременно (рису-
нок 152). 

Переворот (Flip). Чтобы перевернуть выделенный эле-
мент в сцене: 

Выберите Modify > Transform > Flip Vertical или Flip 
Horizontal.  

Вращение. Есть несколько способов вращения выделен-
ного элемента. При выборе свободного вращения (кпопка в 
панели рисования) Вы сможете также менять размер и 
наклон, потянув за центральный кружок одной из сторон. 

 

 
 

Рисунок 152 
 

Чтобы повернуть выбранный элемент на 90° против ча-
совой: выберите Modify > Transform > Rotate Left. 

перевернуто по вертикали 
(flip vertical) 

перевер-
нуто по 

горизон-
тали (flip 

horizontal) 

оригинал 

повернуто 
на 180  
Rotate 180 

повернуто на 180  
Rotate 180 
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Чтобы повернуть выделенный элемент на 90° по часо-
вой: выберите Modify > Transform > Rotate Right. 

Чтобы повернуть выделенный элемент на заданное ко-
личество градусов: выберите Modify > Transform > Scale and 
Rotate и введите значение между -360° и 360° . 

Чтобы свободно поворачивать выделенный элемент, вы-
берите один из следующих вариантов: 

- Modify > Transform > Rotate, и вращайте предмет за 
один из появившихся углов; 

- инструмент «стрелка» и затем кликните на на иконку 

поворота внизу и поворачивайте предмет за один из по-

явившихся углов.  

 
Чтобы наклонять (skew) выделенный элемент, выберите 

один из следующих вариантов: 
- Modify > Transform > Rotate и тяните за центральный 

кружок любой из сторон; 
- стрелку, затем нажмите кнопку поворота (Rotate) и тя-

ните за центральный кружок любой из сторон. 

 
Изменение размера (Scaling). Используйте изменение 

размера, чтобы увеличить или уменьшить рисунок пропро-
ционально или чтобы вытянуть его в ширину или высоту. 
Изменение размера происходит из центра выделенного эле-
мента на указанный процент. Чтобы изменить точку, от ко-
торой происходит изменение размера, измените расположе-
ние центральной точки (center point). 

Примечание. Вы также можете использовать инспекто-
ра, чтобы указать точный размер объекта. 

Чтобы увеличить или уменьшить выделенный элемент 
на определенный процент: выберите Modify > Transform > 
Scale and Rotate и введите значение изменения размера 
(scale) между 10 и 1000. 
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Чтобы уменьшить выделенный элемент, выберите один 
из следующих вариантов: 

- Modify > Transform > Scale и потяните за любой угол; 
- стрелку и затем выберите значок увеличения размера и 

потяните за любой из углов по направлению к центру. 

 
Чтобы растянуть выбранный элемент: выберите Modify 

> Transform > Scale и потяните за любой угол по направле-
нию из центра. Выберите инструмент "стрелка" и затем 
щелкните на значок уменьшения/увеличения размера. Потя-
ните за любой угол по направлению из центра. 

Чтобы перевернуть выбранный элемент во время изме-
нения размера: потяните за средний значок вниз, в сторону 
центра (см. рисунок) (вправо, вверх, в сторону центра). 

 
Примечание. Когда Вы увеличиваете размер намного 

или же предмет очень большой, Вы можете не увидеть пря-
моугольничков, за которые нужно тянуть. В этом случае 
нажмите View > Work Area. 

Выравнивание объектов. Modify > Align может выстро-
ить два или более выделенных объектов. Выравниваение 
может изменить размер элеметов так, что их высота и ши-
рина будут одинаковыми. Размеры "подравниваются" под 
самый большой из выделенных объектов. Выравнивание 
может также выровнять объекты по их центру, левому или 
верхнему краю с равными расстояниями между объектами. 
Align to Page опция выравнивает объекты по отношению к 
друг другу и по отношению к сцене. 

Когда выравнивается несколько объектов, Flash вырав-
нивает их по краям или центру, что сближает объекты. Не 
играет значения, в каком порядке Вы выделите объекты. На 
рисунке 153 показаны объекты без выравнивания, а на ри-
сунке 154 – выравненные по верхней точке. 
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Рисунок 153 
 

Для наилучшего результата сгруппируйте предметы, чтобы 
оставить элементы раздельными и редактируемыми после вы-
равнивания. Если некоторые из выделенных объектов соеди-
няются между собой или расположены близко друг к другу, 
результат выравнивания будет непредсказуемым. Элементы, 
которые находят друг на друга, после выравнивания и изме-
нения размера будут разбиты на части или сольются. 

 

 
 

Рисунок 154 
 

Чтобы выровнять объекты: 
1. Выделите объекты, которые Вы будете выравнивать. 
2. Выберите Modify >Align (рисунок 155). 
3. Выберите опции в диалоговом окне и нажмите ОК.  
 

 
 

Рисунок 155 
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Вырезание, уничтожение, копирование и вставка 
объектов 

 Вы можете вырезать (cut), уничтожать (delete), копиро-
вать (сору) и вставлять (paste) объекты во Flash так же, как 
и в большинстве программ рисования. 

Объекты, скопированные в буфер обмена, сглажены 
(antialiased),  и они будут выглядеть в других программах 
так же, как и во Flash. 

Вырезанные или скопированные объекты могут быть 
вставлены в другие сцены или слои (layers), в тот же ролик 
(movie) или в другой ролик (movie). Есть две возможности 
вставки - вставить в то же место (Paste in Place) с которого 
Вы вырезали или скопировали объект, и вставить (Paste) в 
центр рабочего поля. 

Графика, вставленная из другого ролика (movie), или 
программы помещаются в текущий фрейм (frame) текущего 
слоя (layer). Каким образом графический элемент будет 
вставлен во Flash, зависит от типа элемента, исходника и 
опций, которые Вы выбрали: 

- Текст из текстового редактора вставится, как единич-
ный объект текста. 

- Векторная графика из любой программы вставится как 
группа, которую можно разгруппировать и редактировать, 
как и любой объект, созданный во Flash . 

- Растровая графика вставляется, как сгруппированный 
объект, так же, как и импортированная растровая графика. 
Выберите Modify > Trace Bitmap, чтобы перевести растр в 
векторную графику. 

Примечание. Чтобы скопировать и вставить графику из 
FreeFIand 8 во Flash 3, измените FreeHand Export Prefe-
rences на CMYK и RGB . 

Чтобы удалить выделенный элемент: 
- нажмите Del или Backspace; 
- выберите Edit > Clear; 
- выберите Edit > Cut. 
Чтобы скопировать выделенный элемент: 
- Ctrl-потяните объект из одного окна на другое;  
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- выберите Edit > Duplicate; 
- выберите Edit > Сору. 

Чтобы вставить объект в то же самое месторасполо-
жение: 

- вырежьте (Cut) или скопируйте (сору) объект. 
Чтобы предотвратить замещение с копированного объекта:  
- переключитесь на другой слой (layer); 
- выберите Edit > Paste in Place. 
Объект появится в том же самом месте, откуда он был 

скопирован, но в другом лайера. Это особенно полезно для 
вставки объектов, которые должны быть в одном и том же 
месте в разных слоях или разных сценах. 

Чтобы вставить объект в центр рабочего поля: 
- вырежьте (Cut) или скопируйте (сору) объект; 
- выберите Edit > Paste. 
Команда Специальная Вставка (Paste Special). Команда 

Paste Special вставляет содержимое буфера обмена 
(Clipboard) в указанном формате. Так же может создать 
ссылку к информации из другого ролика. Диалоговое окно 
Paste Special содержит следующие опции: 

Source (исходник) показывает имя исходных данных и их 
месторасположение. 

Paste (вставить) вставляет содержимое буфера обмена в 
Ваш рисунок. 

Paste Link (вставить ссылку) вставляет содержимое бу-
фера обмена в Ваш рисунок и создает ссылку к исходному 
приложению, таким образом, вставленный объект автомати-
чески обновляется. 

As (как) обозначает тип информации, которую Вы вставля-
ете. Выберите Object, чтобы вставить объект и информацию, 
необходимую для изменения объекта. Название объекта зави-
сит от приложения, в котором объект был создан. Чтобы из-
менить объект во Flash, выберите Modify > Break Apart. 

Выберите рисунок (Picture) (Metafile), чтобы вставить 
рисунок, который Flash конвертирует в редактируемый объ-
ект. Выберите Текст (Text QASCII), чтобы вставить неот-
форматированный текст. Выберите Text (Native), чтобы 
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вставить отформатированный текст. Выберите Flash 
Drawing, чтобы вставить часть рисунка Flash. 

Display As Icon (показать как иконку) показывает ссылку, 
как иконку в Вашем рисунке. 

Result (результат) описывает результат выбранной опе-
рации. 

Change Icon (изменить иконку) открывает диалоговое 
окно Change Icon. Используйте опции в диалоговом окне, 
чтобы выбрать другую иконку. Опции доступны, если вклю-
чен Display As. 

 
4. Работа с цветом 

 
Создание и редактирование цвета 
Используйте окошко цвета (Colors), чтобы изменить цвет 

в палитре и указать альфу или степерь прозрачности. Цвет 
или градиент для текущего инструмента показан внизу ин-
струмента. Когда Вы в первый раз открываете Flash, табли-
ца цвета в выпадающем меню Цвет (Color) представляет со-
бой набор цветов, доступный на данный момент и в данном 
ролике (рисунок 156). 

 

 
 

Рисунок 156 
 

теку-
щий 
цвет 

 

кнопка «палитра» 
для создания нового 

цвета 

доступные гради-
енты 

доступные цвета 
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Чтобы создать или изменить цвет: 
1. Щелкните на кнопку палитры или выберите 

Window>Color. 
Flash ролик может иметь больше цветов, чем обозначено 

в панели Colors. Количество цветов в ролике ограничивается 
только Вашей видеокарточкой (256, тысячи или миллионы).  

2.Щелкните на закладку Цельный (Solid), чтобы высве-
тилась панель изменения цельного цвета. 

4. Выберите цвет в палитре, который Вы хотите изменить. 
5. Измените цвет следующими способами: 
Чтобы подключить яркость или затемнение, перемещай-

те крестик в окошке с цветами. 
 Чтобы выбрать уровень прозрачности цвета, используй-

те рычажок непрозрачности или введите нужный процент в 
окошке процентного значения непрозрачности (100% - пол-
ностью непрозрачный цвет) (рисунок 157). Полупрозрачный 
красный выглядит так: 

 

 
Вы можете ввести значения красного R, зеленого G и 

голубого В, чтобы подобрать нужный цвет.  
 

 
 

Рисунок 157 
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6. Когда Вы закончите менять цвет, выберите один из 
следующих пунктов: 

- Чтобы заменить выбранный цвет новым, нажмите Change. 
- Чтобы добавить новый цвет в палитру, нажмите New 

(цвет появится в самом низу окна). 
- Чтобы уничтожить выбранный цвет, нажмите Delete. 
- Чтобы приготовить ролик к использованию в броузере, 

постарайтесь выбрать цвета, близкие к 216 безопасным цве-
там web. 

 
Создание и редактирование градиента 

 
Используйте окно цвета (Color), чтобы создавать и ре-

дактировать градиент (рисунок 158). Закладка градиента 
Gradient в окне цвета (Color) показывает все доступные на 
данный момент градиенты. 

Градиент - это переход цвета между двумя или более 
цветами (до 16). Градиент может быть линейным (linear) 
или круглым (radial). Любой цвет в градиенте может быть 
прозрачным в той или иной степени. 

  

 
 

Рисунок 158 
 
Чтобы создать или отредактировать градиент: 
1. Щелкните на кнопку палитры или выберите Window 

> Colors. 
2. Щелкните на закладку Gradient. 
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3. Выберите градиент, чтобы использовать его как осно-
ву для нового. 

4. Выберите Radial или Linear в окошке "Тип градиента". 
5. Выделите указатель цвета, измените его по своему 

желанию и двигайте его, чтобы установить место, где 
начнется переход цвета. Указатели цвета устанавливают ме-
сто, с которого цвет начнет переходить в градиент. Добавь-
те еще один указатель, потянув за "рычажок добавления 
градиента". Если Вы хотите удалить указатель, потяните за 
него и переместите к "рычажкам добавления градиента" (в 

крайний левый угол).  
6. Экспериментируйте с различными комбинациями цве-

тов и меняйте уровень прозрачности для каждого цвета, по-
ка не получите желаемого результата. (См. Создание и ре-
дактирование цвета.) 

Каждый цвет в составе градиента может иметь свой соб-
ственный уровень прозрачности. 

7. Выберите цвет и прозрачность для дополнительных 
указателей цвета. 

8. Нажмите Change, чтобы заменить текущий градиент. 
Нажмите New, чтобы добавить градиент. Новый градиент 
добавляется в самый конец набора. 

Чтобы уничтожить выбранный градиент, нажмите Delete. 
 

"Запирание" и изменение формы градиента и заливки 
 

Используйте запирание и изменение формы градиента и 
заливки, чтобы создавать интересные эффекты градиента и 
заливки из растровой графики. 

Когда градиент или заливка заперты, мазки кисти и за-
ливка наносятся как продолжение начальной заливки, в от-
личие от нанесения заливки по отдельности на каждый ри-
сунок. Как правило, градиент и запертая заливка использу-
ются, чтобы расширить область заливки или область раст-
ровой заливки после копирования пипеткой. 
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Рисунок 159 
 
На рисунке 159 показаны верхний и нижние квадраты, 

залитые одним и тем же градиентом с использованием зам-
ка, на рисунке 160 - без использования замка. 

 

 
 

Рисунок 160 
 

Используйте опцию трансформирования заливки (Trans-
form Fill), чтобы изменить внешний вид готового градиента 
или заливки. При первом нанесении градиент или заливка 
отцентрованы по отношению к центру рисунка. С помощью 

трансформирования заливки Вы можете смещать центр за-
ливки, вращать его и растягивать. 

Используйте команду убрать цвет (Remove Colors), чтобы 
убрать цвет или градиент из рисунка. 

Как применить замок заливки: 
1. Выберите кисточку или ведерко заливки, а также гра-

диент или растровую графику в качестве заливки. 
Чтобы использовать заливку растровым изображением, 

ис-пользуйте пипетку, чтобы выделить растер. После этого 
выберите кисточку или ведерко с заливкой. 

2. Щелкните на иконку с замком.  
3. Залейте желаемую область, которая будет центром 

для заливки. Залейте другие области. Flash заполняет обла-
сти выбранной заливкой и помещает центр заливки в ту 
часть рисунка, с которой Вы начали заливать. 

Чтобы изменить форму градиента или заливки: 
1. Выберите ведерко с заливкой.  
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2. Щелкните на иконку трансформации цвета (Transform 
Fill).  

3. Щелкните на область, залитую градиентом или залив-
кой. 

Когда Вы выделите градиент или заливку для редакти-
рования, появятся точка центра заливки и квадрат с 
кружочками, за которые Вы можете тянуть, вытягивать и 
изменять размер. Когда курсор находится на одном из этих 
кружочнов, он изменяется в соответствии с доступной функ-
цией изменения. 

4. Измените форму градиента или заливки следующими 
способами: 

- чтобы изменить точку центра, потяните за неё в нуж-
ную сторону; 

                  
- чтобы изменить ширину заливки, потяните за квадра-

тик на стороне большого квадрата или на круге (если Вы 
использовали круглый градиент);  

- чтобы изменить высоту линейного градиента, исполь-
зуйте нижний квадратик; 

 
- чтобы вращать градиент или заливку, потяните за 

кружок вверху или внизу прямых, означающих границы за-
ливки. Если Вы использовали круглый градиент, также по-
тяните за кружок (курсор примет вид полукруглой стрелки); 

 
- чтобы изменить размер линейной заливки, потяните за 

средний квадратик; 
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- чтобы изменить радиус круглой заливки, потяните за 
средний кружок; 

                     
- чтобы наклонить заливку внутри рисунка, потяните за 

круглый указатель вверх или вправо; 
- чтобы размножить растр, увеличьте заливку. 
Примечание. Если Вы работаете с большим рисунком и 

не видите указателей, выберите View > Work Area. 
Чтобы удалить цвет из элемента рисунка: 
- выделите не сгруппированные элементы с заливкой; 
- выберите Modify > Transform > Remove Colors. 
Flash удалит все цветные заливки. Черный цвет останет-

ся черным, все остальные цвета станут белыми. 
 

5. Движение 
 
Motion tweening 
Tweening motion является простым и эффективным, од-

ним из главных инструментов Flash. Вы создаете первый 
(frame) и последний (frame) кадр, a Flash анимирует! 

Шаг 1. Создайте символ (F8 или Insert -> create simbol). 
Назовите его « motion» (движение). 

Шаг 2. Перейдите непосредственно к сцене, нажав стрел-
ку вверх (справа вверху на "прокрутке" голубоватая стрелка, 
нажав ее, Вы попадаете из окна создания символов непо-
средственно на сцену. В любом месте создайте начальный 
ключ кадра (keyframe), нажав F6. 

Шаг 3. Откройте библиотеку (window ->library). Переме-
стите Ваш символ из библиотеки в нужный фрейм (кадр) 
(для этого вертикальная полосочка - указатель – должна 
стоять на фрейме - синий кружочек, который будет пустым 
до тех пор, пока в нем не появится Ваш "актер" - символ). 
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Шаг 4. Переведите полоску на любой фрейм ( в зависи-
мости от того, насколько долгую Вы хотите получить ани-
мацию - на 10-15-20 и т.д. фреймов). Нажмите F6 в месте 
окончания анимации (образно говоря, покажите своему "ак-
теру" на сцене место, где ему стоять в начале и конце дей-
ствия). Вы получили 2 синеньких кружочка и "скопировали" 
"позу" вашего "актера" из первого в последний фрейм. 

Шаг 5. Переведите полосу - указку на последний кадр - 
фрейм. Измените положение символа, переместив его влево 
или вправо, вверх или вниз. Можете покрутить его (rotate), 
увеличить его размер (Scale) и даже искривить его, пользу-
ясь и scale и rotate, - в общем, поступайте с Вашим "акте-
ром", как Вам заблагорассудится. Следите за тем, чтобы 
указка в это время стояла именно на последнем кадре. 

Шаг 6. Переведите полосу-указку на первый кадр - 
фрейм. Щелкните на кружочке  2 раза правой кнопкой мыши 
и выберите проперти (properties). Откроется окно со свой-
ствами первого кадра. Выберите закладку "Tweening" и в 
выпадающем меню выберите "Motion Tween". Чтобы "актер" 
крутился, выберите "rotate". Поэкспериментируйте с разны-
ми значениями. 

Tween Scaling - Ваш "актер" - символ будет увеличи-
ваться или уменьшаться во время анимации. 

Rotate clockwise - крутиться по часовой (сколько раз - 
укажите в соответствующем окошке), Rotate counterclock-
wise - крутиться против часовой стрелки. 

Orient to patch direct - анимация по заданной Вами тра-
ектории (любой кривой). В другом примере easing in - ани-
мация, медленная вначале, к концу "твининга" - быстрее, 
easing out - с точностью до наоборот. После окончательного 
выбора - ОК. 

Далее play. 
Анимация из начальной точки к конечной выполнена. 
Общие понятия - моцион твининга - задаете начальную 

и конечную "позу" Вашего символа. Flash сам создает ани-
мацию между этими двумя "позами". 
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Shape tweening (морфинг) 
Shape tweening - очень сильный инструмент в умелых руках. 
Шаг 1. Создайте новый "спектакль" (movie). File ->new 

или Ctrl+N. 
Шаг 2. Нарисуйте прямо в сцене (хотя можете создать 

Movie clip или Graphics и проделать все это там, а потом 
перенесите символ из библиотеки в муви %). Для морфинга 
возможны следующие приемы: 

- Все нарисованное инструментами Flash. 
- Импортированные bmp, gir jpeg (если Вы будете делать 

именно так, не забудьте сделать Break apart - modify -
>break apart или нажав Ctrl +B) или сделайте trace bitmap 
(modify->trace bitmap), но надо отметить, что размер будет 
немаленький (если, конечно, Вы не выбрали значение, при 
котором "стрейсенный" битмап лишь отдаленно напоминает 
исходник). Чем больше Minimal area и Color treshold, тем 
более "непохожим" будет результат и тем меньше размер. 

- Ипортированные символы флэша. 
- Шрифт или текст из Flash. 
Шаг 3. Создайте конечный кадр, пустой (переведите кур-

сор, к примеру, на 10, 20, 30, 100-й) кадр, щелкните правой 
кнопкой мыши и выберите "insert blank keyframe" (вставить 
пустой кадр). Или щелкните один раз мышью на любой фрейм 
и нажмите F7. Затем (курсор находится на конечном фрейме) 
создайте в нем любой другой рисунок или импортируйте лю-
бой другой gif, jpeg или bmp (в последнем случае не забудьте 
снова сделать trace bitmap). Можно комбинировать - в первом 
кадре, например, стрейсенная картинка, а в последнем - текст. 
Необходимо помнить: картинка и в первом, и в последнем 
фрейме ни в коем случае не должна быть сгруппирована, а ес-
ли это сгруппированый символ (например, из библиотеки), 
обязательно сделайте Break apart. 

Шаг 4. Проверьте еще раз, чтобы символ был разгруппи-
рован. Щелкните на Ваш рисунок. Если вокруг него появля-
ется квадрат, а сам символ никак не выделяется, нажмите 
ctrl+b. Рисунки и в первом, и в последнем кадре должны 
"затемняться", как кружок (рисунок 161). 
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Шаг 5. Щелкните 2 раза мышью на 1-м кадре (или пра-
вой кнопкой - properties). 

Шаг 6. Выберите закладку Tweening. Из выпадающего 
меню выберите "Shape tweening". 

 

 
 

Рисунок 161 
 

Нажмите play (Ctrl-Eneter). 
Шаг 7. Опция Distributive лучше подходит для круглых 

рисунков. Angular - лучше применять для рисунков со мно-
жеством углов, изгибов и т.д. 

Нажмите play (Ctrl - Enter). 
 

6. Элементы управления 
 
Используем "Track as Menu" (как меню). 
Track as menu (перетащить как меню) позволит создать 

выпадающие меню или подменю. 
Шаг 1. Создайте символ-кнопкут (button), нажав F8. 

Называем ее MENUBUTTON. Соответственно рисуем в ней 
изображение кнопки с надписью "меню". 

Шаг 2. Создайте movie clip, также нажав F8. Назовем его 
MENU. 

Шаг 3. Выберите window-> library. Нажмите на movie 
clip и выберите Edit из выпадающего меню, нажав на стрел-
ку в правом верхнем углу. Вставьте 2 кейфрейма - первый 
назовем "пустым" (empty), второй - "полным" (full). Чтобы 
создать имя, щелкните 2 раза мышью на кружок фрейма или 
правой кнопкой мыши - properties и выберите закладочку 
Label. В закладке убедитесь, что отмечен именно Label, а не 
Comment - между ними большая разница. Комментарии 
вставляются для того, чтобы напомнить самому себе, и ни-
какого значения не имеют. Лейблы, напротив, имеют важ-
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ное значение и являются необходимым инструментом для 
программирования во Flash и без них практически невоз-
можно выполнение сложных комманд Tell Target. 

Шаг 4. Создайте кнопки, которые будут появляться при 
нажатии на основную кнопку в меню (выпадающие кнопки - 
в примере Forvard (Вперед), Back (Назад)). 

Шаг 5. Вернемся к movie clip. Оставьте "empty" кейфрейм 
пустым. Теперь поместим все кнопки, которые будут выпа-
дать (т.е. кнопки Forvard и Back) в "полный" (ful) кейфрейм. 

Шаг 6. В каждой кнопке (forvard - вперед и в back - 
назад) поочередно выберите закладку свойства (properties) 
(для этого щелкните 2 раза на кнопку, убедитесь, что в за-
кладке Control отключена опция Enable Button) и в разделе 
definition выберите "Track as Menu Item". Помните, что это 
нужно проделать с каждой из Ваших кнопок (рисунок 162). 

Шаг 7. Теперь идем в основную сцену (синяя стрелочка 
вверх). Вставляем 2 слоя - insert-layer. Называем слои по-
следо-вательно: самый верхний - menubutton, средний - 
подменюшки, последний - Hit area. Вставляем в слой 
menubutton в первый кадр кнопку menubutton. В первый 
кадр среднего слоя "подменюшки" вставляем movie clip. Вы-
берите свойства (properties) для movie clip, щелкнув на нем 
2 раза (в сцене movie clip появится в виде крошечного 
кружка, из-за того, что первый кадр - пустой) и в поле 
instance дайте имя "menu". 

Если у Вас не получается "найти" мувиклип в сцене, 
щелкните на иконку слоя "подменюшки" так, чтобы появи-
лось выпадающее меню и выберите lock other. Или же с 
нажатой кнопкой Ctrl щелкните на все слои, кроме слоя 
"подменюшки". Щелкните на поле правой кнопкой мыши и 
выберите select all. 

Шаг 8. Сделайте активным слой menubutton (на нем по-
явится изображение карандаша). Щелкните 2 раза на кнопку 
menubutton в сцене. В меню properties выберите закладку 
action. Добавьте "Tell Target" таким образом: 

On (Release) Begin TellTarget [/menu] Gotoand Stop [full] 
End Tell Target End On 
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Это позволит при нажатии на кнопку меню появляться 
подменю. Теперь нужно сделать так, чтобы это подменю 
еще и исчезало при отводе мыши (рисунок 163). 

 

 
 

Рисунок 162 
 

 
 

Рисунок 163 
 

Шаг 9. Создайте еще одну кнопку (button), нажав F8. 
Назовите ее Hit Area (область щелчка). Нажмите Edit и за-
полните только область Hit, нарисовав большой цветной 
квадрат (рисунок 164). 

Шаг 10. Вернитесь в сцену (синяя стрелочка) и вставьте 
еще один слой (layer). В примере лайер называется "hit 
area". Затем вставьте в него Вашу Hit Area кнопку. Слой 
(layer) с этой кнопкой должен быть ниже остальных слоев. 

Шаг 11. Область щелчка - кнопка стала голубой. Это зна-
чит, что она прозрачная и является кнопкой, в которой есть 
только область щелчка (hit area). Чтобы все работало лучше, 
поместите голубую область везде, где она не будет "пере-
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крывать" подменюшки. Можно вставить эту кнопку несколь-
ко раз и не забудьте дать Tell target каждой из вставленных 
"голубых" кнопок. 

 

 
 

Рисунок 164 
 

Шаг 12. Нажмите свойства (properties) голубой области и 
назначьте следующие команды Tell Target: 

On              (Roll                                  Over) 
Begin Tell Target [/menu] 
Goto and                Stop [empty] 
end Tell                Target 
End On 
Этим Вы добьетесь того, чтобы выпадающее меню исче-

зало, как только Вы отведете мышь, поскольку Вы наводите 
мышью на прозрачную голубую область, которая не будет 
видна в броузере. 

Movie clips нужен для создания более "продвинутой" 
анимации или для создания анимированных кнопок. Для со-
здания movie clips нужно проделать следующие шаги: 

Шаг 1. Нажмите F8 и выберете movie clip. 
Шаг 2. Создайте анимацию, shape или motion tweening. 
Movie clips должны использоваться в следующих случаях: 
• Если нужно съанимировать уже анимированный сим-

вол. (Пример - крутящееся колесо от велосипеда вставляем 
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в movie Clip, где нарисован велосипед и анимируем сам ве-
лосипед, например, он едет, подскакивая на кочках.) 

• Если нужно использовать Tell Target. 
• Если нужно создать повторяющуюся анимацию 

(looping) или эффект, независимый от другой анимации. 
Tell target - самый мощный инструмент во Flash. Также 

это та часть флэша, которую невозможно изучить до конца. 
Что же делает эта команда? Она посылает информацию к 
таймелайнам, которые находятся внутри мувиклипа 
(movieclip). Это позволяет, к примеру, создать movie clip, 

который можно проигрывать и останавливать используя со-
вершенно различные кнопки. 

Этот урок позволит создать постоянно играющий музы-
кальный момент (loop), который Вы можете востановить из 
Вашего муви. 

Шаг 1. Создайте movie clip, который будет называться 
music. Первый фрейм оставьте пустым и дайте ему label 
"blank". Отступите на несколько фреймов и создайте фрейм с 
именем musik. Вставьте в фрейм (в 10-м примере) музы-
кальный фрагмент. Для этого воспользуйтесь либо встроен-
ной библиотекой звуков (курсор стоит на 10-м фрейме, 
libraries -> sound), либо импортируйте любой wav файл (file 
->import, затем windows - >library и описанным выше обра-
зом перетащите музыкальный символ). Имейте в виду, что 
перетаскивать любые символы из библиотеки нужно, щел-
кая на верхнее окошко (в котором изображен символ), а не 
на окошко с перечнем символов и их именами. Пометьте 10-
й фрейм именем (label) "music". 

Шаг 2. Перейдем в сцену (синяя стрелочка справа). 
Вставьте лайер (левой кнопкой мыши на поле справа от 
лайера по умолчанию) и выберите insert->layer. Назовем его 
music layer. В первый фрейм вставьте ваш муви-клип, пере-
тащив его из библиотеки (windows-library). (Если Вы все 
сделали правильно, кружок фрейма станет заполненным.) 
Теперь щелкните на муви-клип непосредственно в сцене 
(правой кнопкой мыши), выберите properties и в закладке 
definition напишите в окошке “Instance name” слово music. 
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Шаг 3. Создайте 2 кнопки для включения и выключения 
музыки и поместите их куда-нибудь в сцене. В примере они 
помещены в лайер с названием button. 

Шаг 4. Щелкните на кнопку, которая будет включать музы-
ку (в примере кнопка on), выберите свойства (properties) так 
же, как и с муви-клипом, когда задавали ему instanse name. 
Выберите закладку Actions. Зададим кнопке цель (Tell Target): 

On (Release) 
Begin Tell Target [/music] 
Goto and                Play [music] 
End             Tell          Target 
End on 
Теперь Ваши кнопки указывают музыкальному муви-

клипу идти и играть туда, где стоит пометка (label) music. 
Этим Вы добились того, что музыка при нажатии кнопки 
"on" будет играть. 

Шаг 5. Повторим все то же самое для кнопки выключе-
ния (off). Только пропишем ей другие значения: 

On (Release) 
Begin Tell Target [/music] 
Goto and               Stop                   [blank] 
End             Tell          Target 
End on 
При нажатии на кнопку выключения (off) кнопка задает 

Вашему клипу цель "иди и остановись на пометке "blank". 
Загрузка ролика (Load movie) - команда, которая позво-

лит загружать другой ролик (movie) внутрь первого. Осо-
бенно это пригодится в случаях, когда Вы хотите использо-
вать музыку на своем сайте. Просто поместите музыку в от-
дельный ролик (movie) и загружайте или выгружайте его из 
первого ролика (movie). 

Пример создания отдельного музыкального флэш - ро-
лика (movie). 

Шаг 1. Создайте ролик (movie), содержащий только по-
стоянно играющую (looping) музыку. Сохраните его под 
названием, например music.swf. 
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Шаг 2. Откройте основной ролик. Предположим, что Вы 
хотите, чтобы музыка начинала играть с самого начала. По-
ставьте курсор на любой фрейм (в нашем примере это 1-й 
фрейм) основного ролика и назначьте первому ключу кадра 
(keyframe) команду "Load Movie" (2 раза щелкните на фрей-
ме или правой кнопкой щелкните на фрейме, и выберите 
свойства (properties) Action Load Movie). 

Шаг 3. В поле "Load Movie" введите имя файла, который 
Вы хотите загрузить. Предположим, "music.swf'. Ниже распо-
ложено окошко "уровни" "Level", которому придадим значе-
ние 1. Если Вы хотите загружать несколько роликов (movie), 
просто ставьте им последовательно значения. При этом не 
играет роли, какое именно цифровое значение Вы им при-
своите. Нам нужно загрузить только один ролик. Итак, оста-
вим значение 1. 

Шаг 4. Теперь музыка начинает играть в тот момент, ко-
гда Вы входите в Ваш основной ролик. По желанию Вы мо-
жете создать 2 кнопки. Щелчок по первой кнопке будет за-
гружать ролик music.swf со значением level 1. А вторая 

кнопка будет выгружать Ваш музыкальный ролик со значе-
нием 1 (level 1). Это еще один способ включить/выключить 
музыку. Точно так же можно загружать и выгружать не-
сколько роликов с музыкой. Например, при нажатии на 1-ю 
кнопку загружается файл movie.swf, при нажатии на 2-ю – 
выгружается movie.swf и загружается movie2.swf. 

Интерактивность позволяет ролику отвечать на состоя-
ния, такие как пользователь сделал то-то и то-то или поль-
зователь изменил то-то и то-то. Flash подключает интерак-
тивность через акции набора скриптов или инструкции по 
использованию ролика в определенном случае. 

Скрипт. Скрипт акций (action script) осуществляется че-
рез индивидуальную последовательность, которую заявляет 
акция. 

Заявления акций (Action statements) - практически то же 
самое, что и предложение: комбинация слов, которые пере-
дают информацию и инструкции ролику. Как и в любом 
языке, заявление акций использует несколько понятий и 
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правил для создания этого самого заявления. (То есть, что-
бы попросить человека о чем-либо, нужно сказать, напри-
мер: "Вася, ПОЖАЛУЙСТА, сделай то-то и то-то." Слово 
ПОЖАЛУЙСТА является словом, выражающим просьбу и т.д. 
Так и с заявлениями акций.) Flash запускает заявления по 
порядку, начиная с первого заявления. Необходимо упорядо-
чить эти заявления в нужном Вам порядке и правильно ука-
зать параметры каждого заявления. 

Многие акции содержат только одну инструкцию, напри-
мер, инструкцию играть ролик. Тем не менее, акции могут 
комбинировать несколько заявлений и проверять, когда про-
изойдет указанное состояние, и только после этого исполнять 
акцию. (Пока ролик не пойдет на 10-й фрейм, ничего не про-
изойдет. Как только ролик окажется на 10-м фрейме, будет 
дана команда перейти на какую-либо ссылку (get URL).) 

Вы можете использовать переменные (variables), чтобы 
сохранять и обновлять значения. Как имя связанное, вари-
анты имеют значения, которые могут меняться в то время, 
пока играет ролик. 

Переменные (Variables) могут содержать как цифры, так 
и буквенную последовательность (srings). Наиболее типич-
ные типы информации - это URL, текст, вводимый пользо-
вателем, результат математических операций, сколько раз 
происходит то или иное действие или событие, сопровож-
дающее щелчок мыши по кнопке. 

Привязывание акций скрипта. Вы можете привязать 
акцию к кнопке или фрейму, указав акцию внутри закладки 
Action для кнопки или в диалоговом окне Properties для А-
атез (кадров). 

Если Вы привязали акцию к кнопке, то после того, как 
пользователь щелкнет на кнопку или проведет мышью, она 
исполнится. Привяжите акцию к кадру (frame), чтобы собы-
тие произошло в тот момент, когда Ваш ролик "доиграет" до 
указанного кадра. Акции кадров (Frame actions) очень полез-
ны для создания пауз или загрузки первым роликом другого 
ролика (load movie). 
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Включение акций. Подключите акции, выбрав заявление 
акций из панели "акции" (Actions). Если Ваша акция имеет 
дополнительные параметры, которые можно подключить, 
используйте панель параметров (Parameters) и поле, в кото-
рое вписываются эти параметры. В зависимости от парамет-
ров, значения могут быть цифровыми или это могут быть 
последовательности букв (слова, фразы и т.д). Во многих 
случаях можно использовать выражения (expression) вместо 
цифр или условий. 

Используйте другие акции символов и акции кадров, 
чтобы создать более полную интерактивность. Например, 
поместите клип (movie clip) внутрь кнопки (button), чтобы 
создать анимированную кнопку. 

 
7. Публикация ролика 

 
Вы закончили свой флэш - ролик. Теперь нужно его под-

готовить к публикации в Web. Macromedia создала 
Aftershock, чтобы было проще это сделать. Aftershock пишет 
необходимые HTML коды, javascripts и все остальное, необ-
ходимое для того, чтобы Ваш ролик был виден в Интернете. 

Где получить Aftershock. Aftershock поставляется вместе 
с Macromedia Flash 3. 

Подготовка файла .swf для Web. Откройте Aftershock. 
Нажмите следующую кнопку: 

 Укажите путь к Вашему файлу, выставьте нужные 

значения (они приведены ниже) и нажмите save. 
Редактирование готового ролика в Aftershock. Нажми-

те следующую кнопку и выберете HTML file, который со-
здан ранее с Aftershock. (Не советуем Вам этого делать, 
лучше создать HTML снова, поскольку Aftershock имеет 
обыкновение дублировать комманды, из-за чего при про-
смотре в Wеb возникают большие проблемы.) 

Разберем все закладки в Aftershock: 
Scripting, Page Layout, Shockwave, Alternate Image, and 

Java. 
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Scripting. Закладка scripting указывает, в каком окруже-
нии и при каких обстоятельствах ролик будет показываться. 
Выберите схему (Scheme). 

Примечание. Java работает только для Flash 2 роликов. 
Обычно используются следующие параметры (рисунок 165). 

Эти настройки хороши и для тех случаев, когда Вы ис-
пользуете Flash 3 с javascripts наподобие "открыть в другом 
окне". В остальных случаях используются опции по умолча-
нию. 

План страницы (Page Layout) обозначает, как Ваш ро-
лик должен выглядеть в броузерах. Если необходимо увели-
чить ролик к большему размеру, чем Вы указали во Flash, 
здесь это можно сделать. Если Вы хотите полноэкранный 
ролик, укажите 100%.  

 

 
 

Рисунок 165 
 
Выравнивание (Alignment) указывает, какая часть Ваше-

го ролика будет показана. Если Вы укажете размер, отлич-
ный от размера, указанного во Flash, броузер изменит раз-
мер ролика так, что некоторые детали ролика, которые не 
должны быть видны, станут видными или, наоборот, аф-
тершок "обрежет" какие-то части. (Например, если Вы рисо-
вали больший, чем размер ролика, прямоугольник в каче-
стве фона, края этого фона станут видны. Также, если Вы 
делали motion, который начинается вне видимого простран-
ства, он также станет виден.) Используя Align, Вы "прибива-
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ете" ролик к одной из сторон броузера. List URL's и List 
Text нужны для регистрации в поисковых системах. 

Shockwave. Здесь Вы указываете, как ролик будет вести 
себя в броузере. Вы можете изменить бэкграунд ролика, 
просто написав здесь другие значения в hex! Часть playback 
указывает, хотите ли Вы, чтобы ролик выдерживал паузу 
перед первой загрузкой и чтобы он играл постоянно (loop). 
При помеченной опции "display menu" у пользователя при 

нажатии правой кнопки мыши на Вашем ролике появится 
меню с возможностью приблизить, отдалить, переиграть 
сначала и т.д. (zoom, rewind). Когда эта опция не помечена, 
пользователь увидит только "About Shockwave Flash". 
Device font - очень интересная опция, которая использует 
шрифты из системы пользователя. Quality опция нужна, ес-
ли Вы хотите, чтобы Ваш ролик был сглаженным 
(smoothed). Настройка Auto-High позволяет подстраивать 
качество ролика под скорость связи. При быстрой связи Ваш 
ролик будет выглядеть превосходно, при падении связи ка-
чество изображения будет ухудшаться пропорционально 
скорости связи. Если Ваш ролик не больших размеров, луч-
ше использовать High quality. В закладке window mode три 
опции. Обычно используется значение "window". Opague хо-
рошо для DHTML. Transparent (прозрачность) делает бэк-
раунд прозрачным, позволяя смотреть все, что написано в 
HTML через ролик. 

Примечание. Transparent опция работает только в  
Internet Explorer 4 или выше. Scale позволяет указать дру-
гой размер ролика. Exact fit (точное заполнение) не изменя-
ет ролик. No border убирает края, присутствующие в ролике 
Flash, т.е. в некоторых случаях пользователи будут видеть 
рабочую область Вашего ролика (что крайне нежелательно) 
Default (по умолчанию), что-то вроде No border, но эта оп-
ция не показывает рабочую область. 

Alternate Image. Если Вы хотите создать анимационный 
или статичный гиф, можно это сделать здесь. Этот рисунок 
можно показывать пользователям, у которых нет Shockwave 
плагина. 
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Java. Если Ваш ролик создан во Flash 2 и Вы хотите ис-
пользовать Flash Java Player, здесь можно указать настрой-
ки. Также можно указать, где Ваш ролик будет брать Java 
Player. Как правило, этими опциями пользуются по умолча-
нию. 
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